Diamond Mind Baseball version 9
We have tried to create a help system that will provide you with everything you need to get the most out of DMB,
including introductory tutorials, detailed information about every window and menu command in the game, a
glossary of terms (including statistics and their abbreviations), and essays on some of the more advanced
capabilities of the game.
If the information in this help file does not answer your questions, we invite you to seek additional help in the
following ways:
visit our web site (www.diamond-mind.com) for answers to frequently asked questions, free downloads,
and other helpful information.
sign up (using the form on our web site) for our free email newsletter. During the weeks following the
release of version 9, we expect to use the newsletter to provide technical tips and other useful information
about the game. Back issues of the newsletter are posted to our web site.
send your questions via email to support@diamond-mind.com.
call toll-free (800) 400-4803 during our business hours (9-5 Pacific time, Monday to Friday)

What's new and different
This page summarizes the most significant additions and changes in version 9. We strongly recommend that you
take a little time to review this page and follow the links to the topics that provide you with more details about the
new and improved features.
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Playing games
The NetPlay feature provides direct internet play support. You can now play games head-to-head over the
internet without using a third-party product like NetMeeting.
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events, and relevant statistics. We've added a very large amount of new text to our play-by-play library. And we've
begun adding park-specific plays.
Customizable play-by-play font. You can choose any font family and size for the play-by-play commentary. See
the Exhibition Game Options or Scheduled Game Options topic to see where you can make font changes.
Play-by-play speed. Separate options for the delay between messages and the delay at the end of each play give
you more control over the play-by-play speed. See the Exhibition Game Options or Scheduled Game Options topic
to see where you can change play-by-play speed..
Game log. In addition to the boxscores and play-by-play scoresheets that have always been part of our game,
version 9 adds a textual game log similar to those you see on major web sites today. For an example, check out
our sample game log.
Player-specific manager tendencies. Manager profiles have been expanded to allow you to specify tendencies
for individual players. This provides you with an increased ability to influence how the computer manager chooses
tactics in game situations involving those players. These player tendencies are optional, so there's no need to
spend time setting them up if you're content with the team's manager tendencies and the computer manager's
ability to make good decisions based on player ratings.
Outfield assists. Improved the computer manager's decisions on baserunning plays, reducing the number of
trailing runners who are being thrown out and bringing outfield assist totals down to more realistic levels. We've
also added some information about your chances to take extra bases in different running situations.
Brawls. The likelihood of a brawl is now tied to the number of HBP that have occurred in the game. In other words,
a brawl is more likely to erupt in a contest where two or more batters have been plunked.
Catcher fatigue. Previously, a tired catcher would underperform at the plate but remain at full strength in the field.
Now catcher fatigue affects defensive performance as well.
Unrated catchers and pitchers. We increased the defensive penalties when an unrated player is used at those
positions.

Generating reports
Report groups. You can create groups of reports to be generated with a single command, with the option to send
the output to a file in either plain-text or HTML format or directly to a printer.

Web site generation. Report groups are also the basis for generating an entire league web site consisting of
linked reports at the organization, league and team level plus any saved boxscore/scoresheet/game log files.
Because these report groups and the individual reports are customizable, you can design the web site to include
the information you want and nothing else.
Expanded HTML support. Statistical reports are now formatted as HTML tables using fonts and colors to improve
the presentation. Cascading style sheets hold the formatting information so advanced users who are familiar with
HTML can control how these reports are formatted.
New analytical statistics. Several reports have been updated to include modern statistics such as total bases plus
walks (TBW), component ERA, runs created ERA, strikeout/walk ratio, and WHIP. These statistics are also
available to be added to your custom reports.

Encyclopedia
We have developed a powerful new encyclopedia that enables you to store and report on the results of multiple
DMB seasons. The encyclopedia includes all of the standard DMB reports for individual seasons plus career
leaderboards and career batting and pitching reports for players. Since the DMB Encyclopedia installs as a
separate product, it has its own help system.

Miscellaneous
Expanded rosters. The roster limit has been raised from 60 to 80 players. This was motivated primarily by a few
recent real-life teams that have used as many as 59 players in the regular season.
Voiding draft picks. Whether you're running a human draft or a computer draft, individual draft picks can now be
voided. This is useful when a team loses the right to use a pick as a penalty for a rules violation, because it has
already reached its roster limit, or for any other reason. Voided picks can be restored if they were voided in error.
Creating organizations. It is now possible to create an organization after a season has been started. If you're
playing the season with two leagues that are to meet, and you didn't remember to set up the organization before
the season starter, you can create it in time to set up your championship series.
New transaction types. We have added new real-life transaction codes for the bereavement list that was
introduced in the recent collective bargaining agreement and for players who die during the season.
More databases. Version 8 limited you to 100 DMB databases. This limit has been raised to 200, and the list of
available databases is now sorted to make it easier for you to find the one you're looking for.
Updated historical info. The master era and player files have been updated to include the 2001 - 2003 seasons.

Selecting Multiple Items in a List
Many of the screens you will see in DMB display lists. The Organizer, for example, displays lists of teams, players,
parks and other items in your database. The transfer features display lists of games, manager profiles and
transactions that can be transferred to another computer. The schedule editor displays a list of games in the
schedule.
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In many cases, you want to select only one item and do something (view it or modify it, for example). But there are
some DMB commands, such as transfers and deletions, that can act on a group of selected items. These group
operations can save you a lot of time.
To select the items for a group operation, DMB uses these standard Windows techniques for selecting multiple

items from a list:
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to select a single item, click on that item with the left mouse button
to select a group of neighboring items, click on the first item with the left mouse button and release. Then
hold down the Shift key and click on the last item with the left mouse button. This will select all of the items
from the first item to (and including) the last.
to select a group of items that are not next to each other in the list, hold the Ctrl key down while clicking the
left mouse button on each item. If you Ctrl-click on an item that is not currently selected, it is added to the
group of selected items. If you Ctrl-click on an item that is in the group of selected items, it is removed from
the group.
You can combine these last two techniques by first selecting a group of neighboring items using Shift-click and
then adding or removing individual items using Ctrl-click.

Popup Menus
Many parts of DMB allow you to access commands through popup menus that display when you click the right
mouse button on an item in a list or an area of a DMB window. For example, popup menus display when you rightclick on the lists in the Organizer, the roster and manager profile window, the lineup selection window, or the list of
scheduled games. In each case, the popup menu contains commands that apply to whatever it is that you clicked
on.
If you're not sure what to do in a certain part of the product, try right-clicking on various parts of the window. You
will quickly learn where these popup menus are available and what they allow you to do. And there's no harm in
experimenting this way, because DMB doesn't ever do anything based on a right-click other than (a) display a
menu or (b) do nothing, if no menu is available for this part of the product.
When a popup menu displays, you are not required to choose a command from that menu. You can press the Esc
key or left-click anywhere outside the popup menu to make it disappear.

Tutorials Overview
If you have never used Diamond Mind Baseball before, or are familiar with DMB but have not seen the new
features of the latest version, you can use these tutorials to learn more about DMB.
Basic Tutorial: This tutorial assumes you have never experienced DMB before. In this tutorial you will play an
exhibition game against the
DMB computer
manager.
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pitching and batting strategies for your team; you will control these. When you are comfortable with the major
features of Diamond Mind Baseball covered in the Basic Tutorial, you can move on to the Advanced Tutorial where
you will play a scheduled game and control more of the action.

THE

Advanced Tutorial: If you are familiar with Diamond Mind Baseball but would like to see some of the features of

the latest version, start here.
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Setting Up a League: Many Diamond Mind Baseball customers enjoy replaying real major league seasons. But
DMB also allows you to create and run your own league, right through the post-season. This tutorial walks you
through the steps needed to bring your vision to life.
Managing Playing Time: There are several help topics that deal with issues related to playing time. See Playing
time limits for an overview of pitching, atbat, and pinch hitting limits. The Depth Charts topic covers those areas too
but also explains usage modes for bench players while the Pitching Chart topic deals with pitcher usage modes.
Several topics describe the steps you can take to have more control over player usage, including Depth charts
page (setting up platoons, defensive subs, utility roles, and spot start percentages and choosing a usage mode),
Pitching chart page (setting up roles and spot start percentages, assigning limits to games started or relieved, and
choosing a usage mode), Saved lineups page (assigning atbat limits), and Manager profile generator (generating
playing time limits for each player).
Playing the Post-season: Upon completion of the regular season, you can quickly setup post-season games by
seeding teams for a playoff round and generating a schedule for that round. See Leagues: Post-season Information
and Organizations: Post-Season Information for details on seeding teams and choosing a post-season series
formats.
NOTE: You must seed the teams BEFORE generating the schedule.

DMB's post-season system supports four playoff teams per league. If your league uses a more complicated
system, you can modify the regular season schedule to add post-season games manually.

Basic Tutorial: Game Options
In this tutorial, we're going to play an exhibition game between the 1935 Detroit team and the 1955 Brooklyn team.
You'll be managing Brooklyn at Ebbets field and the DMB computer will be managing Detroit.
When you play an exhibition game in DMB, you can customize virtually all of the features of the game including the
teams, where they play, the weather, boxscore format, and much more. We'll keep things simple in this tutorial so
you can start playing right away.
1. From the DMB menu, select Game then Exhibition . The following window will appear:

Notice that this window has three tabs labeled "Exhibition Game Options," "Managers," and "Colors/Text." We're
going to look at each of these tabs in turn.

Exhibition Game Options
The pull down lists under the heading "Database" allow you to point DMB to datafile(s) containing information on
teams, parks, and eras. For this tutorial, leave these settings at the default location.

The pull down lists under the heading "Selection" allow you to pick specific teams to play against one another,
specific parks, and specific eras of play.
1. For this tutorial select 1935 Detroit as the visiting team and 1955 Brooklyn as the home team.
2. Notice that DMB automatically selects the field based on the home team you select. Of course, you could
select a different ballpark for the game using this pull down, but for this tutorial leave Ebbets Field as the
location for the game.
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3. Select 1955 N as the era for the game. More information about eras is provided in the Eras section of this
help file.
4. The pull down labeled "Display" lets you set what level of detail you want DMB to display while you're playing
the game. You can have DMB show every pitch, or show only the pitch that leads to batted balls, baserunner
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5. Select Each play in the "Stop after" pull down. This tells DMB to stop after the action for each play is
complete so that you can consider your strategy. If you wish, you can have DMB stop after each half-inning,
at the end of a specific inning, or at the end of the game.
6. Leave the boxscore setting at "Newspaper ." We'll see how this works later.
7. Select April from the pull down labeled "Month." This tells DMB which month to use to determine the weather
at the ballpark you have selected.
8. The checkboxes to the right of these pull downs let you tell DMB whether or not to use the designated hitter
rule, the bullpen warmup rule , use the weather system, show the weather report for the game before the
starting lineups are chosen, and use the clutch/jam ratings. For this tutorial, leave these settings to their
defaults .
Now we'll look at the Managers tab.

THE

Managers
The Managers tab lets you set whether a human player or the computer will manage some or all of the action for
the game for each team.

You can have a human player or the computer handle the starting lineups, any substitutions during the game, the
offensive and defensive tactics, and running and throwing action. When you become more familiar with DMB, you'll
see how controlling these features can add a lot of excitement to your play.
To keep things simple for this tutorial, let the computer manage everything but the Game tactics for the home team.
Set this to Human .
Let's look at the Colors/Text tab next.

Colors and Text
The Colors/Text tab lets you determine how DMB looks on your computer. You can set a wide variety of color
combinations for such things as the scoreboard, the lineup screen, the background, and other features. You can
also set the text size for many of the displayed fields.
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For the purposes of this tutorial, leave these settings at their default .
When you're ready, click the button at the bottom of the screen labeled OK and let's head to the ballpark!
NOTE: Since we elected to use the weather option on the game options screen and have the weather at game start displayed,
you'll see a pop up screen with this information. Click OK to proceed to the Game Screen.

The Game Screen

The Game Screen
You've set up your game by selecting teams, how much action you want to display, and the managers. Now you're
ready to play ball. Because we elected to use the weather option and have the weather at game time displayed,
you saw a small pop-up screen with this information. After that, the main game screen appears:

The game screen is divided into several areas. Each of the links below will provide you with a description of these
areas and instructions on how to use them. Familiarize yourself with these areas and what they can tell you before
you go on.
Lineups
The Scoreboard
Batters
Pitchers
The Diamond

The Benches
The Boxscore and Scoresheet Tabs
Sample Boxscore
Sample Scoresheet
Sample Game log
Player Profiles
Tactics and Replay

UNREGISTERED VERSION OF CHM TO PDF CONVERTER STANDARD BY THE

UNREGISTERED VERSION OF CHM TO PDF CONVERTER STANDARD BY THE

Lineups
In the upper left corner of the Game Screen, you'll see the Lineups area, shown below:

Since we elected in the exhibition game options screen to let the computer select the lineups for both teams, all of
the work has been done for us here. Setting your lineups manually is covered in the Setting Lineups section of this
help file.
You can view the lineups for each team by clicking on the tab for each team in this area.
The Scoreboard

The Scoreboard
In the upper center of the Game Screen, you'll see an area that displays the game score, shown below.
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As you play out a game with DMB, you will see the score by inning, as well as the total runs, hits, and errors by
each team displayed here. The team that is at bat is highlighted in this display.
The Batters area.
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Batters
In the upper right corner of the game window, you'll see a section that displays the current batter. The tabs in this
area can be used to look ahead at the next two batters in the lineup. This can be very important when choosing
pitching strategies.

Each batter card shows his name, how he bats ('BLsp' means he bats left and is a spray hitter), his real-life batting
average and power rating versus left- and right-handed pitching (in this image, .000 indicates left/right splits were
not available for the 1935 season), how well be bunts ('Fr/Fr' means that he is only a fair bunter in both sacrifice
situations and when he's trying to bunt for a base hit), and three sets of statistics -- the current game, year-to-date
stats for your DMB season, and the real-life totals on which his ratings were based.
NOTE: When you are playing an exhibition game, the year-to-date stats are always the same as those for the current game,
because cumulative statistics are not compiled for exhibition games.

The Pitchers area.

Pitchers
In the lower right hand corner of the game screen is an area showing statistics for the current pitcher.
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Just as with the Batters area, this area shows standard pitching statistics for the game in progress, for the season
you are playing, and the pitcher's real-life stats for the season you have selected.
If your team is at bat a review of this information can really help you pick a good batting strategy.
The Diamond

The Diamond
In the middle of the game screen you'll see the diamond. This area provides a great deal of information about the
game in progress. All of the information provided in this area of the game screen is discussed below, so take a
moment to familiarize yourself before going on.

The playing field
The field shows you the positions and names of the defensive players (blue) and offensive players (red). It also
provides a quick overview of each player's ratings.
Beside each player's name are ratings for defensive and baserunning skills. Many DMB ratings use a five-point
rating scale with the following values: excellent (Ex), very good (Vg), average (Av), fair (Fr), and poor (Pr).
An infielder has two defensive ratings displayed next to his name -- range and error ratings (expressed as expected
number of errors per 100 games at that position) -- while an outfielder has three -- range, outfield throwing arm, and
error -- and a catcher has three -- range, catcher throwing arm, and error. For more information on defensive
ratings, see Players: Defensive Ratings.
A baserunner has the following three ratings displayed next to his name: r - running, s - steal, and j - jump. For
more information on offensive ratings, see Players: Offensive Ratings.

Park dimensions
At the top of this area you will see a small display that shows the outfield dimensions of the park where the game is
being played.

From left to right, these figures show the distance and fence height for the left field line, left field, left-center gap,
center field, right-center gap, right field, and right field line.

Balls, strikes, outs
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Pitch count

This area shows the total number of pitches and strikes thrown by the current pitcher in the game you are playing.

Tactics
This area is most useful when you are playing head to head with another human manager. It simply shows that the
defensive player has made his pitching tactic selection as well as the position of the fielders. In the example below,
the pitcher is ready and the manager has selected a normal defense. When the offensive player makes his batting
tactic selection, play begins.

Bullpens
This option was not selected for this exhibition game, but if it was, and if a pitcher was currently warming up in the
bullpen, you would see another box in the lower-right corner of the playing field:

The top two rows are for the defensive team and the bottom two for the batting team. For each pitcher listed, the
first column shows his status (W for warming, R for ready), and the third column shows his throwing hand.
The Benches.

The Benches
In the lower left corner of the game screen you'll see who is on the bench for each team:

This is an excellent place for you to gather information about the players you are facing and select your defensive
and offensive strategies. Double clicking on a player's name will call up the profile for that player.
Right-clicking on a player on the bench allows you to use that player as a pinch hitter or pinch runner.
You should note that this area displays lefties in the left hand column, righties in the right column, and any switch
hitters at the bottom.
Finally, before we start play, we'll look at the Boxscore, Scoresheet, and Game log tabs on the game screen.

The Boxscore, Scoresheet, and Game log Tabs
In the far upper left corner of the Game Screen, you see three tabs labeled Boxscore, Scoresheet, and Game log
as shown below:
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The boxscore tab shows the scoring of the game using standard scoring notation. If you would like to learn more
about customizing this display,
go to the Boxscore
chapter
of this
help file.
For this tutorial, you'll
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Click here for an example.

Scoresheet
The scoresheet tab provides an account of the game that allows you to see what happened on every play.
Click here for an example.
More information about reading the scoresheet can be found in the Reading the Scoresheet section of this help file.

Game log
While the scoresheet uses symbols to notate the account of the game, the game log describes each play in a list
format.
Click here for an example.
The game log provides each batter's pitch sequence in a format that is described in the Reading the Game log
section of this help file.

Sample Boxscore
Here is a sample of a newspaper-style boxscore.

Sample Scoresheet
Here is a sample of a play-by-play scoresheet. See Reading the Scoresheet to learn how to interpret the codes that
are used to describe each play.
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Sample Game log
Here is a sample of a game log. See Reading the Game log to learn how to interpret the codes that are used to
describe pitch sequences.

Defensive tactics
During the game you will alternate between playing offense and defense. This action is controlled through the
button array in the upper center of the game screen. Since you are managing Brooklyn in their home field in this
tutorial, you'll play defense first.
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The pitching tactic you select will of course depend on many things -- the batter you're facing, whether or not there
are runners on base, and so forth. The buttons for Pitch out and Pickoff are grayed out when there are no runners
on base.
If you would like more information on the available pitching tactics, click here.
1. For this tutorial, select Challenge hitter.
2. Once you have selected a pitching tactic, the button array will change to allow you to select how your defense
will play. For more information on defensive tactics, click here. For this tutorial, select Normal defense.
When you select your defense, the commentary will be displayed. The speed of this commentary is based upon the
slider setting "Speed of play-by-play commentary," which can be set in the Game Options screen. You can change
the speed of the commentary by clicking on the button labeled "Change options" on this array.
NOTE: that the commentary begins with any pitch that involves a baserunner, batted ball, or any other action that decides the
fate of the batter.

When the commentary and scoring are complete, you will see the tactics tab again. You may review the last
commentary at any time prior to the next pitch by clicking on the tab labeled "Replay."
Be sure to notice the changes on the Diamond, and the Batters Cards after the play.
When you've retired the side by repeating the steps above it's time to play some offense.

Playing Offense
Ok, your team is at bat. Now you have to decide how your batter and baserunners (if you have men on base) will
respond to the pitch.
The tactics button array will change to offense, as shown below:

Of course, the buttons that are available will depend on the situation on the field. "Hit and run" and "Steal" for
example, will only be available if you have runners on base.
For more information on offensive tactics, click here.
You now must decide if you want to swing away at the pitch, to take the pitch, to bunt, etc. And, if there are
baserunners, you can instruct them to steal.
For this tutorial, click on Swing away. The commentary will start and the fate of the batter (and/or baserunners) will
be decided.
You can complete this tutorial by simply playing through the game, alternating defense and offense. Feel free to
experiment with some of the tactics that are available for each.
When the Game is Over

Saving Game Data
Since the game you have just completed was an exhibition game, you will not be able to save the statistics
generated during the game. You can, however, save the boxscore and scoresheet.
At the end of an exhibition game, the tactics button array will change to show the buttons below:
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1. You can exit the game without saving any information by clicking on the Exit game button. For this tutorial,
however, click on the button labeled Save box/ss/gmlog. The following window will appear:

Here you can save the boxscore, scoresheet, and/or the game log by selecting the appropriate checkbox(es).
2. DMB automatically provides a name for the file where the saved data will be store. However, you are free to type
any name you wish into the File name field.
3. Click OK when you are ready to save your game information.
As noted in the above image, all boxscore / scoresheet / game log files are saved in the folder containing the active
database. If the name of the file already exists, the information will be added to the end of that file. Therefore, your
file may contain information for multiple games.
This concludes the basic Diamond Mind Baseball tutorial.

Advanced Tutorial
This tutorial is for users who are familiar with Diamond Mind Baseball or who have completed the Basic Tutorial
and want to learn more about the features provided in this version of DMB.
In the Basic Tutorial, the DMB computer handled most of the game action. In this tutorial, you'll learn how to
manage the starting lineups, substitutions, and baserunning and throwing settings.
From the DMB menu, select Game then Scheduled . The following window will appear:

This screen is divided into several sections, which are described below. We'll look at each of these, except for
"League Selection." Since this is a tutorial, we'll cover this option in another section.
League Selection
Game Day

Scheduled Games
Play Options
Setting the Lineup
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Game Day: The Calendar
The upper left corner of the scheduled game screen contains a calendar. You can use this calendar to select any
month and day in the season and display which games are scheduled for that day.

Simply use the left and right arrows beside the month to scroll through the months, then click on any day of the
month. The games that are scheduled to be played on that day are displayed below the calendar in the scheduled
games area.
Scheduled Games

Scheduled Games
This area of the Scheduled Games Screen displays all of the games that are scheduled to be played on the month
and day you selected using the calendar.
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If a scheduled game has already been played, this area will display the scores for each team as well as any extra
innings played during that game.
For this tutorial, do not select any games in this area.
Play Options

Play Options
In the Basic Tutorial, we let the computer control everything but the pitching and batting tactics. In this tutorial,
we're going to let you control these as well as set the lineup, substitutions, and the throwing and running decisions.
NOTE: The throwing and running decisions will only appear in DMB under certain circumstances. If you have selected this
option you will be prompted by DMB when, for example, one of your runners has an option to try for third base when rounding
second. In defensive environments, DMB will prompt you to make a selection such as throwing to second or third.

To set scheduled game play options:
1. After you have selected a game day you can click the button labeled Play. This will bring up a submenu that will
allow you to play the first unplayed game on the day you have selected or any particular game you have selected.
2. For this tutorial, since we have not selected a particular game, select Play first unplayed game on this day. A
window will appear that will allow you to set some of the same options covered in the Basic Tutorial.
3. Click on the Managers tab.
4. Set all of the options for the visiting to team to be managed by the DMB computer by clicking the All Computer
button at the bottom of this column.
5. Set all of the options for the home team to be managed by you by clicking the All Human button at the bottom of
this column.
When you are done, click the OK button to go to the Lineup Screen.

Lineup Overview
DMB displays all of the information you need to choose starting pitchers and starting lineups. One screen shows all
of your active pitchers, with key ratings, statistics, and fatigue information. Another shows all of your active batters,
again with key ratings and statistics. You can easily access the full statistical and ratings display for a player. And
you can look at the same information for your opponent so you can tailor your choices to his strengths and
weaknesses.
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NOTE: If you are using the DMB computer manager, it will automatically choose the starting pitchers and lineups for teams that
it handles. You can look at all of this information for a computer-managed team, but you cannot make any changes to the lineup.

Before the game starts, DMB displays summary information about your pitchers and a menu of commands for
choosing a starting pitcher.
You choose starting
pitchers TO
for both
teamsCONVERTER
before selecting starting
lineups, because
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it is important to know whether the opposing pitcher is right- or left-handed when choosing starting lineups. The
home team is displayed first, because baseball rules require the home team to name its starting pitcher first, but
you can select your players in any order.
The list of players on the roster always starts with the status (under the "S" column) and name of each player.
Some of the status codes can occur only as a result of things that happen during a game:
For in-depth information on lineups, see Overview of Lineup Selection in the Lineups topic. You can learn more
about the player status codes in the Player Status Codes topic.
Next, we'll look at the process for selecting a starting pitcher.

BY THE

Starting Pitchers
In this tutorial you are going to control all of the action for your team. When you start play, the first thing you will see
is the screen below, which allows you to select the starting pitcher for your team.

If the DMB computer was managing your opponent, you'll see that it has already selected its starting pitcher as
shown in the area in the lower right of the screen. In this example you can see that the DMB computer is starting
Don Newcombe.
To set the starting pitcher:
1. Review your pitching ranks and select the pitcher you think will make a good starter for this game. Remember to
check the status codes for the pitchers. Click once on the pitcher's name and release the mouse button.
2. Position the mouse near the top or bottom edge of the player's name. When the cursor changes from the normal
arrow cursor to the special drag-and-drop arrow, left-click again , hold your mouse button down, and drag the
player over to the "Current lineup" area on the right side of the screen and release the mouse button.
NOTE : By default, DMB places the pitcher you select in the 9th position in the batting order. You can change this later if you
wish, when you set the final batting order.

3. Click the OK button to proceed to setting the batting order.
I MP ORTANT ! You must click the button labeled "OK" on this screen before you can set the batting order.

Batting Order
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Batting Order
Once the starting pitchers have been selected for a scheduled game, you can proceed to set the batting order.
When you clicked "OK" after selecting your starting pitcher, the DMB screen switches to show you the player roster
for your team. As with the pitching roster, you can click the checkbox labeled "Show available only" to filter the
roster.
To set the batting order:
1. Click once on the name of a player you wish to add to the batting order and release the mouse button.
2. Position the mouse near the top or bottom edge of the player's name. When the cursor changes from the normal
arrow cursor to the special drag-and-drop arrow, left-click again, hold your mouse button down, and drag the
player over to the "Current lineup" area on the right side of the screen.
3. Hover your mouse pointer over the position in the batting order you want the selected player to fill and release
your mouse button. DMB displays a popup menu so you can choose his defensive position.
NOTE: You will be able to change the order before playing the game if you wish.

4. Choose a defensive position from the popup menu.
Notice that as you fill positions in the batting order, the positions they play change from red to blue in the area just
below the current lineup. This is simply to help you see what positions need to be filled.
When the pitchers have been selected and the lineups are set, click OK and play ball.

League Setup Overview
All copies of Diamond Mind Baseball come with our All-time Greatest Teams #2 disk, so you will always have at
least one league installed with your game. Many people are happy playing games with real-life teams on this disk or
others from the many season disks available from DMB.

But at some point many customers
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If you have
UNREGISTERED
VERSION
OF CHM
STANDARD
BY THE
reached this point, this tutorial will explain the choices you face and the steps you should follow. The possibilities
are endless. Among them are keeping big-league teams and parks but drafting new rosters; creating fictional
teams, assigning them to parks and drafting big-league players; and building a super-league of favorite teams from
a variety of seasons.

If you are new to the game,
you may wantOF
to begin
by learning
about the
Organizer, Your Primary
Tool for building BY THE
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If you are already familiar with the game's components, you can go straight to Common Scenarios for building
leagues to see if one fits your plans.
If none of the scenarios fit, if you are new to the game or if you want to take a more methodical approach to
building your league, we will also walk you through the steps it takes to bring your vision to life:
General Rules explains the basic rules that apply to all Diamond Mind Baseball leagues.
Preparing the Database outlines how to create a home for your league that will contain everything you need to play
games, manage rosters and track statistics.
Gathering the Components describes how to populate your database with real or fictional teams, ballparks, players
and eras, and what role they'll play in your league.
Putting It All Together helps you name and structure your league, create your teams, fill out their rosters, and build
a schedule -- the final steps that will leave you ready to play.
One more word before getting started: The process of setting up a league involves many Diamond Mind features.
Rather than repeat large chunks of the Help file in this tutorial, we will sometimes direct you to relevant material
elsewhere in the file. As these cases come up, we will remind you that you need to click the Back button to return
to the tutorial.

Your Primary Tool
The Diamond Mind Organizer is the primary tool used to create or modify leagues, teams, and players. If you're not
familiar with this tool, a word of introduction is in order.
To access the Organizer, choose Organizer from the View menu at the top of the main screen. The following
window appears:
NOTE : The contents of this display will vary, and may even be blank, based on the particular database you are working with.

The tabs across the bottom allow you to switch easily from one category of items to another. When you click on a
tab, the main body of the window shows a list of all items of that type. Each list shows the name and several useful
attributes of each item.
Across the top is a row of buttons that, when clicked, allow you to create, copy, modify, delete, import, or view one
or more items in the list. If a button is deactivated (grayed out), it means that command is not applicable to items of
the type in the currently active tab.
To execute some commands (modify or delete, for instance), you must first select one or more items from the list
so DMB knows which item(s) you want the command to act on. To select a single item, click once with the left
mouse button. To select multiple items (usually appropriate only when you want to delete several things at once),
use the techniques described in the Selecting Multiple Items in a List topic. (This link carries you to another topic in
this Help file; when you have read it, click on the Back button to return to this tutorial.)
You can also invoke commands by right-clicking on the list of items. This causes a popup menu to display with the
commands that are appropriate for the currently active tab.

WARNING! If you wish to modify or delete an item using the popup menu technique, you must first left-click to select the item,
then right-click to display the popup menu. If you wish to delete one or more items, keep in mind that the item(s) to be deleted
are the ones that are highlighted. If, for example, you select the second item in the list, then right-click on the fourth item and
choose Delete, it's the second item that is deleted. Right-clicking on an item to display a popup menu DOES NOT select that
item for deletion.

If you double-click on an item, DMB immediately carries out a default command. For most items, the default
command is Modify, so the appropriate modification window appears immediately. Double-clicking on a player
displays his Profile (because player modification is something that most users rarely or never do).
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Common Scenarios
Their particulars vary, but many Diamond Mind leagues fall into one of several basic configurations. If you have in
mind one of the following approaches, you can build your league by following the links to each of the steps we
outline. (After viewing one of these links, click the Back button to return.)
1. If you are taking existing teams from multiple DMB Season Disks and putting them into a new league structure:
Create a new empty database.
Import the teams you want, making sure to include their parks.
If the eras you want aren't already there, import them from the Historical Eras database or another database.
Create your league or leagues.
Assign the teams to divisions.
If you want a two-league setup with inter-league or post-season play, create an organization.
Create a schedule.
2. If you are using the player pool from a single DMB Season Disk but want to draft new rosters onto existing, reallife teams:
Copy the existing database.
Release the players from their real-life teams.
Delete the team-specific records for multi-team players.
Create and run the draft.
Tweak the computer-generated manager profiles.
3. If you are using the player pool from a single Season Disk but want to draft new rosters onto fictional teams:
Copy the existing database.
Delete all real-life teams using the Organizer window, a step that also releases the players into free agency.
Delete the team-specific records for multi-team players.
Create the fictional teams you want.
Import and assign the ballparks in which they will play.
Import the eras you want from the Historical Eras database or another database.
Create your league or leagues.
Assign the teams to divisions.

If you want a two-league setup with post-season play, create an organization.
Create and run the draft.
Tweak the computer-generated manager profiles.
Create a schedule.
If you find that terms in this list don't make sense, have in mind a scheme we don't cover or simply prefer a more
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starting point is the General Rules that apply to all DMB leagues.
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General Rules
DMB allows you to customize many of the rules under which your league will operate -- the number of games to be
played, for example, whether the DH is used, or if weather should influence play.
But certain fundamental rules apply to all leagues. They are as follows:
A league can have a maximum of four divisions of 16 teams each.
A team can be in only one league at a time.
A player can be on only one team at a time. (The exception is multi-team players, created by DMB for players
who were traded during the regular season.)
If inter-league or post-season play between two leagues is part of your plan, the leagues must be grouped
into what DMB calls an "organization."
The rules of an organization govern play for all leagues within it.
With these rules in mind, you're now ready to build and populate your own league. You can check Common
Scenarios to see if one fits your plans. Or you can take a methodical approach and start at the beginning: preparing
the database that will contain and track your league and its records.
Your First Database Decision

Your First Database Decision
Your first decision is whether to work from scratch by creating a new database and populating it with leagues,
teams and players, or whether to copy and then modify an existing database.
There is no wrong answer. But making the better choice for your purposes will simplify your league setup.
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Starting with an existing database makes sense if you intend to work primarily from a single Diamond Mind season
disk -- the All-Time Greats #2 disk, for example, or the 2003 season. As each disk is installed, the game places it in
its own database. In building your own league, you can either work directly with an existing database or make a
copy of it.
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league using real-life teams or players, it's best to make a copy of the database and set up the new league using
the copy. That way, you'll end up with two databases, one set up like the real-life 2003 season, and one with your
league set up however you want.

If, on the other hand, you're pretty sure you don't want to use the 2003 Season Disk in its original form, you can set
up your league using the original database. You won't be stuck even if you later decide you want to use the real-life
2003 rosters. You can always reinstall the 2003 Season Disk (from the original CD, diskette, or file that was
emailed to you from Diamond Mind) into a new database at a later date.
Starting with a new database makes sense if you intend to draw teams from a variety of season disks or create
teams all your own. Starting with an empty database makes building your league a matter of addition, because you
can import only those teams, parks and players you wish to work with.
Not familiar with the role of a database in Diamond Mind Baseball? Now is a good time for a database briefing.
(This link carries you elsewhere in the Help file; when done, click on the Back button to return to the tutorial.)

Starting with an Existing Database
To copy an existing Diamond Mind database, it must be the active database. To check or change the active
database, click File on the Diamond Mind menu bar and select Change active database from the pulldown menu.
The following window appears:

If the current database is the one you wish to copy, click Cancel and proceed. If you wish to select a different
database, select it and click OK.
Next, click File on the DMB menu bar and select Copy this database. The following window appears:

When this window displays, DMB assumes you want the new database to be stored within the main DMB folder. If
you wish to copy the database to a different location, click on the ellipsis button (the "..." button in the image above)
to open the following window:
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When you have selected the location for your database, enter a name for the new database in the database
creation window. This name must be different than that of the database you copied, or any other DMB database
you have installed. Click OK.
You are now ready to begin gathering the components for your league.

Starting with a New Database
To create a new Diamond Mind database, click on the File menu at the upper left of the main screen. From the
dropdown menu, click on Create new empty database. The following dialog box appears:

When this window displays, DMB assumes you want the new database to be stored in a folder contained within the
main DMB folder. If you wish to create the new database to a different location, click on the ellipsis button (the "..."
button in the image above) to open the following window:

When you have selected the location for your database, enter a name for the new database in the database
creation window and click OK. Make sure you give this new database a name that isn't already being used by
another database.
Having created a home for your league, you are now ready to gather the components for it.

Introducing the Components
In assembling your league you will work with four basic components: Eras, Teams, Parks, and Players. When you
have these components in place, you can put them together by creating one or more leagues, possibly grouped to
form an organization, and then creating the league schedules you need to play games.
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players to include in your database and how to assemble them.

An Era determines several important aspects of the playing conditions for your league games. Diamond Mind has
created an era that reflects the norms of performance for each real-life big-league season, as well as a neutral era
that reflects the norms averaged over the past century. Each era specifies the level and type of offense (walk rates,
strikeout rates and the frequency
with which
batted
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make errors and how durable pitchers will be. For more on how to decide which eras to use and how to get them
into your database, see Assembling Eras.
A Team is a collection of players that is assigned to play its games in a certain home ballpark. For more on how to
put together the teams you want, see Assembling Teams.
Each team is assigned to a home Park. Ballparks play a very important role in Diamond Mind games, since some
parks (Coors Field) are very friendly to hitters, others (Dodgers Stadium) have historically favored pitchers and
others have relatively little impact on games played there. For more on choosing the parks you want to use in your
league, see Assembling Parks.
And, obviously, you'll need to gather the Players you need for your league before you can start playing any games.
See the Assembling Players topic for details.
Just because we're discussing these components in this order -- eras, teams, parks and players -- doesn't mean
you have to assemble them that way. You can work on them in just about any sequence you please, and you can
move back and forth between them at any time.
The primary tool you will use to assemble eras, leagues, teams and players is the Diamond Mind Organizer. If
you're not familiar with this tool, it may be helpful to read Your Primary Tool before you proceed.

THE

Assembling Eras
By choosing an era for your league, you decide whether you want to see dead-ball baseball (high batting averages,
few homeruns, walks and strikeouts, lots of errors, many complete games), 1960's baseball (very low batting
averages with moderate rates of walks, strikeouts, homeruns, errors and complete games) or modern baseball
(moderate batting averages, lots of walks and strikeouts and homeruns, very few triples, almost no complete
games and historically low error rates). You can choose other historical styles of play, or even some combination of
styles.
If you are not already familiar with the role that eras play in Diamond Mind Baseball, or the factors that make up an
era, this might be a good time to review the Overview of Eras topic elsewhere in the Help file. (Click on the Back
button to return to this tutorial after reading it.)
For playing league games, you usually need only one or two eras in your database. Each league uses only one era,
so if you plan to create only one league, you'll need just one era. If you plan to mirror the real-life setup of two
leagues linked by an organization for post-season or inter-league play, you can use the same era for both leagues
or use a different era for each.
You may find the eras you want are already in your database. If so, there's nothing more to do at this stage. When
it comes time to assign eras to your league(s), you can choose from those eras.
If the eras you wish to use are not already in your database, you have several options.
The first is to import eras for your league from another database. The single most useful source is the Historical
Era Database, which comes with your game. This database contains an era for every big-league season since
1894. To access this database open the Organizer window. Choose the Eras tab, click on the Import button, and
then scroll down the list of databases. The Historical Era Database is at the bottom of the list.
In some cases you may not wish to use an era that DMB provides. Say, for example, that you are replicating a reallife minor league, or wish to average major-league norms over an entire decade rather than a single year.
In either case, you will need to research such factors as the durability of pitchers and the frequency of errors. Once
you have your numbers in hand, two options for creating a unique era are available. You can create an era using
the Organizer window. Or you can modify an existing era, using the same tool. (These links carry you to another
topic in this Help file. When you have read one, click on the Back button to return to this tutorial.)

Assembling Teams
At this stage of the tutorial, we'll focus on gathering the teams you wish to use in your league. (We'll deal with their
rosters later.) The fundamental choice you face is whether to use real-life teams or fictional ones.
Real-life teams
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If your goal is to create a new league using real-life teams, your task is to get the right teams into your database.
Once they're there, you can release their players for a draft, make trades, sign free agents -- or simply create a
schedule and play.
If the team you want is already in your database but is committed to another league, you need to release it from the
first league. That's because
a team can only
belong
to one
league
in a CONVERTER
single database.
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One option is to delete the other league altogether by clicking on the Leagues tab in the Organizer window, clicking
on the league to be deleted, and then clicking the Delete button. This releases all of its teams for use in the new
league.
If you're only interested in one or a few teams from an existing league, you can release those teams from that
league individually using the Modify League function in the Organizer window.
If the team you want is in another database, you can import it for use in your league. This function makes a copy of
the team, so importing a team for your league does not remove it from the original database. When you import a
team, its players come with it. You also have the option of bringing along its home park and the era in which it
played.
Fictional teams
If you want to populate your league with fictional teams, you can either gather real-life teams as explained above
and then modify their characteristics, or create new teams altogether.
The choice is largely a matter of preference, because either option can bring you to the same destination. If you
modify the hometown and nickname of a real-life team to suit your purposes, for example, you can preserve its
association with a ballpark. But this saves you only one step and a few keystrokes. So you may find that it's simpler
to start fresh and create your teams from scratch.

THE

Assembling Parks
As any fan knows, the size, shape and playing surface of a ballpark have a big influence on play. So does the
weather. All these factors are reflected in Diamond Mind's ballpark ratings, so choosing the parks in which your
teams play is an important step. (You can read a parks overview elsewhere. Click on the Back button to return to
this tutorial.)
If you are working with real-life teams, they are probably associated with their home ballparks already. For example,
if you import a team into your database, DMB gives you the option of bringing its ballpark along with it.
But if you have created fictional teams, or if you would like your real-life teams to have a different home, then you
will need to gather the parks in which they might play. DMB provides you with two basic options for achieving this.
First is importing parks individually from another DMB database. For example, every copy of DMB comes with the
All-time Greatest Teams #2 disk, which contains the 1955 Brooklyn ballclub. So you can import Ebbets Field (as it
played in 1955) and "move" your 2003 club out of Los Angeles and back east.
Because ballparks change over time, so do their ratings. And, of course, no ballpark is forever. So Diamond Mind
has compiled a historical database with the park dimensions and statistical factors for every ballpark that has been
used since 1901. This database is a separately priced product that you can purchase and install along with your
DMB game. If you have installed this database, you can import any of these parks into your database for use in
your league.
Your second option for gathering parks is creating them. This is a matter of entering general, physical and weather
information along with statistical factors that will affect events on the field. In addition, you will need to associate
your park with a ballpark image.

Assembling Players
One of the most basic decisions you make when creating a new league is choosing the pool of players who will
participate.
If you are creating a new league using real-life teams, this is easy. You simply gather the teams you want into a
single database, keepingVERSION
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But if you are drafting new rosters -- onto real-life or fictional teams -- you must assemble the players who will
populate your league.
One common approach is to work primarily or exclusively with players from a single Diamond Mind season disk -the 2003 season, say. InVERSION
this case, gathering
players
involves
releasing
them from their original
rosters.
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This can be done on a player-by-player basis by using the roster management window. This works well if you
intend to place only a few players from any particular team into the draft, but releasing large numbers of players
this way would be very time-consuming. A better option in such a case is the release all players function, which, as
its name suggests, releases all players from their teams and deposits them in the draft pool.
At this point, if a real-life player played for more than one team in a single season, he may now exist in several
incarnations in your player pool: a partial record reflecting his performance for each of his teams, and a composite
record reflecting his overall season performance. Running another Diamond Mind function -- delete team-specific
records -- removes the partial player records and leaves only the composite records in your draft pool. (You can
also prune your draft pool by deleting individual players through the Organizer window.)
If you are drawing your players from more than one season disk, you have two options for gathering them. One is
to import players individually from other databases; this function copies the player for use in your league while
leaving the source database untouched. If you want members of an entire team available for your league -- say, the
1927 Yankees -- you can import the team. If you then delete the team, its players will remain in your draft pool.
Perhaps you'd like to be in the league yourself, or to include a real-life historic player not available to you on
another Diamond Mind roster. With a bit of research, you can create a player. It's also possible to modify an
existing player.
Now -- with your eras, teams, parks and players all assembled -- it's time to put your league together.

The Big Picture
By now you have assembled all the components for your league: the database that will contain everything you need
to play games, manage rosters and track statistics; the era that will set the norms for batting, pitching, and fielding;
and the teams, ballparks and players that will be involved.
Now it's a matter of putting the pieces together.
First you'll need to create a league -- or leagues, if you have in mind something like the current big-league
structure. Each league can have a maximum of four divisions with 16 teams each. Each can have its own era, or
they can share the same one. In creating a league you will also set rules for league play.
If you are creating more than one league, and envision either inter-league or post-season play, you will need to
group your leagues within an organization. There can be only two leagues within an organization, and only one
organization within each database. The rules of the organization will govern play for the leagues within it.
The next step is assigning your teams to leagues and divisions. No team can be assigned to more than one league
at a time, so you may need to free teams from another league to make them available for yours.
Next comes assigning players to teams. If you are simply assembling real-life teams into a new league structure,
this task is already done. But if you are building or tweaking your own rosters, you can assign up to 80 players to a
team by running a draft, making trades or signing them through a team's roster window.
Before playing games in which you use the computer manager or the Quick Play option, every team must have a
well-crafted manager profile to guide the computer manager in its decisions about starting pitchers, starting lineups,
tactics, and substitutions. All Diamond Mind Baseball season disks include manager profiles, so if you have
imported a real-life team from another database, chances are it already has the manager profile it needs. And if you
built a team using the computer drafting option, a manager profile will have been created for that team
automatically. If, however, you built a team by hand, you will need to generate a manager profile using the
Generate manager profiles command on the Tools menu or create one using the tools in the Roster/manager
profile window. In any case, it never hurts to review the manager profiles for each team and make any necessary
adjustments.
The final step is generating a schedule for league play. You'll determine such factors as how often teams should
face their intra- and inter-divisional rivals. DMB will take care of the rest -- leaving you ready to play ball.

Creating a League
Your next step is creating your league and setting the rules and options that will guide play. We'll cover setting up
divisions and assigning teams later.
You can set up additional leagues in the same database. They can operate with complete independence, although
no team can be assignedVERSION
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To create a new league:
1. Click View on the DMB menu bar and select Organizer .
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2. When the DMB Organizer screen appears, select the Leagues tab.
3. At the top of the Leagues tab, click the button labeled New . The following screen will appear:

4. Enter a name for the league and a year . The year has no particular significance, so you can fill it in as you wish.

5. Select the era for your league (See Introducing the Components to review the significance of this choice).
6. Leave the inter-league play and schedule categories unchanged. You cannot make these selections until later
in the process.
7. Click on the Rules/options tab at the top of the window. A new form comes forward, leaving you with an
important series of choices to make . (This link carries you to another topic in this Help file; when done reading it,
click on the Back button to return to this tutorial.)
8. Click OK to add the league to the database, or Cancel to quit without saving this new league. You don't need to
set the Post Season information until you are ready to begin post-season play. (This link carries you to another
topic in this Help file; when done, click on the Back button to return.)
If you have created more than one league, your next step is linking them through an organization. Otherwise, you
are ready to line up your teams .

Creating an Organization
An organization links two leagues so they can share a common set of rules and options, play inter-league games,
and meet in post-season play. If you want to use the Diamond Mind features that support post-season play
between two leagues, you need to make those leagues part of an organization before the season starts.
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games during the regular season. You can set up the organization just to share the rules and options for postseason play. It is also possible to mirror real-life and use the DH in one league within an organization, but not in the
other.
If you do choose to set up an organization, you will be required to name the two leagues that compose it. Both

leagues must be in the same
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the organization,
you can
create only one organization
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To create an organization:
1. Click View on the DMB menu bar and select Organizer. When the DMB Organizer screen appears, select the
Orgs tab.
2. To create a new organization, click the button labeled New. The following tabbed window appears:

3. Enter a name for the organization and a year. The year has no particular significance, so you can fill it in as you
wish.
4. Select the two leagues that will compose the organization.
6. Click the inter-league play box if you wish teams in the two leagues to meet during the regular season. Leave
the schedule category unchanged. Later in the process, when you create a schedule, you will link it to your
organization.
7. Now click on the Rules/options tab at the top of the window. A new screen comes forward, leaving you with an
important series of choices to make. (This link carries you to another topic in this Help file; when done reading it,
click on the Back button to return.)
NOTE: The rules of an organization take precedence over those of a league, so your selections here will dictate play for both
leagues. It is possible, however, to allow the DH in one league but not in the other. First, the teams in the DH league must be
individually designated "DH Ok" while those in the non-DH league are individually designated "No DH." Then, under the
Rules/options tab for the organization, set the DH rule to "HomeTeam DH Rule."

8. Click OK to add the organization to the database, or Cancel to quit without saving this new organization. You
don't need to set the Post Season information until you are ready to begin post-season play. (This link carries you
to another Help file; when done reading it, click Back on your browser to return.)
Now you are ready to line up your teams.

Assigning Teams
It's time to create the divisions that will give your league its internal structure and assign your teams to their home.
Diamond Mind Baseball provides you with great flexibility in this respect, as in others. You may create up to four
divisions in a single league, and each division may have up to 16 teams. At the other extreme, you can place an
entire league of up to 16 teams in a single, unnamed division, just as in real-life days gone by.
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To create divisions and assign teams:

1. Click View on the DMB menu bar and select Organizer . The DMB Organizer screen appears. Click on the
"Leagues" tab at the bottom of the screen.

2. Select the league you VERSION
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at the top of the "Modify League" window. The following form appears:

3. To name a division, click on the first empty column header field (starting from the left) and type the division
name -- for example, "Senior," or "Junior," etc. If you intend to have only one division, you do not need to name it.

Do not skip a field and then add teams to a subsequent field. For example, if your league is going to have two
divisions, you must use the first two division fields.
4. To assign a team to a division, look at the Available teams list on the right side of the window. This window
displays every team in your database that is not currently assigned to a league. Left-click on any team in the list to
select it, and then right-click. DMB displays a pop-up menu listing the divisions:

Click the appropriate division and the team will be assigned to it.
NOTE: There are two common pitfalls in this process. If you assign a team to the wrong division, you can reverse yourself by
selecting it, right-clicking and then choosing another destination for it. If you a expect a team to be available and don't see it
listed, odds are it's still assigned to another league in your database. Using the Organizer window, select that league and choose
Modify to open the Modify League window; then choose the Teams tab and release the team from that league.

5. When your league is configured as you want, click OK .
If you plan no changes to your teams' rosters, you are ready to generate manager profiles or create a league
schedule . But if you are tweaking or building your team rosters, next you will want to assign players by holding a
draft, signing individual free agents, or making trades.

Assigning Players
If you have imported existing teams into your league and don't plan to change their rosters, you are ready to check
their computer managers or create a league schedule.
But if you plan to make roster changes, Diamond Mind provides you with three options for doing so: running a draft,
signing individual free agents
through a team's
window,
making
trades.
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We'll introduce you to each in turn, and provide links to detailed discussions of each option. If you follow a link to
material elsewhere, click Back on your browser when ready to return to this tutorial.
1. Drafting
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A draft is an organized process in which teams select players from a free agent pool. If you want to have every
team in a league or organization take turns drafting free agents -- manually, by computer, or in combination -setting up and running a draft is the way to go. You will find the computer to be a skilled general manager, one that
makes choices by comparing a team's needs and the available players with each passing round. A complete
overview of the drafting process is available elsewhere.
Before conducting a draft you must create a pool of free agents, either by importing players individually or by
releasing them from their current teams. If the pool contains players who played for more than one team, you
should delete their partial season records while leaving a single, composite record for the player in place. More on
creating the free-agent pool is available elsewhere.
Your options for structuring and conducting the draft are many. The following topics elsewhere in the Help file
explain the process in detail:
Creating a draft
The draft window
Setting the draft order
Adding, deleting, and trading picks
Making manual picks
Computer drafting
Drafting and manager profiles
Pausing and resuming a draft
Deleting a draft
2. Signing individual players
If you wish to sign a few free agents for a particular team, or to release a few players from the roster, you can do so
through DMB's Roster/manager profile window. An introduction to this window is available elsewhere, as are
detailed instructions on how to sign free agents, release individuals and make other changes to a team's roster.
3. Making trades
Perhaps you wish to adjust your rosters by trading two or more players between two teams. DMB's Trade Players
function allows you to manage such transactions in a single, simple process.
If you have built your roster manually, or have signed individuals or made trades, it's necessary to update your

computer manager; in any case, you may wish to check and tweak the managerial decisions the computer has
made. Then, with one more step -- generating a schedule -- you'll be ready to play.

Generating a Manager Profile
The Manager Profile is the brains of a team's on-the-field operation. If you plan to have the computer manage a
particular team, it MUST have a complete Manager Profile to function at its competitive best.
If you have imported teams whole into your league, or had DMB build teams through the draft, these teams already
have their Manager Profiles.
Nevertheless,OF
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Perhaps you'd prefer to use a different relief pitcher as your closer or give more playing time to a promising young
player.
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If you have drafted a team yourself, or made changes to its roster through individual signings or trades, you must
to update the Manager Profile for your team to function well under computer management. Even if you plan to play
all of a team's games yourself,
having a complete
Manager
Profile
will simplify
such steps as loading
a starting
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lineup and selecting your starting pitcher. If you intend to use the Quick Play function during any game, you will
also need a well-formed Manager Profile.
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In such cases, you can build the profile yourself step by step. But you will probably save time if you have the
computer build the Manager Profile and then make any adjustments you see fit.
If you're ready to get to work, let's move on to the detailed instructions elsewhere in the Help file. (If you follow this
link, click on the Back button when ready to return.) Then, once you've generated a schedule, you'll be ready to go.

Creating a Schedule
It's time for your last step: the schedule.
If your league is not part of an organization, the league will have its own schedule. If it is part of an organization, it's
the organization that has the schedule. An organization schedule can include inter-league games, but it doesn't
have to. An organization schedule is necessary, however, for two league champions to meet in post-season play.
Diamond Mind provides you with a powerful tool for generating a schedule. The first step is to use the
View>Organizer command to open the Organizer window, click on the Schedules tab, then click on the New
button. The follow window appears:

Enter a Name for your schedule. Use the Scope pulldown to indicate whether this schedule is intended for a
league or an organization, then use the Owner pulldown to link the schedule to your league or organization. If the
Owner is an organization, check the Inter-league play box if you wish to play inter-league games during the regular
season or post-season.
When you have finished making your selections, click OK. The new schedule appears on the "Schedules" tab of
the Organizer.
At this point, there are no games in the schedule. The DMB scheduling tools give you several options for filling it
out. (The following links carry you elsewhere in the Help file, so click on the Back button when ready to return to
this tutorial.) You can:
generate a regular-season schedule by filling in a form that indicates how many games each division should
play against each other division
select a schedule template that matches the structure of your league or organization and build a schedule
using that template
create a schedule outside of DMB (perhaps using a spreadsheet or database product), save it as a commadelimited text file, and import that text file into DMB
create a schedule by adding games one at a time, adding a group of games, copying blocks of games,
inserting and removing off days, and using the other schedule editing commands
With the schedule completed, your league is ready for play. Enjoy!

What is a Database?
A Diamond Mind Baseball database contains everything you need to play games (leagues, teams, players, parks,
schedules, real-life statistics and ratings), track the results of those games (boxscores, scoresheets, game scores,
and computer-league statistics), generate reports, and manage a season from start to finish.

In earlier versions of DMB,
databases were
referred
to asTO
season
disks,
player directories, or
player disks. For BY THE
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a variety of reasons, each of those terms is outdated. A database can contain all of the items needed to play a
single season, but it doesn't have to be limited to one season. A database contains a lot more than just players.
With the advent of Windows95, directories are now more often described as folders. And CDs have replaced floppy
disks for many people. So we have adopted the term database because that's really what it is -- a collection of data
of various types that you put together for the purpose of playing league games or exhibition games.
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Each database is stored in a separate folder on your hard disk. We generally find it easiest to manage those
databases if they are all stored as subfolders within the folder in which you installed the Diamond Mind Baseball
game. But you can create a database anywhere on your hard drive or on a network.
If you purchase a Season Disk, Greatest Teams Disk, or Greatest Players Disk from Diamond Mind, you can install
it using the Install season disk command on the File menu. These products are shipped as a single compressed
file that you can receive via email or through the mail on CD or diskette. The install command takes care of creating
a folder on your hard drive, extracting the files, and adding this new database to the list of databases that you can
use with DMB.
All copies of DMB come with our Greatest Teams #2 disk, so you will always have at least one database installed
with your game. Whenever you have more than one database installed, one of them is the active database. This is
the database whose contents display in the Organizer window, and from which you select games to play, and
where the data for the reports is found. You can use the Change active database command to switch among the
databases that are installed with your game.
Many people find that they never need to create their own databases. They are quite happy playing games from
one of the many season disks and greatest teams/players disks that are available from Diamond Mind. But you can
create your own databases, too. Here are a few reasons why you might want to do that:
you can import teams (along with their players and parks) from one database to another so you can create a
new league using teams from different Diamond Mind season disks
DMB includes the tools you need to create your own players, parks, teams, leagues, and schedules from
scratch
using the players from one Diamond Mind Season Disk, you may want to play some seasons using the reallife rosters and schedules, while playing other games using totally new rosters drafted from the same player
pool. You can do this by creating one or more copies of the initial database and setting up a different league
in each of these new databases.
For these reasons, DMB provides commands for creating a new database (either an empty one or a copy of the
currently active database), deleting a database, and switching to a new active database.
If there is a database on your hard drive or your network that Diamond Mind Baseball doesn't know about, you can
add it to the list of available databases with the Add reference to existing database command. Such a database
might have been created with an earlier version of Diamond Mind Baseball, or you may have created it outside of

the game using Windows commands to copy folders and/or files.
Anytime you install a Diamond Mind Season Disk, add a reference to an existing database, or choose a new active
database, DMB checks to see what version those files are in. If DMB detects that this new database not already in
the new format, it asks you whether you wish to convert it to the new format. If you say no, DMB will not allow this
database to become the active database. If you say yes, DMB converts the data from it's old format to the format of
the current version of the game. (Sorry, DMB cannot convert data in formats older than version 5.)
Because many of you will pour dozens or hundreds of hours into playing DMB games, it's always a good idea to
make backups of your active databases from time to time. For that purpose, DMB includes commands that assist
you in backing up and restoring your DMB databases.
Finally, many of you create leagues for your own use or play in leagues with other DMB owners that carry rosters
forward from year to year. You can use the Migrate command to carry forward the structure of your league (rules,
divisional setup, schedule, rosters) from one year to the next. If not for this command, you would have to spend
many hours setting up your league when the new season disk is published each year.

Converting Databases
Whenever you install a Diamond Mind Season Disk, add a reference to an existing database, or choose a new
active database, DMB checks to see what version those files are in. If DMB detects that this new database is not
already in the new format, it asks you whether you wish to convert it to the new format.
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If you say no, DMB will not allow this database to become the active database. If you say yes, DMB converts the
data from it's old format to the format of the current version of the game. (DMB cannot convert data in formats older
than version 5.)
With very few exceptions, DMB converts 100% of the information that was contained in the database being
converted, including:
all eras, leagues, parks, teams, players (with all of their real-life statistics and ratings), schedules, real-life
transactions and lineups (if present), and notes
game results, statistics, injury logs, and transaction logs for games played with DMB
In other words, even if you are in the middle of playing a league season, you can convert a database to the new
format and pick up right where you left off, with the following limitations:
new versions of DMB may compile statistics that were not kept in earlier versions. If you convert in midseason, these statistics will start at zero. In most cases, this is completely harmless, but it sometimes leads
to odd-looking data. Suppose Saves were recorded in version X but Save Opportunities were not added until
version Y. If you convert mid-season, you'll have some pitchers with more Saves than Save Opportunities.
That won't hurt anything, but it will seem like an error unless you remember that this is the result of
converting in mid-season.
previous versions of DMB allowed you to play unscheduled league games. All DMB league games must now
be part of a schedule, and you will lose information if you try to convert a league that wasn't already using a
schedule in the prior version. If your league play included unscheduled games, we don't recommend that you
convert in mid-season.
When the conversion is complete, you have the option to view and/or print a log of the conversion activity. In most
cases, that log will simply report that the conversion was able to successfully convert everything in your database.
If any problems were encountered, the log will contain warnings or error messages.
The following sections describe aspects of the conversion logic that you may want to think about, especially if you
are converting a database that includes a DMB season that is in progress. In those sections, you'll see a number

of references to things that were added to version 8. You can ignore those items if you are converting a database
from version 8 to version 9 format, but we include them for cases where you're converting to version 9 from version
7 or prior.

Eras
In all DMB versions prior to version 8, the statistics for an Era consisted of the batting average, slugging
percentage, doubles, triples, homeruns, walks and strikeouts. These were the values available in the Macmillan
Baseball Encyclopedia, which was the main source of historical statistics through the early 1990s.
But DMB needs more information than this to produce the most accurate results, so those versions of DMB would
estimate the number of atbats, hits, hit batsmen, and intentional walks. Version 8, however, added the ability to
enter exact values for these items, so estimates are no longer required when you create an Era using the latest
version of DMB.
When you convert Eras from version 7 or prior, the DMB conversion logic fills in these values with the estimates
that it uses. In many cases, these estimates will be quite close to the real thing, and DMB will continue to produce
very accurate results for leagues that play their games using these Eras. However, if you know what the real values
are, we recommend that you take a couple of minutes to enter those real values using the Organizer.
It's quite possible that you won't know the exact values for the hit batsmen and intentional walks, since these are
not included in most encyclopedias, and intentional walks were not recorded prior to 1954. If you don't know these
values, or if the Era you are converting uses statistics from prior to 1954, we recommend that you continue to use
the estimated values.

Teams
In version 8, we added two new team statistics -- runs scored and runs allowed -- to the database. These values
are set to zero by the conversion logic. If you convert a pre-version 8 database while a DMB season is in progress,
DMB will begin compiling these statistics for any games played after conversion, so the values will not include any
games played with the older DMB version.

Parks
DMB includes more than 80 image files for current and historical parks. If you are converting a pre-version 8
database, the conversion will assign one of these image files to your parks if the name of your park matches the
name of one of the parks in our collection. Otherwise, the park will be assigned a generic park image. After the
conversion has been completed, you can use the Organizer to assign images for these parks if you like.

Players
For version 8, we added several new player statistics -- holds for relief pitchers, stolen bases and caught stealing
for pitchers and catchers, defensive innings for all fielders -- and added intentional walks to the left/right splits for
batters and pitchers. In all cases, if you convert a pre-version 8 database while a DMB season is in progress, these
new statistics will begin at zero, so they will not include stats from any games played with the older DMB version.

Leagues
There a few new rules and options for leagues that you might want to consider setting before beginning to play

games with a database that was converted from a version prior to version 8.
You can choose whether to use DMB's clutch hitting system. The conversion logic assumes that you want to use
this feature.
You can specify whether boxscores, scoresheets, game logs, and game accounts are to be saved automatically at
the end of each game. The conversion logic assumes that you do NOT wish to save these items.
Versions 6 and 7 included an option to save game-by-game statistics for your players. This option is also present in
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in the prior version, however, you may want to consider activating it because you can generate reports based on
time intervals only if this option is activated.

Organization

UNREGISTERED VERSION OF CHM TO PDF CONVERTER STANDARD BY THE
The concept of an organization was added in version 8. If you are converting a version 7 database that was set up
for inter-league play, the conversion logic creates an organization linking those leagues.

Creating a New Database
You'll want to create a new database as the first step in creating a new league using teams, parks, eras and
players that you create or import from different databases. For details on setting up a league from scratch, see the
tutorial for Setting Up a League.
A newly-created database is empty except for the Neutral Era and the Neutral Park. You can then use the
Organizer window to create new items, import them from other databases, and organize them as you wish.
NOTE: You do not need to create a new database to use Diamond Mind Season Disks in the form they are shipped. The act of
installing a Season Disk automatically creates a new database.

To create a new database:
1. Click File on the DMB menu bar and select Create new empty database. The following window appears:

NOTE: The default location for the new database is the folder where you installed Diamond Mind Baseball. If you would like to
create your new database at another location, click on the ellipsis (...) button to open the following screen.
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2. When you have selected the location for your database, enter a name for the new database in the database
creation window and click OK.
When the database is created, you will be notified. When this operation is complete, the newly-created database is
the active database, and you can open the Organizer window to begin creating or importing items to populate this
new database.

Changing the Active Database
If you have more than one database for Diamond Mind Baseball, you can switch between them using the Change
Active Database feature.
To change the active database:
1. Click File on the DMB menu bar and select Change active database. The following window will appear:

The list shows all of the databases that are known to DMB except for the currently active database, which is shown
at the top.
Click on the database you wish to activate, and click OK. Or just double-click on the database you wish to activate.
If this database is not already in version 9 format, you will be asked whether you wish to convert it to the new
format. See Converting Databases for more information on the conversion process.

Copying a Database
Within a single database, a player can belong to only one team and a team can belong on only one league. But
what if you want to play some games using the real-life rosters and play others using the same players drafted onto
a whole new set of teams?

To do this, make a copy of
the database. You
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When you want to convert a database to the latest version of DMB while maintaining a copy of the database in the
old format, the copy command is ideal. In previous versions of DMB, you had to create the copy by using Windows
file management tools and then use DMB's Add reference to existing database command to convert to the new
format. The copy command
simplifies the OF
conversion
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combining
those steps into one.
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To copy a database:
1. Click File on the DMB menu bar and select Copy database. The following window will appear:

When this window displays, DMB assumes you want to copy the currently active database and store the new
database in a folder that is contained by the main DMB folder. If you wish to copy a different database and/or store
the new database in a different location, click on the appropriate ellipsis (...) button to open the following window:
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2. When you have selected the location of your old database and location for your new one, enter the Name of the
new database and click OK.
You will be notified when the database copy is complete.

Adding a Reference to an Existing Database
If there is a database on your hard drive or your network that Diamond Mind Baseball doesn't know about, you can
add it to the list of available databases with the Add reference to existing database command. Such a database
might have been created with an earlier version of Diamond Mind Baseball, or you may have created it outside of
the game using Windows commands (Windows Explorer or My Computer) to copy folders and/or files.
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To add an existing database:

1. Click File on the DMB menu bar and select Add reference to existing database. The following window will
appear:
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2. Use this window to locate the folder that contains the existing database. When you find the folder, double-click
on it and then click OK.
If this database is not already in version 9 format, you will be asked whether you wish to convert it to the new
format. See Converting Databases for more information on the conversion process.
When the database has been successfully added (and converted, if necessary), a message pops up to let you
know that this database is now the active database.

Removing a Reference to an Existing Database
If you have more than one DMB database on your system, you can use the Remove reference to existing database
feature to remove it. You may not, however, remove the currently active database. If you wish to remove the
currently active database you must first change to another database before using this feature.
To remove a database:
1. Click File on the DMB menu bar and select Remove reference to existing database. The following window will
appear:

The contents of your window may differ from this example.
2. Highlight the database you wish to remove and click OK. The reference to the database will be deleted and you
will be asked if you want to delete the database files.
3. Click Yes to completely remove the database. If you click No, the reference to the database will be deleted but
the database folder and all its contents will remain in your game directory. By keeping the folder and its files, you
can later restore this database by Adding a reference to an existing database.
NOTE: If you delete a folder that contains files that DMB does not recognize, you will receive a notice saying that the DMB files
were removed but the unidentified files were not and therefore, the folder was not deleted.

Installing a Season Disk
If you purchase season disks from Diamond Mind, you can use the Install Season Disk command to create a new
database and populate it with the contents of the season disk.
These products are shipped as a single compressed file that you can receive via email or through the mail on CD
or diskette. The install command
takes care
of creating
folderPDF
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To install a season disk:
1. Click File on the DMB menu bar and select Install season disk. The following window will appear:
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2. Locate the season disk file you wish to install. All Diamond Mind season disks are shipped as compressed files
with the ".exe" or ".alt" extension.
If you received your season disk through the mail, you can find this file on the CD or diskette that we sent you. To
install it, click on the "Look in:" drop-down list box at the top of this window, then click on the CD-ROM drive or
floppy disk drive in which you placed the disk we sent you. When the list of files on that disk is displayed in the
window, click on the file you wish to install.
NOTE: The CD-ROM drive may be titled "Diamond Mind BB (D:)" where (D:) represents the drive letter. The letter of your drive
may be different.

If you received your season disk via email delivery, you should be able to find it in the folder that you normally use
for files that are attached to email messages. Use the "Look in:" list box to navigate to that folder, then click on the
file you wish to install.
3. Click Open. The DMB Season Disk License Agreement appears. After you read and accept it, the following
window will appear:

4. In the first field, enter the location where you want to store the installed season disk. DMB assumes that you will
wish to create the folder for this season disk within the main DMB folder, but you can choose any location on your
hard drive or network by clicking on the ellipsis button.
In the second field enter a name for the new season disk, then click OK.
5. If this season disk is not already in version 9 format, you will be asked whether you wish to convert it to the new
format. See Converting Databases for more information on the conversion process.
When the installation is complete, the newly-created database will be the active database.

Migrating a Database
Whether you are playing on your own or in a league with other DMB owners, you may have created a fantasy
league with new teams and rosters. If so, you know that it can take a while to create the teams, organize them into
divisions and leagues, and draft the players onto their new rosters. The Migrate command enables you to carry
forward that league structure and those rosters and use them again with the next annual DMB Season Disk.
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As an example, let's assume you've finished playing a league season using the 2002 Season Disk and you've just
installed the 2003 Season Disk. You want to set up your 2003 Season Disk to have the same league structure as in
the previous season and to carry forward the rosters from the previous season.
The migrate command does just that. The real-life leagues and teams are deleted and replaced by the leagues and
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who appeared on both season disks is placed on the same roster that he was on the previous season; any player
on the new disk that wasn't on a roster the prior year is added to the free agent pool. At this point, you're ready to
draft rookies, free agents, and other players who did not play the year before.
To use the migrate command, you must have both season disks installed. The source database is the league
database for the season just completed, and the target database is for the next season to be played.

Universal player IDs (UIDs)
Migrate works only if both season disks are coded with unique identifiers for each player. This is the only way that
DMB can be sure that two players with the same name are really the same player. It is quite common to have
duplicate names in the player population, so the migration logic cannot rely on names alone.
Diamond Mind began coding players with unique identifiers in 1997. Just about every season disk that we have
sold since then has these UIDs. If you created a league with a disk purchased prior to that date, you probably won't
be able to use migrate because the UIDs aren't there.
Upgrading your Season Disks for the purpose of obtaining valid UIDs is not necessary because DMB now provides
tools to help you do this. When you convert a database to the latest version of DMB, the program checks player
UIDs to make sure they are present in the converted database. If they are not present, DMB tries to assign the
appropriate UID based on an internal historical player database. This usually accounts for most players but not all.
For those players that are not assigned UIDs during conversion (a default UID of -1 is usually assigned), DMB
includes a UID search command that allows you to quickly assign one. For more information, see the help topic
called Players: General Information.

Multi-team players
In DMB, if a player played on more than one team in real-life for a season, he will have ratings for each team he
played on plus one set of combined ratings. Migrate works with the combined version of those players. For
example, if a player on a 2002 roster played on two real-life teams in 2003, migrate puts the combined record for
that player onto the roster and leaves the team-specific records in the free agent pool.

Manager profiles

After successfully running migrate, your league should be ready to draft rookies and free agents for the new
season. After the draft, your managers will need to create new manager profiles (if the computer manager will be
used for some or all of the league games) before beginning the new season.
You can do this using the Generate manager profiles command on the Tools menu or by using the Roster /
manager profile command on the View menu.

Salary Data
Each player record in a DMB database has room for you to enter the player's salary. This information is optional,
but if salary information is present, it might represent:
his real-life salary. (The first season disk to contain salary information was the 1999 Season Disk.)
a salary assigned to this player by your league.
The migration feature can carry the salary information forward from the previous year or leave the salaries alone.
It's your choice.

Procedure
To migrate a database:
1. Select File from the DMB menu bar and select Migrate. The following window will appear:

2. In the first pulldown list, select the source database. The source database is the league database for the season
that you just completed.
3. In the second pulldown list, select the target database. The target database is for the next season to be played.
4. Enter the year that should be assigned to leagues, teams, and scheduled games that are carried forward. For
example, if the season that you just completed used the 2002 season disk and the next season to be played is
2003, you want the year set to 2003.
If you wish, use the checkbox to migrate salary data as well. If the salaries on the source disk were assigned by

your league, you probably want to check this box so those salaries will be carried forward to the target disk. If the
salaries on the source disk represent the real-life salaries for those years, you probably want to leave this box
unchecked so the target disk will contain each player's new real-life salary.
NOTE: Diamond Mind began supplying real-life salary information with the 1999 Season Disk, so most DMB season disks do not
have real-life salaries anyway.

5. Click OK. You will receive notification when the migration is complete.
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Backing Up Your Data
Many, if not most, DMB users invest a lot of time in the game. Depending on your interests, you may create new
leagues using items from different databases, create new players, or simply play a lot of games using one of the
standard Diamond Mind Season Disks.
Anytime you put that much time and effort into something, it pays to make periodic backups in case something
goes wrong with your hard drive, some of your data is accidentally deleted, or you inadvertently perform an action
within DMB that you wish to reverse.
To back up your data:
1. Make sure the active database is the one you wish to back up. If necessary, use the Change active database
command to activate the database to be backed up.
2. Click File on the DMB menu bar and select Backup. The following window will appear:

3. If you don't want to save the file to the default location, use the standard Windows navigation features to locate
the drive, folder, etc. where you want save your backup. In the above image, change the "Save in" location by
using the pulldown menu that currently displays the backup folder.
4. Type a name in the File name field for your backup. Since the backup will always be a "zip" file, the file type field
is disabled.
5. Click Save. To save space, DMB compresses all of the files in your active database and stores them in a single
compressed file. As this is happening, the following window shows a progress report on the backup process:

A message box appears when the backup is complete.
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Restoring Your Data
If you have used DMB's backup feature to save your data, you can easily restore it.
To restore a backup:
1. Make sure the active database is the one in which you wish to restore the backed up file. If necessary, use the
Change active database command to activate the database to be restored.
WARNING! When you restore a database, the previously backed-up files are copied into the active database, replacing
whatever was there. There is no way to reverse this action, so be sure that you have chosen the correct active database before
you use this command.

2. Click File on the DMB menu bar and select Restore. The following window will appear:

If the file is not located in the default location, use the standard Windows navigation features to locate the drive,
folder, etc. where you backed up your data. Note that you will only see files with the "zip" extension.
3. Click on the file you wish to restore and then click Open. DMB extracts each database file from the backup file,
decompresses it, and copies it to the folder where the active database is stored. As this is happening, the following
window shows a progress report:

You will be notified when the restoration process is complete.
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Organizer Overview
The DMB Organizer provides an easy way to view the items in your databases and how they are related. For
example, you can easily see:
which team a player currently belongs to
which park each team is assigned to
when each team played its last game (which is especially helpful when league commissioners are importing
stats from multiple managers in a distributed league)
what's in a database after switching active databases or installing a new season disk
And while many people enjoy Diamond Mind Baseball with the players and teams that ship with the software or that
you may purchase separately, you may also want to create your own leagues, teams, and players. You can also do
this using the DMB Organizer.

The Organizer Window
To access the features of the DMB Organizer, choose the Organizer from the View menu. The following window
appears:

The row of tabs across the bottom allows you to switch easily from one category of items to another. When you
click on a tab, the main body of the window shows a list of all items of that type.

Each list shows the name and several useful attributes of each item, including the ID that uniquely identifies the
item in the database. In most cases, you can ignore the IDs, since they are created and managed by DMB for its
internal use. In a few cases, such as player creation and exporting schedules to an external text file, it's helpful to
know the IDs, so we make them available here.
Across the top is a row of buttons that, when clicked, allow you to create, copy, modify, delete, import, or view one
or more items in the list. If a button is deactivated (grayed out), it means that command is not applicable to items of
the type in the currently active tab.
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so DMB knows which item(s) you want the command to act on. To select a single item, click once with the left
mouse button. To select multiple items (usually appropriate only when you want to delete several things at once),
use the techniques described in the Selecting Multiple Items in a List topic.

You can also invoke commands by right-clicking on the list of items. This causes a popup menu to display with the
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commands that are appropriate for the currently active tab.
WARNING ! If you wish to modify or delete an item using the popup menu technique, you must first left-click to select the item,
then right-click to display the popup menu. If you wish to delete one or more items, keep in mind that the item(s) to be deleted
are the ones that are highlighted. If, for example, you select the second item in the list, then right-click on the fourth item and
choose Delete, it's the second item that is deleted. Right-clicking on an item to display a popup menu DOES NOT select that
item for deletion.

If you double-click on an item, DMB immediately carries out a default command. For most items, the default
command is Modify, so the appropriate modification window appears immediately. Double-clicking on a player
displays his Profile (because player modification is something that most users rarely or never do).
Related topics:
Teams
Parks
Players
Leagues
Organizations
Eras
Schedules
Drafts
Notes

Teams: Overview
A DMB team is a collection of up to 60 players that is assigned to play its home games in a particular park.
When you first install a Diamond Mind Season Disk, the team's roster includes all of the players who played for that
team in real life. You can use a variety of tools in DMB to change those rosters in any way you like -- drafting,
trading, and the Roster / manager profile window are three examples.
This topic discusses how to view and modify basic team information such as its name, nickname, home park and
team statistics, but does not cover making changes to the team's roster. See the links above for those details.
Creating a New Team
Importing Teams

Creating a New Team
To create a new team:
1. Click View on the DMB menu bar and select Organizer. The DMB Organizer screen will appear. By default, you
will be looking at the "Team" tab for the organizer.
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2. At the top of the Organizer you will see a series of buttons, show below. Click on the button labeled New. The
following screen appears:
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Team information consists of:
The City name where the team is located. You can enter the name of a state or region if it is more
appropriate. Or you can enter a name that has nothing to do with geography.
The team's Nickname. This is optional. All DMB windows and reports are designed to show the city if the
nickname is blank.
An Abbreviation of up to three letters for the team. This is used on displays and reports where there is no

room for the city or nickname.
The Year to which the team statistics and roster apply.
The Home park for the team.
The DH rule for this team's games. Normally, the use of the designated hitter (DH) is determined by the
league. But if inter-league play is in effect, or if you are playing post-season games involving teams from
leagues with different DH rules, the game needs to know whether games involving this team use the DH.
A UID, or Universal ID. You can think of the UID as uniquely identifying a team. You need to assign every
team a UID if you want to use DMB's Encyclopedia to maintain multiple years of stats.
If a team has a default UID of -1, click on the Search button to the right of UID input box in order to
assign one from a list of historical teams. If you are using fictional teams in a DMB league, type in the
input box to assign a unique UID.
Selected team Statistics: wins, losses, ties, team shutouts, runners left on base, double plays, runs scored,
and runs allowed.
The same form is used when you choose to Modify a team.

Importing Teams
The Import Team feature allows you to import a team and all of its players from one DMB database into another
plus that team's park and era if you choose. Copies of these items are added to your active database, leaving the
source database as it was. In other words, importing a team does not remove that team from the source database.

To import a team:
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1. Click View on the DMB menu bar.
2. Select Organizer.

3. Click on the tab labeled
Team at the bottom
the window.
UNREGISTERED
VERSION
OF ofCHM
TO PDF CONVERTER STANDARD BY THE
4. Click the button labeled Import at the top of the tab. The following window will appear:

5. Use the pull down list at the top of this window to select the Database containing the team you wish to import.
When you choose a database, the Teams list box displays the teams in that database.
6. Select the team you wish to import.

NOTE: Because the transfer of a team is a complex process that involves moving its players, manager profile, and (optionally)
its park and era, you can only import one team at a time.

7. Optionally, use the checkboxes at the bottom of the window to import the park and era that the team is
associated with in the source database.
NOTE: In a DMB database, the era is not linked directly to a team. It is assigned to a league and all teams contained in that
league. Therefore, for example, if you import the 1975 Boston team and its associated era into a database, you will only import
the 1975 A era if it is assigned to the league in the source database that contains the 1975 Boston team. If you were importing
the 1975 Boston team from one of our All-time Greatest Teams collections, you would import the Neutral era or whatever era
happened to be assigned to this league made up of teams from different years.

8. Click OK. The team (and park and era, if selected) will be copied to the active database.

Parks: Overview
Baseball is rare among professional sports in that the playing field is not standardized. The official rules of baseball
provide for precise measurements within the infield, but only a few guidelines for distances to the outfield fences,
leaving room for a wide variety of shapes, sizes, playing surfaces, building types, and so on. Combine these
physical variations with the effects of altitude and climate in different parts of the country, and you can easily see
how a ballpark can exert VERSION
a large influenceOF
on games
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For this reason, ballparks play a large role in DMB. When players are created, their raw statistics are adjusted for
the statistical impact of their home park. This (along with the era-based adjustments) helps us create park-neutral
ratings for all players. And when you play a DMB game, the nature of the home park plays a significant role in the
outcomes of games played there.
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These park adjustments add realism to your DMB games. If you use the real-life rosters and the real-life schedule,
the park effects that are removed during player creation are cancelled out by those that are added during game
play, so the players will produce statistics in DMB that are very consistent with their real-life stats. If, on the other
hand, you draft new rosters, many of your players will be playing their DMB games in different parks than in real
life, and the change in parks will have an impact on their DMB statistics.
This is the way it should be. In real-life, when a hitter is traded to a hitter-friendly park, you expect their statistics to
rise even if their talent level doesn't change, and you discount their real-life stats for the effects of their new home
park. The same is true in DMB. If you move a player to a new park that is quite different from his real-life park, you
can expect to see his statistics be affected by this move.

Working with Parks
To create or modify a park, choose the View>Organizer command to open the Organizer window, then click on the
Parks tab at the bottom of the window. This displays a list of the parks in your database. From here, you can click
on the buttons across the top of the Organizer window to create, copy or modify a park. Each of these commands
causes the following window to display:

In DMB, the influence of a ballpark is reflected in the following four groups of park attributes and ratings:
General park information, such as its name and location
Physical characteristics, such as the distance and height of the fences
Weather patterns, including temperature, wind direction and wind speed
Statistical park factors that sum up the overall impact of the park on the rates of singles, doubles, triples and
homeruns that are produced in that park by left- and right-handed batters
If you choose to create or modify parks, keep in mind that the statistical park factors are the most important of
these groups of ballpark ratings. If you move a fence back by 20 feet, it won't decrease the number of homeruns hit
in that park unless you also adjust the homerun factor. If you change the surface from grass to artificial turf, it won't
increase the number of extra-base hits unless you also increase the doubles and triples factors.
Why not? Because we haven't yet figured out how to isolate all of the things that affects the statistics produced in a
ballpark. How much will the rates of doubles, triples and homers be affected by a 20-foot change in wall distance?
By raising the fence by 10 feet? By putting in a new type of artificial turf? Adding a new tier of seats that changes
the wind patterns? Or blocking off the center field seats so hitters can see the pitched ball better? We don't know
for sure.

But we can measure the overall impact of each park through careful study of home and road statistics, and we can
capture that overall impact through the statistical park factors. If a park consistently increases doubles by 30%, we
can give the park a rating that will produce a 30% increase in your DMB games. To that extent, we don't need to
know precisely how much each of the factors is contributing to this 30% figure.

The DMB historical ballpark database
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Once upon a time, anyone who wanted to create players in DMB had to start by creating the home parks for those
players. Statistical ballpark information is not easy to find, so this could prove to be one of the more timeconsuming parts of the player creation process.
To simplify the process of creating players, Diamond Mind has compiled a historical database with the park
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separately-priced product that you can purchase and install along with your DMB game. If you have purchased and
installed this database, you can use these historical parks directly in the player creation and modification process,
and you can import any of those parks into your database so you can use them in your own leagues. In short, you
may no longer need to create or modify your own parks.
If, however, you are creating players for a fictional league, a foreign league, or one of the minor leagues, or if you
wish to use a park based on a range of real-life seasons, you won't be able to use the parks in the historical
database. You can, of course, create and modify your own parks using the DMB Organizer.
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Parks: General Information
The "General" tab enables you to create and modify some general information about a park.

You can change the following general characteristics of a park:
The park name
The city in which the park is located. It used to be that everyone knew where a park was located just by its
name, but with the recent trend toward selling naming rights to corporations, it's much harder to keep track.
So you can enter the name of the city, but it is not necessary.
The time zone in which the park is located. DMB does not currently use this information, but we plan to in
future releases of the game.
The year to which the dimensions and statistical park factors apply.
A UID, or Universal ID. You can think of the UID as uniquely identifying a park. You need to assign every

park a UID if you want to use DMB's Encyclopedia to maintain multiple years of stats.
If a park has a default UID of -1, click on the Search button to the right of UID input box in order to
assign one from a list of historical parks. If you are using fictional parks in a DMB league, type in the
input box to assign a unique UID.
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Parks: Physical Characteristics
The "Physical" tab enables you to create and modify the physical characteristics of a park.

You can change the following physical attributes of a park:
The cover -- that is, whether the stadium is Outdoor, a Dome, or Both (if it has a retractable roof)
The surface: Grass or artificial Turf
The amount of foul ground: Small, Normal, or Large
The distance and height of the outfield fence at seven locations: down the left and right field foul lines;
behind the left, center and right fielders; and in the gaps in left and right
NOTE: DMB divides the outfield evenly and determines distances and fence heights at these equidistant points.
Real-life dimensions are not always measured in this manner. For example, some real parks post gap
dimensions at well-known nooks like the triangle in Fenway Park. Those locations are not necessarily at points
evenly distributed around the outfield and may differ from the ones used by DMB.

The name of the image file that is used to depict the park on the DMB game window. See the topic Parks:
Image Files for more information about these image files, including instructions for using your own image
files.
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Parks: Image Files
The DMB image files have been carefully drawn to scale. When DMB displays the names of the runners and
fielders on the game window, the locations of those names are chosen to correspond with the underlying image.
Each image is 600 x 600 pixels, with one pixel representing one foot. Home plate is 80 pixels from the bottom of
the image, meaning that second base is 207 pixels from the bottom (it's 127 feet from home to second) and there's
enough room for a park that is as deep as 520 feet to straightaway center field. And there's room for 80 feet of foul
territory behind home plate.
DMB comes with a number of images files from which you can choose, and we plan to add to this collection over
time. If your park does not have an image in our collection, you can use the generic park image (genericpark.jpg or
genericturf.jpg for a generic park with a turf surface) or use an image of your own. The generic park image is show
below:

To supply your own image, use any tool that can create JPG files and place your image file into the Parks folder
(typically located at C:\Dmb9\parks) along with the other image files. Any files you add to that folder will show up
the next time you use the drop-down list of image files on the Physical page of the park modification window.
The DMB image files are drawings that were created by a professional graphic artist. They are not automatically
generated by the game, so changing the physical park dimensions on the park modification window does not cause
the corresponding image file to look any different. If you want an image file that reflects the dimensions you
entered, you'll need to create that on your own.

Parks: Weather Patterns
The "Weather" tab enables you to create and modify the weather patterns for a ballpark.
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You can change the following weather information:
The average temperature: Cool, Comfortable, Warm, Hot, Very Hot, or Super Hot. The Comfortable setting
is appropriate for most parts of the country. Cities in northern California sometimes warrant the Cool setting.
Cities in the midwest or the south might warrant a Warm or Hot setting, but you should need the warmest
settings only for desert locales where the temperature routinely goes above 110 degrees in July and August.
How much temperature changes during the season: None (for domed stadiums), Low, Moderate, or High.
This helps distinguish between climates like southern California, where temperatures are fairly steady year
round, and climates like the midwest and northeast, where temperatures can range from the 30s in April to
the 90s in mid-summer.
The frequency of rain: Never (for domed stadiums), Rare, Normal, or Frequent.
The average wind velocity: None (for domed stadiums), Light, Moderate, or Strong.
Wind direction: the number of games in which there was no wind (most often for games in a dome, but
sometimes outdoors), or in which the wind was blowing in one of eight directions: out to left, center, or right;
from left to right; in from left, center, or right; or from right to left.

Parks: Statistical Factors
The "Factors" tab enables you to create and modify the statistical park factors.

You can change the park's impact on the number of singles, doubles, triples, and homeruns hit by left- and righthanded batters. These numbers can range from 20 to 500, with an average park having a rating of 100. If the park
allows only 58% as many homeruns as the average ballpark, the homerun rating for that park is 58. And if a park
allowed 40% more triples than average, its triples rating is 140.
Here's an example. If a team's road games included 140 homeruns and its home games included 100 (both for and
against), you can conclude that the home park allows only 100 / 140 = 71% as many homers as the average of the
other parks in the league. So you would assign a homerun factor of 71 for this park.
It is unusual for a singles rating to be outside the range from 85-115, because there are very few ways that a park
can affect the number of singles that are hit. The ranges for modern stadiums are usually 70-130 for doubles, 50200 for triples, and 50-150 for homeruns. Many years ago, there was more variety in stadiums, and larger
differences in park ratings were more common.

Creating a New Park
You can use DMB to create new parks or modify existing ballparks to your specifications. There are four categories
of park information: General information, physical information, local weather, and factors that affect left-handed and
right-handed batter performance.

To create a new park: VERSION OF CHM TO PDF CONVERTER STANDARD BY THE
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1. Click View on the DMB menu bar and select Organizer.
2. When the Organizer Screen appears, select the tab at the bottom labeled Parks. A screen will appear displaying
all of the parks in your database. You can delete, modify, or import park data at this time by selecting the
appropriate button at theVERSION
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3. Click the button labeled New. The following window will appear:

Fill in the information about the park, and clicking the tabs to move among the categories of park information. The
same form appears when you choose to Modify a park.
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Importing Parks
The Import Park feature allows you to import park descriptions from one DMB database into another.
To import parks:

1. Click View on the DMBVERSION
menu bar.
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2. Click on the tab labeled Parks at the bottom of the window.
3. Click the button labeled Import at the top of the tab. The following window will appear:
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4. Use the pull down list at the top of this window to select the database that contains the park you wish to import.
The contents of the window will change to show the parks available in the selected database.
5. Select one or more parks to import and click OK. To select multiple parks, use the techniques described in
Selecting Multiple Items in a List.
Copies of the selected parks are added to the active database.

Overview of Players
In Diamond Mind Baseball, a player record captures all of the information to define the performance of a player,
generate statistical reports, add him to a roster, and so on.
In most cases, the statistics and ratings represent that player's performance in one season, but that is not always
true. If a player was traded or released during a season, he may have statistics for more than one team. In those
cases, you may find more than one record for that player in your database -- one for each of his real-life teams (we
call these team-specific records) and one for his overall performance (we call these combined or composite
records).
DMB provides you with all of the tools you need to create and modify players. With these tools, you can quickly do
simple things like changing a single statistic or rating, or complex things like creating hundreds of real-life or
fictional players from scratch.
The DMB database stores a lot of information about each player, far too much to fit on a single form. So the
process of creating a player involves a series for forms that allow you to specify some options, enter basic player
information, enter statistics, and assign ratings for various baseball skills. Later, if you want to modify a player you
created (or one from a DMB Season Disk), you choose which category of information you wish to modify, and the
form for that category is displayed.

Players: General Information
The general information form allows you to modify basic player information such as names, positions, birthdates,
and player IDs:
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Importing from the Historical Database
DMB includes a file of historical player information that includes everyone who has ever appeared in the big
leagues. It also includes some players who have yet to make the big leagues but who have appeared on a recent
DMB Projection Disk.
This historical information was provided under license by Pete Palmer, who compiled most of the information in the
Total Baseball encyclopedia. We do not, however, own the right to publish the statistics for those players, so our
historical file contains biographical information only. Nevertheless, it's a very useful way to load the names, batting
and throwing hands, birthdays and universal IDs for real-life players.
When you click on the Import from historical database button, the following list of historical players appears:

This list shows each player by name, with his primary role (B for batters, P for pitchers), whether he bats right, left
or switch hits, whether he throws right or left-handed, and what years he played in the big leagues. The last column
is blank if the player has not yet reached the big leagues.
2. Select the player you want to import and click OK. The player's general information is then displayed on the
player form.

Importing from the Active Database
You are much less like to use this feature, but you can also import general player information from the active
database. This may come in handy if you are creating players for a real life season and wish to create multiple
records for a player who appeared on more than one team that season.

General Player Attributes
Each player has a First name, Last name, and Short name. The short name is used on the game window, in the
play-by-play commentary, and in boxscores and scoresheets. It is a very useful way to distinguish players with
similar last names. For example, if your team includes a player named Robert Jones and another named Randy
Jones, you might enter short names of Jones,Ro and Jones,Ra respectively. That way, when you look back at
boxscores, you'll know which Jones was in the game.
The Year represents the season on which the player's statistics and ratings are based.
Each player is assigned a Role of batter, pitcher or dual. This is used to categorize players in various lists and
reports. For example, the batting and pitching register reports use these roles to decide where a player should
appear (with dual-role players appearing in both lists).
In addition to providing useful information about the player's role on his real-life team, a player's Primary position
is used for categorizing players on reports. You can, for example, indicate that you wish to see a free agent list that
includes only players whose primary position was shortstop. This designation doesn't affect performance. Player
performance is determined by the ratings assigned to each player.
The Bats attribute indicates whether the player bats right-handed, left-handed, or switch hits. In DMB, a switch

hitter always bats left-handed against right-handed pitchers and right-handed against left-handed pitchers.
The Throws attribute indicates whether the player throws left- or right-handed.
A player's Birthday is used to display his age on various windows and reports. This can be useful information when
trying to decide whether to draft a player -- all other things being equal, you will often want to choose the younger
player because he may have more good years ahead of him.
NOTE: Birthdates are useful, but they are not required. Some 19th century players in the DMB historical player file do not have

UNREGISTERED
VERSION
CHM
PDF
CONVERTER STANDARD BY THE
birthdates because baseball
researchers OF
have been
unableTO
to track
them down.
Each player has a unique ID. When you place a player on a team roster, DMB uses this ID to record that
relationship. If a database contains more than one record for the same player, this is how DMB knows which of
those records belongs to that team. You can think of this value as uniquely identifying a set of player statistics and
ratings.
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Each player can also have a UID, or Universal ID. You can think of the UID as uniquely identifying a person. If a
database contains more than one record for the same player, the UID makes it clear that they all belong to the
same person. DMB's migration feature uses these UIDs to match player records in different DMB databases.
NOTE: We added UIDs to our player records beginning in 1997. If you purchased a Season Disk before then, your UID values
will not be valid. This causes no problems if you do not use tools (like migration and the DMB Encyclopedia) that require UIDs.
All DMB Season Disks now have UIDs for every player. If you wish to upgrade older Season Disks, contact us for upgrade
eligibility and pricing.

Upgrading your Season Disks solely for the purpose of obtaining valid UIDs is not necessary because DMB now
provides tools to help you assign valid UIDs. When you convert a database to the latest version of DMB, the
program checks player UIDs to make sure they are present in the converted database. If they are not present, DMB
tries to assign the appropriate UID based on an internal historical player database. If you are converting a database
comprised of real big-league players, this process usually results in all but a handful of players having valid UIDs.
For those players that are not assigned UIDs during conversion (a default UID of -1 is usually assigned), DMB
includes a UID search command that allows you to quickly assign one. Click on the Search button to the right of
UID input box. A listing of historical players appears. DMB attempts to match the player based on his name and
allows you to locate the player if the initial search does not turn up an exact match. Once you've located the player
and clicked on him to highlight his record, click Ok to use that UID.
Each player is also assigned a GStatsID, or game statistics identifier. This is for internal DMB use only, so you
should never need to change this value. There is one exception, however. If you copy a player for any reason -- to
create a clone of that player or to use that player as a starting point for creating a different player -- you'll need to
change the GStatsID to a number unique to the entire player pool. If you do not do this, DMB will treat players with
the same GStatsID as one and their simulated stats will be combined on all reports. You can click on the Next
Avail button to ask DMB to assign the next available GStatsID to a player.
NOTE: If a season is in progress, the GStatsID field and the Next Avail button will be disabled because you cannot change a
GStatsID after a player has appeared in a game. If you later restart the season, you can change the GStatsID at that time.

The Image type indicates whether this player record represents the only record for a player who appeared on only
one team that season (Single team), one of the team-specific records for a player who was Traded (or released)
that season, or the overall (Composite) performance of a player who appeared on more than one team that
season. The Delete team-specific records command uses these values to determine which records to remove from
a free agent list as part of your preparation for a draft.
The Current affiliation box shows which team, league and organization this player record currently belongs to.

You cannot change these values, but DMB automatically updates them as you use other tools to move players
around.
Some DMB leagues use financial systems (auctions, salary caps) to help ensure that a few teams cannot stockpile
all of the best players. Different leagues use different financial systems, so DMB does not try to enforce any
particular system. You can enter any values you want for the salary and expiration year, and DMB will display
these values and carry them forward when you migrate your league from one season to another.
NOTE: Diamond Mind began including real-life salaries with the 1999 Season Disk.

Players: Player UID
Each player has a UID, or Universal ID. You can think of the UID as uniquely identifying a person. If a database
contains more than one record for the same player, the UID makes it clear that they all belong to the same person.
DMB's migration feature uses these UIDs to match player records in different DMB databases.

NOTE: We added UIDs to our player records beginning in 1997. If you purchased a Season Disk before then, your UID values
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will not be valid. This causes no problems if you do not use tools (like migration and the DMB Encyclopedia) that require UIDs.
All DMB Season Disks now have UIDs for every player. If you wish to upgrade older Season Disks, contact us for upgrade
pricing.

Purchasing an upgraded version of a Season Disk simply to obtain valid UIDs is usually not necessary because
DMB provides tools to help you do this. When you convert a database to the latest version of DMB, the program
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assign the appropriate UID based on a historical player database that ships with the game. This process usually
accounts for most players, but a few may end up without UIDs because small differences in spelling and statistical
data prevent the conversion logic from finding an exact match in the historical database.
For players who are not assigned a UID during conversion (a default UID of -1 is usually assigned), DMB includes
a UID search command that allows you to quickly assign one. You can access this command directly from the
Players tab of the Organizer window. From that tab, click on a player to select him and then click on the Modify
button (or right-click and select Modify from the popup menu). When the Modify popup window appears, choose
Player UID. You can also use the UID search command when you modify a player's General Information.
When you choose the search command, a listing of historical players appears. DMB attempts to match the player
based on his name and allows you to locate the player if the initial search does not turn up an exact match. Once
you've located the player and clicked on him to highlight his record, click Ok to use that UID.
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Players: Real-life Statistics
When you choose to modify a player, you can change any of the real-life statistics for that player.
It's important to note that changing a player's real-life statistics DOES NOT affect his performance in your DMB
games. These statistics are used only for display and reporting purposes. To change a player's performance, you
must modify his event table and/or his ratings.
You use the following tabbed window to modify the real-life statistics for a player:

There are six categories of real-life statistics stored in the DMB database: overall batting statistics, batting splits
(versus left- and right-handed pitchers), overall pitching statistics, pitching splits (versus left- and right-handed
batters), fielding statistics (by position), and games started at each position versus left- and right-handed batters.
Most of the statistics are self-explanatory (see the Glossary for an explanation of anything you're not sure about),
so we won't include an image of each of these tabs here. Here are a few tips:
DMB does not store real-life hitting streak information, so these items are disabled on the batting stats tab
On the pitching statistics tab, you enter innings in two parts. Whole innings go into the Innings field and

fractional innings go into the Fractions field. For example, if a relief pitcher threw sixty-seven and two thirds
innings, enter 67 Innings and 2 fractions.
Defensive innings are entered the same way on the fielding tab as described in the previous bullet.
The information on the games started tab is used by the manager profile generator to match real-life playing
time. If you don't plan to use that feature, you don't need to enter games started by position for your players.
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Players: DMB Statistics
When you choose to modify a player, you can change any of the statistics that are compiled for that player in the
games you play with DMB.
If a player played for more than one team during your DMB season, DMB stores a separate set of statistics for his
time with each team (there's no record for a team if he never got into a game with that team). And if this player
appeared in the post-season DMB stores a separate set of statistics for each stage of the season. When you
choose to modify a player's DMB statistics, DMB starts by asking you which team and season stage you wish to
work with:

After you have chosen the team and season stage, click OK to display the tabbed window that enables you to
modify these statistics:
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Six of these tabs are also shown on the window where you modify real-life statistics, so we won't go over them
again here. Two other tabs show information that is recorded only for your DMB games:
The Pitch Counts tab allows you to modify the number of times each pitcher threw a ball, called strike, an so
on. (Sorry, DMB doesn't record pitch count information for batters at this time.)
The Games Active tab records the first and last date this player appeared with this team and the number of
team games for which he was on the active roster. In some modes, DMB tries to ensure that each player
gets the right amount of playing time, and this information helps it do that.
Most of the statistics are self-explanatory (see the Glossary for an explanation of anything you're not sure about),
so we won't include an image of each of these tabs here.

Players: Ratings Overview
The Ratings screen allows you to assign ratings to your players. This window appears as the last in the player
creation sequence, and when you choose to modify the ratings for an existing player.

It is ok to leave some of these ratings empty or at their default values, because some ratings apply to a role in
which the player was never used in real life (and may never be used in your DMB games.) There is no need to
assign Pitching ratings to a non-pitcher or to assign defensive ratings at a position the player never played.
If you do use a player in a role he's not rated for, DMB uses reasonable default ratings for those situations. For
example:
real-life managers sometimes ask position players to throw an inning on the mound to save the bullpen in a
blowout, and sometimes these players manage to retire a few hitters. Overall, they don't do very well, and
you'll find that the same is true if you try this in DMB.
you can use a player at a defensive position for which he is not rated, but his performance will suffer. How
much? It depends on the other positions for which is rated. A player moving from a difficult position to a

similar position that is easier to play (e.g. CF to RF, SS to 3B) won't be hurt all that much. A player moving to
a very different position (e.g. C to 2B, 1B to LF) or to a more difficult position (e.g. 2B to SS, LF to CF) will be
a much greater liability to your team. For more details see Playing out of position.
a player who does not have a range rating at a position does not need ratings for errors, throwing or passed
balls at that position. DMB treats anyone without a range rating as an "unrated" player and uses the adjusted
ratings that are described in the previous bullet.

All players should have a full set of ratings in the Offense group, since all players (including pitchers in non-DH
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These ratings are described in detail in the following topics:
Offensive Ratings

UNREGISTERED
VERSION OF CHM TO PDF CONVERTER STANDARD BY THE
Defensive Ratings
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Injury Ratings

Players: Offensive Ratings
All players should have a full set of ratings in the Offense group, since all players (including pitchers in non-DH
leagues) may be called on to bat and run the bases.
WARNING! These ratings are required for batters and pitchers. If you create a player that does not have a full set of these
ratings, it may affect realism and cause problems (possible crashes) with the game.

The offensive ratings are grouped in a box in the upper-left corner of the player ratings form:

Sacrifice bunt rating
The Sacrifice bunt rating indicates the player's ability to advance a runner with a sacrifice or squeeze bunt.
In real-life games, bunt singles are quite rare in sacrifice and squeeze situations (about 10% of the time), but the
runners advance over 80% of the time when the batter gets the ball in play. But a significant percentage of bunt
attempts are fouled off, putting the batter behind in the count and significantly reducing his effectiveness. The
ability to get the ball in play is often the thing that separates the best bunters from the worst.
When we assign bunt ratings for modern seasons, we study pitch-by-pitch and play-by-play data from every real-life
game to determine which bunters have more success getting the ball in play and advancing the runners.
The ratings range from Excellent to Poor. The better the rating, the fewer the number of foul bunts, and the higher
the success rate when he does get the ball in play.

Bunting for a hit
Most of what we just said about sacrifice bunts applies to bunting for a hit, except that this rating applies only when
the batter attempts to bunt with the bases empty or with two out.
In real-life games, bunt singles are fairly common in these situations. The best bunters are successful over 40% of
the time. But because the hitter often tries to get a running start on these bunt attempts, two-thirds of them are
fouled off, putting the batter behind in the count and significantly reducing his effectiveness. As with sacrifice and
squeeze bunts, the ability to get the ball in play is often the thing that separates the best bunters from the worst.
The ratings range from Excellent to Poor. The better the rating, the fewer the number of foul bunts, and the higher
the success rate when he does get the ball in play.

Running rating
The running rating measures the player's ability to take extra bases on singles, doubles, and caught fly balls. It
measures both running speed and the player's judgment about when to take the extra base. Some slow runners
have good ratings because they know when to try for the extra base. Some fast runners have low ratings because
they don't read the ball off the bat very well or because they're too aggressive and get thrown out frequently.
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a runner takes on singles, doubles and fly balls, and the number of times each runner is thrown out on the bases.
If you do not have this information, you can assess a player's running ability based on statistics and other factors -triples, stolen bases, defensive position, batting order position -- that suggest speed or lack of it. This method isn't
foolproof -- our studies always uncover fast players who don't seem to succeed on the bases -- but it's a good
method when you don't have
play-by-playOF
data to
work with.
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The running ratings range from Excellent to Poor. We rarely assign a running rating better than Average for
pitchers and catchers, but there are exceptions from time to time.

Jump and steal ratings
The jump and steal ratings work together to indicate how well this player can steal bases. The jump rating
measures his ability to read the pitcher and get a good jump on a steal attempt. The steal rating measures how
successful he is on those attempts.
When we assign jump and steal ratings, we look at the player's stolen base and caught stealing totals, but we also
examine the play-by-play data to see whether these statistics are telling the whole story. Some players pick up a
few bonus steals as a trailing runner on double steals that were really earned by the lead runner. Others are very
selective, trying to steal only against the weakest catchers and pitchers. So we don't rely on a strict formula when
developing these ratings. However, because most people don't have access to this type of information, we've put
together some guidelines to use when creating your own players.
One way to calculate the jump rating is to divide the number of steal attempts by the number of times the player
reached first base (singles + walks + hit by pitch), using the following table:
Rating

Rate

Ex

at least 25%

Vg

at least 15%

Av

at least 9%

Fr

at least 3.5%

Pr

less than 3.5%

Excellent stealing ratings are reserved for players who succeed at least 83% of the time. Average stealers are
successful about 67% of the time. Poor stealers are thrown out more than half the time.

Hitter type
This rating indicates whether the batter is a pull hitter or spray hitter. A right-handed batter is considered a pull

THE

hitter if he hit theball to the left fielder, third baseman or shortstop at least 50% of the time in real life. The same
rule is appliedto left-handed batters, but the right fielder, first baseman and second baseman are used instead.

Clutch rating
This rating indicates whether the batter is especially tough in late-inning situations where the score is close. A great
clutch hitter is rated as a Terror, while others are Normal.
Baseball researchers have tried on a number of occasions to find players who consistently perform better in the
clutch, but they have had no success. No matter how you define a clutch situation, hitters tend to hit just as well (or
badly) in those situations as they do overall, given a statistically meaningful number of plate appearances.
As a result, the clutch rating system is only a minor factor in your DMB games, and we don't give out a lot of Terror
ratings. When we do, we assign them to players who hit very well (and better than their normal level) in the late
innings of close games in that particular season.

Power rating
This rating doesn't appear on the ratings form, but we'll mention it because it's on the player profile and in other
places in the game. It indicates how well a player hits for power (doubles, triples and homers) against left- and
right-handed pitching, and it is automatically calculated by DMB whenever you create a player or modify a player's
event table.
This rating, which has values ranging from Excellent to Poor, does not determine the outcome of any plays. Its
purpose is to give you a quick indicator of how much power is represented in the player's event table, and is
therefore a useful companion to the player's batting average.
Statistically, the rating represents a batter's rate of extra-base hits after adjusting for park.

Players: Defensive Ratings
Players should be assigned defensive ratings only for the positions they normally play. All positions have a range
rating that reflects the player's ability to reach batted balls and turn them into outs and an error rating that reflects
his tendency to make errors. Throwing ratings are assigned to catchers and outfielders. Catchers also have passed
ball ratings.
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The defensive ratings are grouped in a box in the upper-right corner of the player ratings form:
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Range rating
This rating indicates a player's ability to reach balls hit in his direction and turn those batted balls into outs. Most
baseball announcers use the "range" to mean the ability to cover ground, and that's certainly an important part of
what goes into our range ratings. But it's not the whole story.
Our range rating (which takes values from Excellent to Poor) measures each fielder's overall playmaking ability
(minus his tendency to commit errors, as we have a separate rating for that). Playmaking ability is not just about
range, it's also about positioning, handling the ball cleanly, throwing quickly and accurately, and making good
decisions about where and when to throw the ball.
For modern seasons, we carry out very extensive studies of play-by-play data when assigning our range ratings.
We look at each player's individual performance on the balls hit his way, overall team defense, the effects of
neighboring fielders (3B often take balls that the SS could have handled anyway, so we don't punish the SS for
failing to make those plays), and ballpark effects.
Unfortunately, good fielding data can be hard to get for past seasons. The best sources we've found are the team
section of the Macmillan Baseball Encyclopedia and the STATS All-time Major League Handbook.
By comparing putouts (for outfielders) and assists(for infielders), and adjusting for playing time, you can get an idea
how a player compares with his peers. These types of measures (commonly known as range factors) can
sometimes be very misleading, however, as they don't take into account the groundball/flyball nature or left/right
mix of the pitching staff. The more of these factors you can take into account when assigning range ratings, the

more accurate your ratings will be.

Error rates
This rating is a percentage indicating how this player's error rate compares to the average fielder at his position in
the era in which he played. A rating of 100 means the player is average -- that is, he makes 100% of the errors
expected of someone at that position. A player who makes only 50% as many errors as his peers is rated 50.
Someone who makes twice as many errors as his peers is rated 200.
The following table summarizes how error rates have changed over time, in five-year intervals. Each entry in the
table is the number of errors made per 100 full games (or 900 defensive innings).
Year

P

C

1B

2B

3B

SS

OF

1895

24

27

26

44

46

67

19

1900

22

24

23

38

38

59

14

1905

18

22

20

31

28

50

10

1910

16

19

18

28

25

45

9

1915

16

17

15

25

22

40

9

1920

14

14

13

23

20

35

8

1925

12

12

11

21

17

32

8

1930

10

10

10

19

16

30

7

1935

10

10

10

18

16

27

7

1940

10

10

10

17

15

25

6

1945

10

9

9

16

15

23

6

1950

10

9

9

15

15

22

5

1955

10

9

9

14

15

20

5

1960

10

9

9

13

15

19

5

1965

10

9

9

13

15

19

5

1970

10

9

8

12

15

18

5

1975

10

9

8

12

15

17

5

1980

9

9

8

11

15

16

5

1985

9

9

8

10

15

16

4

1990

9

8

8

9

15

15

4

1995

9

8

8

9

15

15

4

2000

8

7

7

9

14

14

4

2005

8

6

6

9

12

12

4

This table shows the errors per 100 games (900 defensive innings) over time by position.
For example, to assign an error rating to a shortstop from 1912, determine how many errors that player made per
100 games. Suppose the player made 39 errors and was the shortstop about 80% of the time. Based on a 154game schedule, that's about 123 full games. In 100 games, he would have made 39 x 100 / 123 = 32 errors.
Looking at the rows for 1910 and 1915 in the table, we can estimate that the average shortstop in 1912 made 43
errors per 100 games. Our shortstop's rate is 32, which is 74% of 43, so his rating is 74.

Outfielder throwing
The strength and accuracy of an outfielder's throwing arm are indicated in this rating, which is used whenever a
runner tries to take an extra base on a single, double or fly ball. These ratings take values from Excellent to Poor.
When we assign throwing ratings for modern outfielders, we use detailed information about the number of extra
bases opposing runners took on singles, doubles and fly balls hit to that outfielder. We also look at the number of
runners thrown out, but outfielder assists can be misleading. Some outfielders pick up meaningless assists on
plays where one or two runners
score on aOF
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If you are assigning throwing ratings for past seasons, we suggest you compare assist totals across the league.
Generally speaking, the higher the assist total, the better the throwing arm. This is not always true, of course,
because some outfielders have such a great reputation for throwing that nobody tries to run on them (meaning their
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Catcher throwing
This rating indicates the strength and accuracy of the catcher's throwing arm and is used whenever a runner tries
to steal second or third. It has values from Excellent to Poor.
When we assign catcher throwing ratings for modern seasons, we use detailed studies of play-by-play data to see
how often opposing runners challenged each catchers arm and what percentage of those runners were thrown out.
Our studies take into account any SB that were credited to trailing runners on double steals and how often a runner
was caught stealing as a result of a pickoff throw by a pitcher. Most importantly, we look at the performance of
each pitcher-catcher pair, an approach that helps us determine whether it's the pitcher or catcher who deserves the
credit or blame for the results.
When assigning throwing ratings for past seasons, you can start by comparing assist totals across the league.
Keep in mind, however, that the best throwing catchers often have lower assist totals because opposing runners
don't run on them in the first place. As is the case with all DMB ratings, you will need to use some judgment.

Passed ball rating
This number indicates how many times a catcher will allow a passed ball in 1,000 plate appearances with runners
on base. The formula is similar to that for wild pitch ratings for pitchers:
rating = (passed balls * 1000) / (batters caught * .43)
Official statistics don't include batters caught, so you'll need to estimate it. For example, if a team's pitchers faced
6300 batters and this catcher was behind the plate 72% of time, he caught about 6300 * .72 = 4536 batters.
The .43 factor indicates that about 43% of all plate appearances occur with runners on base. This number rises
and falls with the level of offense in the league.

Playing out of position
You can use a player at a defensive position for which he is not rated, but his performance will suffer. How much?
It depends.
Players can make a relatively painless transition to an easier position that is similar to one they're already rated for.
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The penalties are much greater for moving to a very different position that is also more difficult to play.
For example, a CF can play LF or RF without suffering. Both positions are similar and easier than the one he's
rated for. A LF or RF moving to CF has a more difficult time because there's more ground to cover. Similarly, a
move from SS to 2B won't cost you too much, while a move from 2B to SS will hurt more. And the moves that will
hurt the most are (a) from any position to catcher, (b) a catcher moving to any position except 1B, and (c) a 1B
moving to CF or another infield position.
How will these penalties show up? In lots of ways. More balls in their zones will go for hits. They'll make more
errors. Guys without outfielder throwing or catcher throwing ratings will be easier to run on. Unrated catchers will
have more passed balls. Unrated middle infielders won't start as many double plays on balls hit to them, and they
won't turn two as often when they're the pivot man on the play.
You might ask why we don't improve ratings when a player is moving to a less difficult position. Couldn't a top-rated
SS play 2B even better than the average 2B? In the many years that we've been assigning fielding ratings, we've
seen a lot of players get better ratings when they make the transition from a harder position to an easier one
(especially SS -> 2B, 3B -> 1B, and CF -> LF), but we've also seen plenty of cases where the player needed some
time to learn how to play the new position.
Every position requires of a different set of skills. A CF moving to RF needs to learn how to play the caroms on
balls hit down in the corner. A 3B needs great reflexes to handle the hot smashes that come his way, and that
might not be the strong suit of a middle infielder moving to 3B. A SS moving to 2B must learn how to make the
pivot with his back to the runner.
If our out-of-position adjustments assumed that every player could instantly adapt to a new position, even an easier
one, we think it would create too many opportunities for managers to abuse the game by moving players around in
ways that real-life managers would never get away with. So the game imposes penalties of varying degrees on all
but a very few out-of-position players. The exceptions are (a) center fielders moving to a corner outfield spot, who
do not suffer a range penalty or a change in their error rate, and (b) shortstops moving to other infield positions,
who don't suffer a range penalty but are given an error-rate penalty.

Players: Pitching Ratings
All pitchers should have a full set of ratings in the Pitching group, but you can leave these ratings alone for nonpitchers. If you use a non-pitcher as a pitcher, DMB assigns a set of default ratings to cover those situations.
The pitching ratings are grouped in a box in the lower-left corner of the player ratings form:
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Durability as a starting pitcher or reliever
These ratings (which take values from Excellent to Poor) are used to determine how quickly a pitcher gets tired.
A player who was not used as a starter in real life does not have a rating. If he is used as a starter in DMB, he tires
more quickly than a player with a Poor rating.
A player who was not used as a reliever in real life does not have a relief rating. If he is used in relief, he will have
above-average durability in that role, since his arm is accustomed to long outings.
There are three ways to determine how durable a pitcher was. The best way, which can only be used for recent
seasons, is to look at the average number of pitches thrown per appearance. These days, only the most durable
and effective starting pitchers throw an average of 110 pitches or more. Most are in the 90s.
The second way is to compute the average number of batters faced per start. As you can see from the following
table, which shows the average number of batters faced per appearance, pitchers are being used very differently
today than they were 100 years ago. Back then, relief pitchers were used only in emergencies. Today, a complete
game from a starting pitcher is unusual.

Year

Starters

Relievers

Year

Starters

Relievers

1895

35

17

1950

29

8

1900

34

18

1955

29

7

1905

34

13

1960

28

7

1910

33

12

1965

28

7

1915

33

10

1970

27

6

1920

32

10

1975

27

6

1925

32

9

1980

26

6

1930

31

9

1985

26

6

1935

31

9

1990

26

5

1940

30

8

1995

26

5

1945

30

8

2000

26

5

The third way is to look at a pitcher's complete game percentage compared to the norms for his era.
We consider all three of these pieces of information (when we have them all) when assigning durability ratings to
starting pitchers. But keep in mind that there are some other factors that you may also want to consider:
bad pitchers don't last long, but it's not necessarily because they tire out. For a pitcher like this, you may want
to assign a better durability rating than would normally be assigned based on batters faced per game. On
those rare occasions when he's pitching well, this pitcher might indeed be able to go deep into the late
innings or even throw a complete game.
it follows from the previous point that starter durability rating is most important for good pitchers. It doesn't
matter much if a bad pitcher is allowed to stay in your games too long, but if a pitcher was very effective but
didn't consistently pitch into the late innings, his starter durability rating is the only thing that will stop him from
completing too many games.
a pitcher on a bad team may also be more durable than his batters faced numbers indicate if he's frequently
removed from games for a pinch hitter
today's pitchers throw an average of 3.8 pitches per batter. Historical data of this type is not available, but we
estimate that pitches per batter have risen over the past 100 years from the a low of 3.0-3-2 to today's much
higher levels.
the values in the above table are averages, not maximums. In any given game, a pitcher can usually face 5-6
more batters than these tables indicate without getting tired. The values in the table reflect an average of the
pitcher's short outings (the ones where he got pounded and he left the game before he could get tired) and
his longer ones.
In DMB, as in real life, there is no magic indicator to tell you when a pitcher is tired. You must make a judgment call
based on his performance in the current game and from his durability rating.
The following tables may help you decide when to remove a pitcher. Keep in mind that these tables are based on
how pitchers are used today, so you'll need to make adjustments if you're playing older seasons. And remember
that fatigue sets in gradually, so you may occasionally get away with pushing a pitcher beyond the normal limits.

For starting pitchers (pitch counts):

Rating

One game

Five days

Ex

125-135

210-230

Vg

115-125

195-215

Av

105-115

180-200
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Fr
95-105
Pr

85-95

150-170

For relief pitchers (pitch counts):
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Rating

One game

Five days

Ex

60-70

100-115

Vg

45-55

80-95

Av

30-40

50-65

Fr

25-35

40-55

Pr

20-30

35-50

Holding runners
This rating indicates a pitcher's ability to hold runners close on steal attempts. An Excellent rating indicates a
pitcher against whom opposing runners attempt to steal with the next base open less than 5% of the time. Poor
pitchers allow attempts almost 30% of the time.
When we assign hold ratings for modern seasons, we use detailed studies of play-by-play data to see how often
opposing runners challenged each pitcher and what percentage of those runners were thrown out. Our studies take
pickoffs into account, along with any steals that were credited to trailing runners on double steals. Most importantly,
we look at the performance of each pitcher-catcher pair, an approach that helps us determine whether it's the
pitcher or catcher who deserves the credit or blame for the results.
Unfortunately, there is very little information available for past seasons. It's only in recent years that stolen bases
against pitchers and catchers were routinely published.

Getting out of a jam
This rating indicates whether the pitcher is especially tough in late-inning situations with the score very close.
Pitchers are rated as Super, Tough or Normal.
Baseball researchers have tried on a number of occasions to find batters who consistently perform better in the
clutch, but they have had no success. We're not aware of any such studies for pitchers, but the small amount of
research we've done on this question has also failed to turn up any evidence to suggest that pitchers can bear
down when they need to.
As a result, the clutch rating system is only a minor factor in your DMB games. We don't give out a lot of Tough
ratings and it's possible that we may have never given out a Super rating.

Wild pitch rating
This number indicates how often a pitcher throws a wild pitch when there are runners on base. The wild pitch rating
tends to range from 0 to 60 with an average of 15. Use the formula:
rating = (wild pitches * 1000) / (batters faced * .43)
For example, if a pitcher threw four wild pitches in a season in which he faced 1000 batters, his rating is 9. Why
.43? Because about 43% percentage of batters faced occur with runners on base, though this number rises and
falls over time and will vary for individual pitchers.

Balk rating
This number indicates how frequently a pitcher commits a balk. It is expressed as a percentage, with 100 indicating
a pitcher who's at the average rate for his league. For example, if a pitcher faced 952 batters and balked once in a
league where balks occurred at a rate of 8 per 10,000 batters faced, his balk rating would be:
player: 1 / 952 = .0011
league: 8 / 10000 = .0008
rating: 100 * .0011 / .0008 = 138

Ground ball percentage
This rating is NOT used to determine the result of any play, so you do not need to fill it in for new players. If you do
fill it in, use a value of 50.
GB pct is similar to a batter's power rating in that it is not directly used by the game but acts as a window into the
event table for modern season disks.
For modern season disks, DMB uses ground ball percentage when creating pitching event tables internally. In
these cases, the number accurately reflects the pitcher's ability to cause ground balls. Together with the number of
ground ball double plays made while this pitcher was in the game, you can use this rating to assess your chances
of getting out of a tough situation with a ground ball double play.

Players: Injury Ratings
All players should have a full set of ratings in the Injury group, since all players are subject to injury.
The injury ratings are grouped in a box in the lower-right corner of the player ratings form:
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Injury rating
Players who played almost every game have an Iron rating, those who missed many games (more than 10% of the
season) are Prone, and others are Normal.
The injury system in DMB is quite mild compared with real life. In real-life, it's not unusual for players to miss
several months or an entire season as a result of a single injury. In DMB, however, even a Prone player won't miss
much more than a few weeks at a time, and isn't guaranteed to get hurt at all.
The length of injury depends on the Injury rule you are using. If the rule is set to Random, injury duration is
determined randomly. If it is set to Injury Rating, a single injury will not exceed the number of real-life games
missed (for any reason) by the player during the season. For details about the Injury rule, see Leagues: Rules and
Options.

Percent active
The percentage of the season during which this player was on the active roster and available to play.
If, for example, the team's season was 154 games long, and a player was on a farm team (or another big-league
team) for 60 games, and on the disabled list (with this team) for another 20 games, his percent active would be
(154-60-20) / 154 = 48.
This number helps the computer manager match real-life playing time in detailed replays using real-life rosters
when the automatic transaction processing option is turned on. If you are not using automatic transaction
processing, you can leave this number at 100.

Percent disabled
The percentage of the team's games that the player missed while on the disabled list.
If, for example, the team's season was 154 games long, and a player was on the disabled list (with this team) for 20
games, his percent disabled would be 20 / 154 = 13.
This number helps the computer manager match real-life playing time in detailed replays using real-life rosters
when the automatic transaction processing option is turned on. If you are not using automatic transaction

processing, you can leave this number at 0.
NOTE: This number does NOT affect a player's tendency to get hurt or the severity of any injuries he suffers. Those things are
controlled solely by his injury rating.

Players: Injury and Usage Info
When you choose to modify a player, you can change any stored information about any current injuries and any
recent usage as a pitcher or catcher. Even if he played for more than one team during your DMB season, DMB
stores only one set of injury and usage information. This ensures that any injuries and fatigue information goes with
him if he is traded to a new team during the season.
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The injury and usage information is modified using the following form:
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Usage as a pitcher
The Pitching box shows how much this pitcher has pitched on the four days leading up to the Last pitched date in
the Dates box. Slot number one represents the Last pitched date, slot two the day before that, slot three another
day before that, and so on.
For each day, choose a Role that describes how the pitcher was used that day -- as a Starter, as a Reliever, Both
(if he pitched in both games in a double-header and started one of them), or None. For each day on which he
pitched, enter the total number of pitches he threw that day.

Usage as a catcher

The Catching box shows the number of batters faced as a catcher on each of the nine days leading up to and
including the Last caught date in the Dates box. Slot number one represents the Last pitched date, slot two the
day before that, slot three another day before that, and so on.

Injury information
If the player is currently suffering from an injury, that injury is represented by three pieces of information -- the
Cause of the injury, the date he was Injured, and the date he is eligible to Return. To eliminate a current injury,
change the Cause to None.

Creating a New Player
The process of creating a player involves a series of forms that allow you to specify some options, enter basic
player information, enter statistics, and assign ratings for various baseball skills.
To create a new player, click View on the DMB menu bar and select Organizer. When the Organizer window
appears, select the tab labeled
Players. On
theCHM
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labeled New. ThisSTANDARD
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UNREGISTERED
VERSION
OF
TOclick
PDF
CONVERTER
window.

THE

Player creation options

This form allows you to specify
the optionsOF
that are
in effect
creating
players. The valuesSTANDARD
you enter here are BY THE
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remembered and redisplayed for the next player you create, saving some time and effort if you are creating a
number of players from the same team and using the same source of statistics.

1. In the boxes at the top of this screen, select the Era and Park to use for evaluating this player's statistics. All
DMB players are created on an era- and park-neutral basis so they can be moved into new eras and ballparks and
have their performance automatically adjust to their new surroundings.
Why is this necessary? Suppose a player hit 25 homers in 500 atbats. By itself, this means almost nothing. If he
did this in a huge park during the dead-ball era, it's a tremendous accomplishment. But if he did it in Colorado in
1999, it means he has below-average power. So DMB subtracts the effect of his home park and compares his
park-adjusted stats to the norms for his era. The result is a set of park-neutral ratings that indicate how this player
performed relative to the norms for his era.
For both eras and parks, you can choose to use one from the active database or select from DMB's historical era

and park databases.
2. Select the team to which you want to assign the player, leaving the value as <none> if you want the player to be
added to the free agent pool.
3. Select the creation method you wish to use. DMB has two sets of formulas that it can use for creating players.
The Left/right option is appropriate when you have the player's actual left/right splits and wish to use them to rate
the player. The Overall option is best when you don't have left/right splits or if you prefer to have DMB generate a
standard left/right differential for this player.
If you choose the Overall method, DMB uses historical norms to rate batters to perform better against oppositehanded pitchers. The difference is about 20 batting average points and 30-40 points in slugging average. In other
words, a lefty hitter who batted .280 overall would be rated to hit about .287 against righties and .267 against
lefties. If that player faces righties about 2/3 of the time, his overall average in his DMB games would be around
.280. Similar adjustments are made for right-handed batters and for pitchers.
This means that the strategy of trying to get favorable left/right matchups in your DMB games is still very important,
even if you're using players who were created using the Overall method.
4. In the lower left are a set of checkboxes that allow you to tell DMB to estimate various statistics for the player
you are creating. You can use this feature if you do not have access to accurate statistical data for certain items.
If, for example, you are creating a batter and do not have any information about the number of times he was hit by
a pitch, check the HBP box. If the HBP box was checked, DMB knows that you don't have this piece of information,
and when the form for entering batting stats is displayed, the HBP box is grayed out so you cannot enter a value.
When DMB converts those batting statistics into the event tables that determine batting performance, it estimates
the number of HBP and uses that value.
If you know how many times the batter was hit by a pitch, leave the HBP box unchecked. DMB assumes that you
will enter a HBP value when it comes time to do so. If you enter zero, DMB assumes the player was never hit by a
pitch and rates the player accordingly. In other words, if you don't ask DMB to estimate a statistic for you, zero
means zero.
NOTE: These estimates apply only when you have chosen the Overall method. If you are using the
Left/right method, all of the statistics are required. If you leave something as zero, it will be treated as zero.
No estimates will be made by DMB, so if you don't know the real values, enter your own estimates. In other
words, if you know that a player had 12 sacrifice bunts overall but you don't know how they were broken
down on a left/right basis, make a reasonable estimate. If the player got about a third of his atbats against
left-handed pitching, and you think his sacrifice bunt rate would have been about the same versus both LHP
and RHP, enter 4 versus LHP and 8 versus RHP. Even if this is not exact, you won't be far off, and the
player will perform accurately in your DMB games.
5. Check the box labeled Enter fielding stats if you have fielding statistics for this player and you wish to enter
them during the player creation process. This is optional. You can always go back and enter fielding stats later.
And because fielding performance in DMB is determined by the defensive ratings you assign, not the fielding stats,
you don't need to enter fielding statistics if you don't want to.
6. Click OK to advance to the player creation window.

Player creation window
After you have completed the options form, DMB displays another window that contains a series of forms that you

can use to enter basic player information, statistics and ratings. At the bottom of this window, you'll see buttons that
allow you to move to the Next form or Back to the previous form. When you are on the last form, the text of the
Next button changes to Finish. Click the Finish button to have DMB take the information you have entered, create
the player, and add him to the database.
The series of forms that display in this window depend on the options you selected (left/right versus overall,
whether the fielding stats form should be included) and the role (batter, pitcher, dual) of the player. In every case,
however, the first form is for entering basic player information.
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and birth date, among
other things. BY THE
See Players: General Information for a full description of how to complete this form. Click Next to advance to the
next form and begin entering player statistics.
One or more statistics forms follow the basic information form. Each of these forms includes statistics that must be
entered for the DMB player creation formulas to work properly and other statistics that are included only for display
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and reporting purposes. The required statistics are marked with an asterisk (*). See Players: Real-life Statistics for
additional information on these forms.
NOTE: When you create a pitcher, the first statistical form that appears is for hitting stats.

The last form is always the player ratings form. Because the process of rating players cannot be done strictly by
formula and usually requires that you apply some judgment to whatever information you have on the player, DMB
does not attempt to create these ratings for you. You can enter whatever ratings you feel are appropriate given
everything you know about the player. See Players: Ratings Overview and the related topics for a full description of
these ratings.

THE

Modifying a Player
To modify a player, first click on File at the top of the Diamond Mind screen and then select Organizer. Click on
the Players tab at the bottom of the window and a list of all players in your database appears. Now you can either:
left-click on a player and then click on the Modify button, or
right-click on a player and select Modify player from the popup menu
Either way, DMB presents a popup menu with categories of player information that you can modify:

The first five of these commands display forms that are described in the following topics:
Players: General Information
Players: Player UID
Players: Real-life Statistics
Players: DMB Statistics
Players: Ratings Overview
Players: Injuries and Usage
NOTE: Changing a player's real-life statistics DOES NOT affect his performance in your DMB games. These statistics are used
only for display and reporting purposes. To change a player's performance, you must modify his event table and/or his ratings.

Modifying Event Tables
The last two commands on this menu allow you to change his event table. What is an event table? It's a hidden set
of batting and pitching ratings that determines how often each of the major types of events (singles, doubles,
triples, homers, hit batsmen, walks, strikeouts, fly outs, ground outs, and ground ball double plays) occur when this
player is involved in the batter-pitcher confrontation.
Why do we use event tables to govern the batting and pitching performance of DMB players? Two reasons. First, it
allows us to make appropriate adjustments for changes in playing conditions over time and for home parks.
Second, it's useful to have something other than the player's actual statistics to use as the basis for generating play
results.

On the first point, the Creating a New Player topic describes how DMB rates players on an era- and park-neutral
basis so players can be moved into new eras and parks and automatically have their performance adjust to their
new surroundings. These era- and park-neutral ratings are stored in event tables.
On the second point, there are times when we want to rate players based on numbers other than their actual
statistics. To take an extreme example, suppose a player batted .450 in 30 plate appearances, and you want to use
this player as an everyday player for an entire season. You think that he'd really bat about .280 if he was used that
much. But you want to keep his real-life stats as they are for display and reporting purposes.
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The solution is to create (or modify) this player using a set of statistics that represent the level of performance you
think he would really achieve over a full season, then use the ability to modify his real-life statistics to enter his
actual real-life numbers. The first step creates an event table that makes him a .280 hitter and the second step
restores his real-life stats without affecting his performance in your DMB games.
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form so you can choose the Era, Park, and creation method. After you have made these selections and clicked on
OK, DMB displays a form for entering the statistics needed for recomputing his event table using those options.
The event table is not changed until you click on OK, so you can Cancel out of this operation if you change your
mind.
IMPORTANT! When the player creation options form appears, it will not necessarily display the same era and park that was last
used to create or modify this player's event table. Be sure to choose the correct era and park before modifying an event table.

Importing Players
If you have one or more players in another DMB database that you would like to use in the currently active
database, you can import those players.
To import players:
1. Click View on the DMB menu bar and select Organizer.
2. On the Organizer screen, select the tab at the bottom labeled Players.
3. When the Players tab appears, click the button at the top of the tab labeled Import. The following screen
appears:

4. Use the pull down at the top of the screen to select the source DMB database. The area below the pull down will
list the players that are available in that database.
5. Select the players you wish to import and click OK. To select multiple players, use the techniques described in
Selecting Multiple Items in a List.
Copies of the selected players are added to the active database.

Player Profiles
The player profile window, shown below, pulls together most of the statistics and ratings for a player into one place.
From just about anywhere in the game, you can double-click on the name of a player to display his profile. And the
profile window includes a list of related players so you can quickly cycle through and compare the players on a
team, in a lineup, on a free agent list, or in some other group.
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The title bar of the profile window shows the player's year, full name, primary position, age, batting hand and type,
and throwing hand.
The list box in the upper-left corner lets you cycle through the players in this group (left arrow for previous, right
arrow for next, drop down list to select a specific player).
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The Show combined stats check box is activated whenever a player appeared on more than one team in your DMB
season. When checked, the profile shows his overall stats; when unchecked, it shows his stats for his current
team.
The season stage pulldown allows you to browse through a players stats for the pre-season, regular season, and
each round of the post season.
The main portion of this window is a series of five tabs that show batting, pitching, fielding, status and games
started information for the player. We'll describe each of these in turn.

Batting tab
The batting tab includes two sets of batting statistics (primary and secondary) for real-life, the DMB season or
series to date, and (if you're requesting this profile during a game) the current game. In addition, the batter's
performance against left- and right-handed pitching is also shown. At the bottom is a complete summary of the
batter's offensive and defensive ratings.

Pitching tab
The pitching tab includes five sets of pitching statistics (primary, secondary, as a starter, as a reliever, and
opposing batter statistics) for real-life, the DMB season or series to date, and (if you're requesting this profile during
a game) the current game. In addition, the pitcher's performance against left- and right-handed batters is shown. At
the bottom is a complete summary of the pitchers's pitching ratings.
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Fielding tab
The fielding tab includes fielding statistics for real-life, the DMB season or series to date, and (if you're requesting
this profile during a game) the current game. At the bottom is a complete summary of the batter's offensive and
defensive ratings.

Status tab
The status tab includes usage information (number of pitches thrown or batters faced as a catcher in recent days),
an injury report, and the player's injury and contract information. At the bottom is a complete summary of the
player's offensive and defensive ratings.
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Starts tab
The starts tab shows games started by position against left- and right-handed pitchers for both real life and your
DMB season. At the bottom is a complete summary of the player's offensive and defensive ratings.

Overview of Leagues
Click here to go directly to creating a new league.
Click here to go directly to the tutorial for setting up a league from scratch.

A League helps you organize
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regular season and (optionally) into the post-season.
You do not need to set up a league to play games with DMB. At any time, you can play exhibition games between
any two teams that are stored in any database that you have installed. But when you play games within a league
structure, you have access to several added features:
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League rules can be entered once and automatically applied to all games
Statistics are compiled for teams and players
Playing time is monitored to ensure that pitchers and catchers are not used more often than is realistic
If you elect to use the injury system, DMB tracks how long injured players are ineligible and reinstates them
when they are able to play again
For faster results, you can autoplay one or more games from the league schedule
When you purchase a DMB Season Disk, the leagues are already set up as they were in real-life, so you do not
need to add or modify a league to begin playing games. But part of the fun of playing DMB is the ability to modify
these leagues or create entirely new ones using teams, eras, parks, and players that you create yourself or import
from other DMB Season Disks. If you're interested in setting up a league from scratch, we've created a tutorial to
walk you through the process.
League play is always conducted within a single DMB database, and a DMB team can be involved in only one
league at a time within the same database. (A team can be involved in more than one league if you create separate
databases for each league.) To prepare for creating or modifying a new league, you may wish to do the following:
If you want to use teams, eras, parks, and players from another database, use the Organizer to import the
items you wish to use in your league.
Remove some existing teams from their current league in order to make them available to be added to the
league you are about to create or modify.

Leagues: General Information
The "General" tab enables you to create and/or modify some general information about leagues.

You can change or enter the following general characteristics of a league:
The name of the league (up to 30 characters)
The year of the league. The year has no effect on league play, so you can enter any value you like.
The era to which the league is assigned. Unlike the year, the era you assign to a league has a significant
impact on league play, as it determines the playing conditions (including the level and type of offense, error
rates, and pitcher durability) for your league.
The schedule that will be used for league play.
NOTE : If this league is part of an organization that involves inter-league play, you must choose the schedule at
the organization level, and you cannot change it here. If this league is not involved in inter-league play, you can
select from any of the schedules in your database. After your season has started, you cannot switch to another

schedule unless you first use the "Restart a season" command on the Tools menu.

A UID , or Universal ID. You can think of the UID as uniquely identifying a league. You need to assign each
league a UID if you want to use DMB's Encyclopedia to maintain multiple years of stats. If a league has a
default UID of -1, type in the input box to assign a unique UID.
This page of the League window also displays some status information that you cannot change:

UNREGISTERED VERSION OF CHM TO PDF CONVERTER STANDARD BY THE
If you have created an organization, assigned this league to that organization, and set up the organization for
inter-league play, the name of the organization is shown in Inter-league play.
The season stage is shown in the status box. This indicates whether your league is still in the off-season or is
now playing games from some other stage of your season (pre-season, regular season, or post-season).
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The date of the last game played in this league is also displayed in the status box.

The Teams Tab
The Teams tab on the league creation screen allows to create divisions in your league by giving them names (like
"Senior," "Junior," etc.) and assigning available teams to these divisions.
Teams that are not currently assigned to a league in your database appear in the column on the right hand side of
this window. You may create up to four divisions in a single league, and each division may have up to 16 teams.
To name a division, click on any empty column header field and type the division name, as shown below:

To assign a team to a division, left-click on a team in the Available teams list to highlight and then right-click. DMB
displays a pop-up menu listing the divisions.

Click the division and the team will be assigned to that division. This same approach is used to move teams from
one division to another.

Leagues and Organizations: Rules and Options
As its name implies, the Rules and Options tab on the league creation screen allows you to set various rules and
options that will apply to your league games.
NOTE : If a league has been assigned to an organization, the rules and options of the organization are used to govern play for
both leagues in that organization. In this case, those rules and options are shown on this page but can be modified only through
the Modify Organization window.
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The following bullets describe the rules and options on this page:
The number of games in the season. If you are planning to run a draft later, setting the season length helps
the computer make picks by indicating how much playing time will be needed from players at each position to
complete the season. During a season, this figure is used to adjust the length of injuries. For example, if you
are playing a 40-game season, DMB's injuries are only one-fourth as long as if you were playing a 162-game
season.

Whether the designated hitter can be used. Select No DH (never permit it), DH OK (always use it),
AwayTeam DH Rule (for inter-league games where the visiting team's rule should be used), or HomeTeam
DH Rule (also for inter-league games).
Which injury rule should be used. Select None if you do not wish DMB to generate any injuries. Select
Random if you want all players to have an equal chance of getting hurt. Or select Injury Rating to use each
player's injury rating to determine how often he is hurt.
NOTE : If, during a season, you change the injury rule from Random or Injury Rating to None, all players in the league
are immediately restored to health.
NOTE : If your league is using real-life transactions, the injury rule must be None, because the real-life transactions will
determine when players are placed on the disabled list and when they are activated.

Which sacrifice fly rule will be used. In the course of baseball history, the rules governing sacrifice flies
have changed several times, and DMB allows you to choose among those four methods for your league. See
Sacrifice Fly Rules for more details.
Whether the bullpen warmup rule will be used. If this rule is in use, you must start warming up relief
pitchers before bringing them into a game. This adds an interesting element of strategy by forcing you to
think ahead about potential moves you might wish to make. If this rule is not in use, you can bring in a
reliever at any time. See The Bullpen Warmup Rule for details.
NOTE : The bullpen warmup rule does not apply when the computer manager is handling a team. The computer
manager can bring in a reliever at any time without warming him up first.)

Whether to use real-life transactions and lineups in your games. See Real-life transactions and lineups for
details.
Whether to use the weather system . If you check this option, DMB will generate realistic weather patterns
based on the date of the game and the weather information that is recorded with each ballpark. See Weather
for details.
Whether to use the option to limit bench playing time . Every year, there are some players who didn't play
very much but produced excellent statistics when they did play. If you play DMB games with the computer
manager involved, the computer manager will want to use these players much more often than they were
used in real life. If you set up your manager profiles so that these players are not in the starting lineups and
you activate the limit bench playing time option, the computer manager will limit the use of these players and
thereby avoid giving them a larger role than they had in real life.
Whether to use the clutch rating system . See Clutch and Jam ratings for more details.
Whether to automatically save boxscores, scoresheets , and game logs for each game. You can choose
to save all of them, none of them, or save them only when something special happens in the game. You can
choose what qualifies as a special event using the Options command on the Scheduled Game window.
Which boxscore format to use. DMB provides an expanded boxscore with columns for just about every
important batting, pitching and fielding statistic, and a more traditional newspaper-style boxscore with four
batting columns and a block of text that summarizes the doubles, triples, homers, errors, and other
interesting events from the game.
Whether to generate game-by-game statistics for your games. Check this option if you wish to be able to

generate reports based on time intervals and if you wish to be able to look at the daily performance of the
players in your league. The game-by-game statistics can consume 10-20MB of hard disk space for a large
(32-team) league, so if you're short of disk space, you can leave this option unchecked to save space.
Whether to generate game accounts for your games. Check this option if you're running a league and wish to
transfer the results of league games from one computer to another. If you plan to play all of the games on the
same computer, leave this option unchecked.
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Leagues: Post-Season Information
DMB understands that most league seasons end with some sort of championship playoffs. In the course of
baseball history, there have been several changes in the number of teams that qualify for post-season play and the
length and format of those post-season series, so DMB provides you with a variety of options for setting up and
playing your post-season games. The post-season tab is shown below with some fields filled in:

On the post-season page of the Modify League window, you can specify which teams should meet in the first round
of the playoffs and what format those first round series should follow. The format is entered as a string of digits
where 0 (zero, not the letter) indicates a travel day, 1 indicates the higher-seeded team is at home, and 2 indicates
that the lower-seeded team is at home. Here are a few examples:
0220111 -- A travel day between the end of the regular season and the start of this series, followed by two games
at the visiting (lower-seeded) team's park, another travel day, and three games at the home (higher-seeded) team's
park.
1102201 -- Two games at the park of the home (higher-seeded) team, a travel day, two games at the other park,
another travel day, and the deciding game at the home team's park
0110222011 --The 2-3-2 format that has been in use for most seven-game series in recent history
The post-season page also provides the ability to enter the teams that qualify for the league championship round of
the playoffs. In most cases, DMB will automatically identify these teams based on the results of the first round, but
if your league doesn't have a first round, you can select the teams using this form. You can also enter a format for
this championship series and click on a radio button to indicate which of these teams has the home-field advantage

for the series.
The schedule editor window provides a command that enables DMB to generate schedules for post-season series,
and DMB uses the information on this page (the teams and series formats) to create those schedules.
As these series games are played, DMB updates each team's win total so it can display those win-loss records on
the Post-season tab of the scheduled game window and determine when a series has been decided. You cannot
change the teams or series format after the series has started.
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Creating a New League
Prerequisites: If you want to put teams into your new league, your database must contain teams that are not
already assigned to another league.
To create a new league:
1. Click View on the DMB menu bar and select Organizer .
2. When the DMB Organizer screen appears, select the Leagues tab.
3. At the top of the Leagues tab, click the button labeled New . The following screen will appear:

4. Enter a name for the league and a year .
5. Select an era for the league (See Eras for more information).
6. Select a schedule for the league (See Schedules for more information). Leave as <none> if you have yet to

create a schedule.
7. Enter a UID , or Universal ID. You can think of the UID as uniquely identifying a league. You need to assign a
league a UID if you want to use DMB's Encyclopedia to maintain multiple years of stats.
8. Click on the Teams tab to set up a divisional structure and add teams to the league, and click on the Rules and
options tab to finish setting up your league. (You typically don't need to set the Post-season information until you
are ready to begin post-season play.)

UNREGISTERED
VERSION
OF orCHM
PDF
STANDARD BY THE
9. Click OK to add the league
to the database,
CancelTO
to quit
withoutCONVERTER
saving this new league.
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Overview of Organizations
Click here to go directly to creating a new organization.
An Organization links two leagues so they can share a common set of rules and options, play inter-league games
during the regular season, and meet in a championship series at the end of the post-season. Just because you link
two leagues through an organization, you are not required to play inter-league games during the regular season.
This is optional. You can set up the organization just to share the rules and options for post-season play.
You can have more than one league in the same DMB database, and there is no obligation to link them via an
organization. Each of those leagues can independently play their regular season and post-season games, with their
own rules and timetable. If you have only one league in the database, there is no point in creating an organization.
If you do choose to set up an organization, you will be required to name the two leagues that comprise it. Both
leagues must be in the same database as the organization, and you can create only one organization per
database. If you wish to use the same leagues in more than one organization, you can make a copy of the
database and set up the other organization with the copy.
While organizations and leagues have some similarities -- they share the same rules and options -- they also have
some differences. You use a league to organize the divisions and teams that comprise the league and to set the
structure for the post-season series that determine the league champion. You use an organization to identify the
leagues and set the structure for the championship series between the league champions.

Organizations: General Information
The "General" tab enables you to create and modify some general information about the organization.
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You can change the following general characteristics of an organization:
The name of the organization (up to 30 characters)
The year of the organization. The year has no effect on the games that are played, so you can enter any
value you like.
A UID, or Universal ID. You can think of the UID as uniquely identifying an organization. You need to assign
the organization a UID if you want to use DMB's Encyclopedia to maintain multiple years of stats. If an
organization has a default UID of -1, type in the input box to assign a unique UID.
The two leagues that comprise this organization and whether or not inter-league games will be played during
the regular season.
The schedule that will be used.

This page of the organization window also displays some status information that you cannot change:
The season stage is shown in the status box. This indicates whether your organization is still in the offseason or is now playing games from some other stage of your season (pre-season, regular season, or postseason).
The date of the last game played in this organization

Organizations: Post-Season Information
One of the reasons why you might create an organization is to make it possible to play a championship series
between the two teams that win their respective league championships.
This final round of the post-season is set up on the Post-season page of the organization window.
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On this page, you specify the format for this series. See Leagues: Post-Season Information to learn how to specify
a format for the series. You also specify the league whose champion has the home-field advantage in the series. In
the status box, you can choose the two teams that will meet in the series. (These teams may have already been
filled in by DMB based on the results of the league championship playoffs.)
The schedule editor window provides a command that enables DMB to generate a schedule for this series, and
DMB uses the information on this page (the teams and series format) to create that schedule.
As the series games are played, DMB updates each team's win total so it can display those win-loss records on the
scheduled game window and determine when the series has been decided. You cannot change the teams or series
format after the series has started.

Creating a New Organization
To create or modify an organization:
1. Click View on the DMB menu bar and select Organizer. When the DMB Organizer screen appears, select the
Orgs tab to display the existing organization (if any) in this database.
2. To create a new organization, click the button labeled New. To modify an existing organization left-click the
organization and then click on the Modify button. If you prefer, you can simply double-click on the organization. The
following tabbed window will appear:

This window enables you to name the organization, choose the leagues that comprise it, select rules and options,
and set up for post-season play. This information is divided into the following area:
General organization information
Rules and options (the same as for a league)
Information about the post-season

NOTE: After you have finished setting up your organization, you will need to make sure it has a valid schedule before you begin
to play games. If the organization has no schedule assigned to it, you can use DMB's schedule creation tools to generate, import
or edit a schedule that fits the structure of your organization. It's up to you whether this schedule includes inter-league games or
not.
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Overview of Eras
Click here to go directly to viewing and modifying era information.
Much of baseball's rich tradition is due to the unchanging nature of the game. Nevertheless, some aspects of
baseball have changed dramatically over time. For example:
Today, league batting averages are typically around .270. But over the past seventy years they have ranged
from under .240 to over .300 due to changes in rules, ballparks, and equipment.
At the turn of the 20th century, it was common for shortstops to make over 60 errors in a season. Today, few
shortstops make more than 25 errors.
Also at the turn of the 20th century, it was common for starting pitchers to complete over 80% of the games
they started. Today, teams rely much more on their relief pitchers, with starting pitchers completing fewer
than 10% of their starts.
Pitchers in leagues using the designated hitter rule usually allow one more run every two games than they
would in a non-DH league, because they do not face weak-hitting pitchers.
It is not possible to play realistic games among teams of different eras without adjusting for these changing playing
conditions. For example, without these adjustments, a 1912 team would have almost no chance of beating a 1984
team because it would make two to three times as many errors. Are the 1984 fielders really that much better? Of
course not. They just have the advantage of using modern gloves and playing on artificial turf.
Or, to use a modern example, a pitcher from a DH-league typically allows an extra run every two games compared
with a pitcher who does not have to face a DH. If you want to see what would happen if this pitcher was traded to a
non-DH league, or you wanted to release all of the players from both leagues and draft new rosters, you need a
way to make sure the DH-league pitcher is not unfairly punished.
DMB uses eras to adjust for these factors. In DMB:
A .280 hitter in 1968 (when the league batting average was under .250) is a better hitter than someone who
hit .280 in 1930 (when the average player batted .300).
A shortstop making 40 errors in 1912 is a better fielder than a shortstop making 30 errors in 1993.
A starting pitcher completing 30% of his games in 1984 is more durable (relative to his peers) than someone
who completed 50% of his starts in 1920.
A DH-league pitcher with a 3.30 earned-run average is a better pitcher than someone with a 3.00 ERA in a
non-DH league.
For many DMB owners, it is enough to know that you are using a game that adapts to different playing conditions.
However, if you want to create or modify players, create new leagues and rosters, or play games with teams from
different seasons, you need to know a little more. The remainder of this help topic describes the information
contained in an era and the procedures for adding, changing and deleting eras.
The DMB historical era database

Once upon a time, anyone who wanted to create players in DMB had to start by creating the era against which
those players should be evaluated. If you were creating all of the players for a single real-life season, that wasn't
too bad, because you'd need only one or two eras. If you were creating a collection of all-time great players drawn
from all of baseball history, you might need to create dozens of eras.
To simplify the process of creating players, DMB now includes a database with an era for every big-league season
that has been completed since 1894. You can use these historical eras directly in the player creation and
modification process, and you can import any of those eras into your database so you can use them in your own
leagues. In short, you may no longer need to create or modify your own eras.
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If, however, you are creating players for a fictional league, a foreign league, or one of the minor leagues, or if you
wish to use an era based on a range of real-life seasons, you won't be able to use the eras in the historical
database. You can, however, create and modify your own eras with a few simple steps.

Working with Eras
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To create or modify an era, choose the View>Organizer command to open the Organizer window, then click on the
Eras tab at the bottom of the window. This displays a list of the eras in your database. From here, you can click on
the buttons across the top of the Organizer window to create, copy or modify an era. Each of these commands
causes the following era window to display:

There are two tabs on this window:
the General tab displays basic information about the era and the statistics that establish the level and type of
offense for this era

the Rates tab displays error rates and pitch-by-pitch rates that govern fielding performance and the batterpitcher confrontation for games played in this era.

Eras: General Information
The "General" tab enables you to create and modify some general information about the era.
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You can change the following general characteristics of an era:
the name of the era (up to 30 characters)
the internal ID that uniquely identifies this era within a DMB database. This ID is automatically assigned by
DMB and cannot be changed.
the from year and to year for the statistics and rates in this era. These values are not directly used for
anything in DMB, but because most eras are based on real-life seasons or a collection of real-life seasons,
they give you a handy way to remind yourself where the statistics and rates come from. In fact, you can think
of these values as an extension of the era's name.
Example: If, for example, you create an era based on the 1936 season, you could enter 1936 as the from year and
leave the to year as zero. If you create an era that reflects the average of all seasons from 1920 to 1929, you could
enter 1920 for the from year and 1929 for the to year.

whether or not the DH (designated hitter) was used in the real-life season(s) from which the statistics. This is
very important, because DMB hitters and pitchers are evaluated based on how they performed when
compared to the averages for their era.

NOTE: Pitchers are generally very poor hitters, so their batting statistics drag down the era averages. The same group
of players might produce a batting average of .260 if designated hitters are used and an average of .253 if pitchers bat
for themselves. Without adjusting for the effect of the designated hitter rule, a shortstop who hits .257 would appear to
be a little below average in the first situation and a little above average in the second. So DMB needs to know whether
the DH was used so it can make the necessary adjustments so our .257 hitter is rated the same way in either situation.

the statistics for this era. In most cases, these statistics will be for a single season of a real-life league. If
you wish to create an era for a group of seasons, we recommend that you average those season so the
values you enter are about the right size for a single season.
NOTE: These statistics determine the basic rates of singles, doubles, triples, homeruns, walks, strikeouts, and hit
batsmen for games played in this era. When players are created, their statistics are compared with these rates, and the
players are rated for how much higher or lower their personal rates were than the norms for the era. When you play
DMB games, these rates establish a starting point from which DMB makes adjustments -- to reflect the ballpark, the
ratings for the batter and pitcher, the tactics employed on the play, and many other factors -- that help it determine
whether a particular pitch results in a single, a double, and so on.

DMB generates the result of every pitch (hit batsman, called ball, called strike, swinging strike, foul ball, ball hit into
play). Walks and strikeouts result from a progression of these pitch results. So the process of creating an era
isn't complete when you enter the statistics on this page. You must also visit the Rates page of the era window
to ask DMB to generate a set of pitch-by-pitch rates that are based on the walks, strikeouts and other statistics you
entered on the General page.
As far as we know, it's either extremely difficult or impossible to find league totals for intentional walks and hit
batsmen. None of the leading baseball encyclopedias include this information, and we're not aware of any online
sources, either. So we've added buttons that allow you to ask DMB to estimate these figures for you. DMB's
formula uses the year, the DH rule, atbats, and walks to make these estimates, so make sure you've already set
these values before clicking on the estimate buttons.

Eras Rates
The "Rates" tab enables you to create and modify some important information about the era.
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There are three groups of rates on this page. The first group determines pitcher durability, the second determines
error rates, and the third governs the pitch-by-pitch system. Let's consider each group in turn.

Average pitches
The values for average pitches per start and per relief appearance determine how quickly your pitchers will get
tired.
Keep in mind that there are many reasons other than fatigue for a pitcher to be removed from a game -ineffectiveness, the need for a pinch hitter, a double-switch, injury -- so the average number of pitches thrown is
usually lower than the number of pitches he can throw before getting tired in any particular game. This is, of course,
assuming the pitcher doesn't enter the game having already thrown a bunch of pitches in the last couple of days.
For example, if the average number of pitches thrown per start is 95, a pitcher with an average durability rating can
probably throw at least 110 pitches before tiring if he enters the game at full strength. And a pitcher with an
Excellent durability rating can probably throw more than 130 pitches before beginning to weaken.
See Pitching Ratings for a table showing how the average number of batters faced has changed over the past 100
years. You can use this table as a guide when choosing the average pitch values for your eras. You'll need to
multiply these batter faced numbers by the average number of pitches per batter faces.

Unfortunately, this type of pitch count information isn't known for most of baseball history. We know that the
average number of pitches per batter was in the 3.6 to 3.8 range in the 1990s. And we know the rates of walks and
strikeouts were at or near all-time highs in the 1990s, so it stands to reason that batters were seeing fewer pitches
per plate appearance for most of baseball history. But how much lower is a matter of speculation. Our best
estimate is that these rates have ranged from 3.1 to 3.8 over the course of the last hundred years.

Error rates
The error rates are expressed as the number of errors made per 100 games. We chose 100 games because the
length of a season has changed over time, and we wanted a stable period of time to work with.
See Defensive Ratings for a table showing how error rates have changed over the past 100 years. You can use
this table as a guide when choosing error rates for your own eras.

Pitch by pitch rates
The pitch-by-pitch rates govern how often a pitch results in a hit batsman, called ball, called strike, and so on. Click
the Recalculate button to have DMB produce these values based on the era statistics that were entered on the
General page.
These values have the following meaning:
HBP rate. The number of pitches (per 10,000) that result in a hit batsman.
Strike rate. The number of pitches (per 10,000) that result in a strike (called, swinging, foul ball, ball in play).
Swing rate. The number of strikes (per 10,000) on which the batter swings.
Foul rate. The number of swings (per 10,000) that produce a foul ball.
In play rate. The number of swings (per 10,000) that produce a ball in play.
Balk rate. The number of balks per 10,000 pitches with runners on base.
You can change the pitch-by-pitch rates, but it's not always easy to figure out the effect that your changes will have
on your games. For example, increasing the In play rate will reduce the number of walks and strikeouts because
more balls in play means that you won't have as many plate appearances that make it all the way to four balls or
three strikes. But the amount by which it will reduce walks and strikeouts depends on the other pitch rates. An
increase in the foul rate would reduce the number of strikeouts (by keeping the batter alive on more two-strike
pitches) and increase the number of walks (because the batter may go on to draw walks where he might have
already been struck out before). It's even harder to predict what will happen if you change more than one of these
values at the same time.
Most of the time, the generated pitch-by-pitch rates will give you very accurate results. When we design season
disks, we always start with these calculated rates. We occasionally make adjustments, but those adjustments are
always small, and we often have to experiment by simulating the season a few times before we settle on a set of
adjustments that gives us the results we're seeking.

Creating a New Era
If you wish, you can create a new era which reflects general changes in overall player performance for a particular
period in time.
To create a new era:
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1. Click View on the DMB menu bar and select Organizer.
2. At the bottom of this screen you will see a series of tabs. Select the tab Eras.
3. Click the button at the top of the screen labeled New. The following window will appear (though there won't be
any values filled in):
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This window contains two tabs. One for entering general information about the era and another for entering rates.
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Importing Eras
The Import Era feature allows you to import era descriptions from one DMB database into another.
To import eras:
1. Click View on the DMB menu bar and select Organizer.
2. Click on the tab labeled Era at the bottom of the screen.
3. Click the button labeled Import at the top of the tab. The following window will appear:

5. Use the pulldown list at the top of this window to select the database that contains the era you wish to import.
The contents of the window will change to show the eras available in the selected database.
6. Select one or more eras to import and click OK. To select multiple eras, use the techniques described in
Selecting Multiple Items in a List.
Copies of the selected eras are added to the active database.

Overview of Schedules
To play league games, you need a schedule. If your league is not part of an organization, the league has its own
schedule. If it is part of an organization, it's the organization that has the schedule. An organization schedule can
include inter-league games, but it doesn't have to.

Before each real-life season,
the scheduleOF
of games
for that
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schedule because all games are on the dates they were originally scheduled for. As the season progresses,
however, some games are rained out and either rescheduled later in the season or cancelled altogether. So there's
another schedule, one that reflects when the games were actually played. We call this an as-played schedule.
This distinction is important for these reasons:
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if you are doing a season replay using real-life rosters, you'll probably want to use an as-scheduled schedule
if you have access to one, because all teams are guaranteed to play the full 154 or 162 games that way.
if you are doing a season replay using real-life rosters and you want to use the real-life transactions and
lineups feature (for those seasons where this is available), you MUST use the as-played schedule. The
transactions and lineups are geared toward the dates when the games were actually played, so everything
will be out of synch if you try this with the as-scheduled schedule.
If you have created a new league or you are using the same teams but with newly-drafted rosters, you ought
to use an as-scheduled schedule, either one from real-life or a new one that you create with the DMB
scheduling tools.
The DMB scheduling tools give you several ways to create and modify a schedule:
create a schedule by adding games one at a time, adding a group of games, copying blocks of games,
inserting and removing off days, and using the other schedule editing commands
generate a regular-season schedule by filling in a form that indicates how many games each division should
play against each other division
select a schedule template that matches the structure of your league or organization and build a schedule
using that template
create a schedule outside of DMB (perhaps using a spreadsheet or database product), save it as a commadelimited text file, and import that text file into DMB
when the season is over, generate a post-season schedule using the information you enter into the Postseason sections of the league and organization forms
You can edit schedules even after the season has started, though some commands are not available in some
situations. You can also edit game results for games that have been completed.

Creating a New Schedule
Any time you create a new schedule, you must select the league or organization the schedule is to be built for.
Most of the DMB scheduling tools need to know which teams are to be included and what divisional setup is to be
used.
No matter which tools you plan to use to build your schedule, the first step in creating a new schedule is to use the
View>Organizer command to open the Organizer window, click on the Schedules tab, then click on the New
button. The follow window will appear:

Enter a name for your schedule. Use the Scope pulldown to indicate whether this schedule is intended for a
league or an organization, then use the Owner pulldown to choose a specific league or organization. If the Owner
is an organization, check the Inter-league play box if you wish to play inter-league games during the regular
season.
NOTE: You MUST choose a scope of Organization if you wish to play a final championship series between the two league
champions.

When you have finished making your selections, click OK. The new schedule appears on the Schedules tab of the
Organizer.
At this point, there are no games in the schedule. Double-click on the name of the new schedule to open the
Schedule Editor window, which will be empty until you start adding or generating games. See Schedule Editing for
details.

Schedule Editing
When you first create a schedule, the schedule editor window is empty except for a row of buttons that you can use
to create and modify a schedule. As games are created, they are displayed in this window. During the season, this
window also shows the score of any games that have been completed.
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Schedule Info
Click on the Info button to display a window showing the information you entered when you created the schedule
and a few other pieces of information about the schedule you are creating. Other than the name, you cannot
change this information after the schedule has been created.

Adding New Games
Click on the New button to add one or more games to the schedule. See Adding Games for details.

Copying Games
Click on the Copy button to add one or more games to the schedule. See Copying Games for details.

Deleting Games
To delete one or more games, select the games you wish to delete and click on the Delete button. To select a
single game for deletion, click on that game using the left mouse button. To select multiple games for deletion, use
the techniques described in Selecting Multiple Items from a List.

Modifying a Game
To modify a game, select the game you wish to modify by clicking on that game using the left mouse button. Then
click on the Modify button. DMB displays the same window that is used for adding new games. See Adding Games
for details.

Erasing the Schedule
Click on the Erase button to remove all games from the schedule. Because accidental use of this command could
wipe out a lot of your work, DMB asks you whether you are sure you want to do this before it proceeds to delete the
games.

Scheduling Tools
Click on the Tools button to display a popup menu containing a number of powerful schedule generation tools. See
Scheduling Tools for details.

Saving the Schedule
Click on the Save button to save the current schedule to disk. If you do not save your schedule periodically, DMB
will not save your changes until you close the schedule editor window.
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Adding Games
Once you have created a schedule, you can add games to that schedule using the schedule editing window. To
open the schedule editor window, use the View>Organizer command to open the Organizer window, click on the
Schedules tab, click on the schedule you wish to work with, then click on the Modify button.
In the schedule editor window, click on the New button. You will see the pop up menu shown below:

At this point you may add a single game or multiple games to the schedule. Depending on what you select, the
following screen will appear with one or more options unavailable:

If you selected Add one game, the options "Games" and "Spread games over days" will not be available. If you
selected Add multiple games the option "Game of day" will not be available.
Enter the date of the game (if you're adding one game) or the date of the first game in a series (if you're adding
multiple games).
Choose the Away team and the Home team.
If you are adding a single game, enter the Game of day. If this is the only game between these two teams on that
day, enter 0. If this game is part of a double-header, enter 1 for the first game or 2 for the second game.
Choose the Type of game to be played -- pre-season, regular season, and so on.
If you are adding multiple games, enter the number of games to create. Check the spread games over days box to
have DMB create one game per day starting with the date that was entered. Leave this unchecked if all of the
games are to be played the same day (as in the case of a double-header).
Click OK when you are done.
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Copying Games
One strategy for creating a league schedule is to (a) enter a collection of games in which each team plays one
series against each other team, (b) repeat this step with the home and away teams reversed, and (c) copy all of
these games one or more times until you have enough games for a full season. The Copy command helps you do
steps (b) and (c) very quickly.
To open the schedule editing window, use the View>Organizer command to open the Organizer window, click on
the Schedules tab, click on the schedule you wish to work with, then click on the Modify button.
In the schedule editor window, select the games you wish to copy. To select a single game, click on that game
using the left mouse button. To select multiple games, click on the first game, then hold down the Shift key and
click the last game. You cannot skip games in a schedule if you are copying multiple games.
When you have selected the game(s) you wish to copy, click on the Copy button. DMB displays the following
window:

Enter a start date for the copied games to begin. Use the check box if you wish to reverse the home and road
teams. When you have made your selections, click OK. The copied games are now displayed in the Schedule
window.

Scheduling Tools
When you click on the Tools button in the schedule editor, DMB displays a popup menu of powerful schedulebuilding commands.
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Some of these commands are quite simple, and we'll describe them below. Others are more complex, and we'll
provide links to separate help topics for a full explanation.

New start date
Use the New start date command to change the start date for your schedule. If, for example, your schedule
currently begins on April 5th and you change it to April 10th, all games in the schedule are moved five days later.

Adding and removing off days
Use the Add off days command to insert one or more off days into the schedule. DMB displays the following
window:

Enter the date of the first off day and the number of days you wish to insert at that date. When you click OK, DMB
moves all subsequent games by the number of days you enter.
Use the Remove off days command to remove one or more off days from the schedule. DMB displays the window
shown above so you can choose the first day and the number of off days to remove. DMB will not let you remove
days if there are games scheduled on those days.

Generating schedules
DMB includes two schedule generators, one for generating regular-season schedules and one for generating postseason schedules.

Schedule templates
A schedule template is a generic schedule, one that has a certain divisional structure and season length, but has
place-holders instead of the IDs of real teams. You can convert any schedule to a template so you can use it as the
basis for creating schedules for other leagues with the same structure. And you can create a schedule for your
league using a schedule template that comes with the game or one that you previously created. See Schedule
Templates for details.

Importing and exporting text files
You can convert DMB schedules to and from comma-delimited text files. This enables you to work on schedules
outside of DMB and import the results back into the DMB database. See Importing and Exporting Schedules for
details.

Edit game results
After a DMB game has been played, DMB adds the linescore for the game and some other information (starting
pitchers, winning and losing pitcher, etc.) that is useful for the game results reports. See Editing Game Results for
details on making changes to these game results.

Generating Regular-season Schedules
DMB includes a flexible schedule generator that you can use to build schedules for almost any divisional structure,
including inter-league play.
To open the schedule editing window, use the View>Organizer command to open the Organizer window, click on
the Schedules tab, click VERSION
on the schedule OF
you wish
to work
with,
then click
on the Modify button.
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DMB displays a two-part form for collecting your schedule generation options. The first page contains the following
items:
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Enter the start date you prefer.
Check the Off days box if you want the generator to build off days into the schedule to simulate the travel days that
real-life schedules include. Leave this box unchecked if you want the generator to try to build a schedule without
any off days. (It may not be possible to avoid off days for some types of leagues.)
Enter a value for the Average series length you would like to see. This is a guideline, not a firm rule, because the
generator needs the flexibility to generate series of varying lengths to ensure that the right number of games are
scheduled between each pair of teams.
To add some variety to your league's schedule, you can use the Shuffle options of Series and Date. Shuffling by
Series randomly shuffles your schedule but will keep all games in each series intact. For example, a three game
series that would normally start on Opening Day, could get shuffled to start on the 70th day of the season. The
second game of the series would now be scheduled for the 71st day and the third game for the 72nd day.
Check the All-star break box if you want the generate to insert a gap in the schedule for an all-star game. (DMB
doesn't generate the all-star game itself.) Enter the length of the break (in days) and how far into the season
(Break pct) you'd like the break to be scheduled.
Click the Next button to move to the second part of the form:

On this form, enter the number of games a team in one division plays teams in the other divisions. The top-left cell
contains the number of games each team in the first division should play against other teams in the same division.
The second cell on the top row indicates the number of games each team in division one should play against each
team in division two. And so on. If you don't want one division playing another, enter zero in the cell for that
divisional matchup.
The divisional matchup grid has eight rows and eight columns. That's because you can generate a schedule for an
organization that links two leagues, and each league can have up to four divisions. The bottom part of this window
lists the divisions that correspond with each row and column in the grid.
Suppose you have a league with two six-team divisions. And suppose that you have decided that you want a 162game schedule, with each team playing 24 games against divisional opponents and 7 games against teams in the
other division. Enter 24 in the "1 vs 1" cell, 7 in the "1 vs 2" cell and 24 in the "2 vs 2" cell.
You may need to play around with the numbers before you settle on a set that produce the season length you are
looking for. To help you with this, the Games column on this form is continually updated to show how many games
each team in a given division would play if you went with the numbers currently entered into the cells. Use the tab
key to move from cell to cell and ensure the Games column is updated.
When you are happy with your selections, click on the Finish button to generate the schedule. DMB closes this
options window and displays the generated schedule in the schedule editor window.
Limitations
The schedule generator is designed to apply simple rules like making sure that every team has the same number of
home and road games against each opponent. This isn't too hard to accomplish with simple league structures like
one division of eight teams and two divisions of six teams.

In recent years, the addition of inter-league play and the odd divisional structure (three divisions per league with
divisions holding 4, 5 or 6 teams), the real-life schedule makers have been forced to break all the traditional "rules"
of schedule design. In 1999, we had inter-league play (but only for certain divisional matchups) where teams would
play home-and-home series against their designated rival but only one series against the other teams in that
division. Because one league had 14 teams and the other 16, two teams had to play within their own league while
the others were playing inter-league games.
There is, quite frankly, no chance that the DMB schedule generator can come close to building schedules like the
ones in use today, because it's not "trained" to break those traditional rules of schedule design. We added
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schedule that comes close to what you want, then using the schedule editing commands to adjust that schedule
until it's exactly the way you want it.
You can generate schedules of up to 200 games per team. DMB doesn't permit schedules longer than that
because some of the player
statistics would
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database
fields if the season
was longer than
UNREGISTERED
VERSION
OF
CHM
TO their
PDF
CONVERTER
STANDARD
that.

BY THE

BY THE

Generating Post-season Schedules
If you have used the Organizer to set the matchups for the post-season, you can use the schedule generator to
quickly add those series games to the end of your schedule. See Leagues: Post-season Information and
Organizations: Post-Season Information for details on setting up for the post-season. Once you have set up for
post-season play, generating the schedules is quite simple.
To open the schedule editing window, use the View>Organizer command to open the Organizer window, click on
the Schedules tab, click on the schedule you wish to work with, then click on the Modify button. Then click on the
Tools button and select Generate. Then pick the round of the post-season you wish to generate.
That's it. DMB adds the games for these series to the end of your schedule. If a post-season round involves more
than one series (there will be four first-round series if you have an organization with two leagues and four teams
qualifying in both leagues), the generator adds all of the series for that round at the same time. So you only need to
run this command once per round, not once per series.

Schedule Templates
A schedule template is a generic schedule, one with a certain divisional structure and season length. But instead of
containing real team IDs, it has place-holders. If you have a league or organization that has the same divisional
structure as the one used in the template, the actual teams in your league can be merged into the schedule
template to form a real schedule.
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To create a schedule from a template, or to save a schedule as a template for future use, you must first open the
schedule editing window. To do this, use the View>Organizer command to open the Organizer window, click on
the Schedules tab, click on the schedule you wish to work with, then click on the Modify button.

Creating a schedule from a template
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Click on the Tools button and select Create from template. DMB displays the following window to allow you to
choose a template that fits the structure of your league or organization:

Use the template description pulldown to browse the collection of templates and select one that matches the
structure of your league and the length of schedule you're looking for. When you select an entry from this list, DMB
populates the information in the bottom half of the window.
When you have selected the template you want, choose the Start date for your schedule, and then click on OK.

Saving a schedule as a template
Click on the Tools button and select Save to template. DMB displays the following window to allow you to assign a
name and description that will make it easier to decide when to use this template later:

Click on OK to add this new template to the DMB template database.

Importing and Exporting Schedules
Sometimes it helps to be able to export a DMB schedule, work on it in a database or spreadsheet product, and
import the modified schedule back into DMB. Or maybe you have a schedule that you created in another product
and would like to use it in DMB. If you can get that schedule into a comma-delimited text file in the format we
specify, you can import that schedule.
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The user interface for importing and exporting schedules is pretty much the same. In both cases, the standard
Windows file location window opens, allowing you to find the file you want to import or specify a file name and
location where DMB should write the export file.

WARNING! If you already have games in the schedule you are working with, importing a schedule will erase the existing games
before adding the imported games.
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Format of the schedule file
An exported schedule file is a plain text file with one scheduled game per line and commas separating the values
that describe each game. Here are the first few lines of an exported file:
1,4/5/2000,0,11,7,2,0
2,4/6/2000,0,9,3,2,0
3,4/6/2000,0,1,5,2,0
4,4/6/2000,0,6,8,2,0
5,4/6/2000,0,2,10,2,0
The first item in each row is a sequence number, starting from 1 and going up to the number of games in the
schedule.
The second item is the date of the game in a MM/DD/YYYY format.
The third item is the game number within the day -- 0 for the only game of the day, 1 for the first game of a
double-header, and 2 for the second game of a double-header.
The fourth item is the ID of the visiting team and the fifth is the ID of the home team. You can find team IDs on
the Teams tab of the Organizer window.
The sixth item is the game type, with the following values:
Game type code

Meaning

1

Pre-season

2

Regular season

5

Divisional series

6

League championship

7

Org championship

In most cases, you should include only pre-season and regular-season games. The post-season codes are
meaningless until the regular season has been completed and the matchups are known.

The seventh and last item is the game status, with the following values:
Game status code

Meaning

0

Unplayed

1

Completed

4

Cancelled

5

In progress

If you are building a file to import into DMB, you should use only the 0 code. DMB will not let you import a schedule
after the season has started.

Editing Game Results
After a DMB game has been played, DMB adds the linescore for the game and some other information (starting
pitchers, winning and losing pitcher, etc.) that is useful for the game results reports. The game result information
also includes the name of any boxscore or scoresheet file that was generated for this game.

To edit game results, youVERSION
must first open the
To do this, use the View>Organizer
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command to open the Organizer window, click on the Schedules tab, click on the schedule you wish to work with,
then click on the Modify button. Then select the game you wish to modify, click on the Tools button, and select the
Edit game results command. DMB displays the following form:
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You cannot change the data of the game or the teams involved, but you can edit the linescore, change some of the
statistics, change the identity of the starting pitchers and the players who were awarded the win, loss, save and
game-winning RBI.
NOTE: Any changes to these values will affect only the contents of the game results reports. These changes do not affect the
statistics of any player.

Click OK when you are happy with your changes or Cancel to abandon any changes without updating the
database.

Drafting: Overview
A draft is an organized process in which teams select players from a free agent pool. Before we get into the details
of setting up and running a draft, we remind you that you can also sign free agents to a team roster using the
commands in the Roster / manager profile window. That's the best way to move a few free agents onto team
rosters. But if you want to have every team in a league or organization take turns drafting free agents, setting up
and running a draft is the way to go.
DMB offers a wide variety of options when conducting a draft. You can:
draft new rosters from scratch or start with partially complete rosters (such as a group of players carried over
from a previous season)
set the order in which the teams will make their picks, choosing whether the draft order stays the same in
every round or reverses in every other round
browse lists of free agent batters and pitchers, sort those lists on any statistic or rating, and filter those lists
based on batting and throwing hand, position, playing time, etc.
add supplemental draft picks for one or more teams in any round, or delete any draft pick (to punish teams
for breaking league rules, for example)
trade draft picks
reverse a draft pick that was made in error
ask the computer general manager to make one or more picks automatically
save a draft in progress and resume it later
generate a report showing all of the picks that have been made in a draft.
The following topics explain the process of creating and running a draft:
Draft preparation
Creating a draft
Draft Window
Setting the Draft Order
Adding, Deleting and Trading Picks
Making Manual Picks
Computer Drafting
Drafting and Manager Profiles
Resuming a Draft
Deleting a Draft

Draft Preparation
Before you begin drafting players, you may want to do some work to prepare the team rosters and the list of free
agents.
If you have used the Migrate command to carry your league's structure forward from one Season Disk to the next,
everything should be ready
to go. But if you
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that most of the players you might want to draft are already on their real-life rosters. So, before your begin the draft,
you may want to release players into free agency, delete team-specific records for multi-team players, and set up
the teams in your league.

THE

Releasing Players
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There are two ways to release players into free agency:
many leagues limit the number of players you can carry forward from one year to the next, so managers have
to decide who they wish to keep and who they wish to make available in the draft. To release specific
players, use the Roster / manager profile window and choose the Release command.
use the Tools>Release all players command to quickly drop all players from one or more teams into the free
agent pool.

Deleting multi-team players
Most Diamond Mind Season Disks contain more than one record for players who were traded during the real-life
season. So you'll often see the same player in the free agent pool three or four times -- once for each team he
played on (we call these team-specific records), and once for his overall performance.
It's usually best to remove the team-specific records and leave only the player's overall record in the database. The
Tools>Delete team-specific records command is an easy way to do this.
NOTE: This command will only delete team-specific records if they are already in the free agent pool. If you have not used
Tools>Release all players and wish to delete only some team-specific records, you need to make sure they are first released
from their team.

Setting up Your League
Before creating the draft, use the Organizer commands to put together the league and/or organization for which
you are going to run the draft. When you create the draft, you'll be asked which league or organization to use, so
you need to have this set up ahead of time.

Creating a Draft
You create a new draft using the Organizer:
1. From the Diamond Mind menu bar, click View then Organizer.
2. When the Organizer window appears, select the tab labeled Draft at the bottom of the window. Click on the New
button to display the following form:

3. Enter a name for your draft.
NOTE: You can create more than one draft in a database, though you probably won't need more than one very often.

4. Use the pull down list to select whether you draft will include teams from a single league or from an
organization linking two leagues.
5. Use the next pull down to select the specific league or organization you wish to include in the draft.
6. Enter how many rounds you want your draft to run. Don't worry too much if you're not sure about this number.
You'll have a chance to add or delete rounds later.
7. Finally, use the checkbox if you want the draft order to reverse each round. If this box in not checked, teams will
draft in the same order in every round. If it is checked, the draft order will be from first-to-last in the rounds 1, 3, 5,
and so on, and from last-to-first in rounds 2, 4, 6, and so on.
8. Click OK.
9. Double-click on the name of your draft to view the draft window.

Draft window
The draft window displays all of the information you need to finish setting up a draft and to carry out that draft using
a combination of human and computer draft picks. The information is divided into four tabs, as shown below:
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Main Tab
The Main tab displays the teams that are participating in the draft, listed in the order they will make their picks. For
each team, this list also shows whether this team is in a league that uses the Designated Hitter (DH), whether the
picks for this team are to be made by a human (H) or computer (C) manager, and the number of batters (B),
pitchers (P), and total players (T) currently on this team's roster.
We'll cover Setting the Draft Order in the next topic. The buttons carry out the following actions:
the Options button displays the information you entered when creating the draft, including the name of the
draft and number of rounds
the Freeze draft order button locks in the draft order for the duration of the draft. Don't click on this button
until you're sure everything is set up the way you want. But don't forget to click on this button when you are

ready to start drafting, because you cannot make any picks until the draft order is frozen.
click on the name of any team in this list to select it, then click on the Show roster button to display the
Roster / manager profile window for this team. This allows you to see all of the players on a team's roster,
examine the statistics and ratings for those players, and view the team's manager profile.
click on the All human button to indicate that all teams are to be drafted manually, or click on the All
computer button to switch all teams to computer drafting
You can also display a popup menu by right-clicking on any team in the list shown above. Using this menu, you
can:
view that team's Roster / manager profile window
move that team to another place in the draft order or have that team swap places in the draft order with
another team (assuming the draft order hasn't been frozen)
switch between human or computer drafting for that team
Whenever the draft window is open, you will see a special drafting menu across the top of the main DMB window.
Many of the commands that you can access via the buttons and the popup menu are also available on that special
drafting menu. One additional command is also available. On the Draft menu, you can choose Set draft order
randomly to shuffle the draft order.

Batter and Pitcher Tabs
These tabs display the list of available free agents and provide tools for sorting and zooming in on the players you
are most interested in drafting. The batter and pitcher lists contain different statistics and ratings, but they work the
same way, so we'll show only the batter list here:
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The tabs in the bottom left corner allow you to switch among several pages of statistics and ratings for these
players.
Click on the Options tab to display a window with many options for zooming in on players by batting hand, position,
or playing time. In this example, we've limited the list to players with at least 200 plate appearances, and we've
sorted the list by slugging percentage. You can specify the sort sequence using the Options button or by doubleclicking on any column header.
Click on the Draft player button to select a player. We'll discuss this in more detail in the Manual Picks topic.
You can right-click on any player to display a popup menu with commands that allow you to draft that player or view
the Player Profile window for the player. You can also double-click on a player to view his profile.

Draft Picks Tab
This tab shows you the full list of draft picks:

The first two columns identify each pick by its round (Rd) and its number within the round, and the last column
numbers each pick from the beginning of the draft. For example, we can see that Lefty Williams was taken with the
8th pick in the 1st round and that Hank Greenberg was taken with the 17th overall pick.
The Orig Team column shows you which team originally owned the pick. This is important because a pick can be
traded, but the order in which the picks are made is determined by the draft order position of the team that originally
owned the pick.
The # column is used only when you add a supplemental pick in a round. Normally, each team makes exactly one
pick in each round. But your league may have awarded a team an extra pick in a certain round. (Expansion teams
often get extra picks, for example.) Those extra picks will have a sequence number of 2, 3, and so on.
The Curr Team column identifies the current owner of a traded pick.
The Player column contains the name of the player chosen.
You can right-click on any pick to display a popup menu with commands that allow you to add or delete rounds, add
or delete individual picks, trade picks, or reverse a previously made pick. We'll discuss these actions in more detail
in the Working with Draft Picks topic.

The Draft Order
The draft window's Main tab displays the teams involved in the draft and the order in which they will make their
picks. There are three ways you can modify the draft order:

on the main window's
menu, select Draft
then TO
choose
Set draft
order randomly. This,
as the name
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suggests, will shuffle the teams into a new order.
right-click on a team to display a popup menu of commands, then choose either the Move team or Swap
teams command. In both cases, enter the team's new draft order position in the small window that pops up.

use drag-and-dropVERSION
to select a new position.
To move
a team,
on it with the left mouse
button, and while BY THE
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holding the mouse button down, drag that team to its new position, then release the mouse button. To swap
the positions of two teams, use the same technique, but hold the Shift key down while you carry out the dragand-drop sequence.
When you have the draft order as you want it, click on the Freeze draft order button. You must do this before you
can start making draft picks.

Working with Draft Picks
You can use the Picks tab of the Draft window to view the progress of a draft and perform other actions such as
adding rounds, reversing, deleting, or trading picks, and so forth.
The menu of draft pick commands can be displayed in two ways:
left-click on a draft pick to select it, then choose Picks on the main DMB window's menu bar
right-click on a draft pick to select it and display a popup menu
With this menu, you can add or delete rounds, add or delete an individual draft pick, trade a pick, or reverse a pick
that has already been made.

Adding and deleting round(s) to the draft
When you choose either of these commands, enter the number of rounds you wish to add or delete in the small
window that pops up, then click OK. You may not delete rounds after the draft order has been frozen, but you may
add rounds at any time. The rounds you add and delete are always those at the end of the draft.

Adding a draft pick
When you choose this command, the following window pops up:

Fill in this form to indicate which team is the original owner of the pick; the round in which this pick will be made;
whether this is the original team's first, second, or a subsequent pick within this round; and (if the pick has been
traded) the new owner of this pick. When you are done, click OK.
You can add picks to a draft at any time.

Deleting a draft pick
To delete a pick, just select that pick and choose the Delete pick command. You cannot delete a pick that has
already been made. If you need to delete a pick that has been made, reverse that pick first, then delete it.

Trading a draft pick
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When you choose this command, DMB displays the same window that is used for adding a new pick, but allows
you to change only the team that currently owns the pick. Select the new owner, then click OK to transfer the pick
to that team.
You cannot trade a pick that has already been made. If you need to trade a pick that has been made, reverse that

pick first, trade it, then draft
the player again.
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Reversing a draft pick
Use the Reverse selected pick command to release a drafted player back into the free agent pool.

Void selected pick
When the computer drafting logic comes across an unmade pick that belongs to a team whose roster is already
full, it marks the pick as void and moves on. You can use this command to void a pick manually -- as a penalty for
playing time violations in the previous season, when a team has made all of the picks it's entitled to -- for any
reason that makes sense for your league. These voided picks will appear as such on the drafting screens and in
draft reports.

Restore voided pick
Use the Restore voided pick command to reverse the voiding of the pick and allow that team to use that draft
pick.

Manual Picks
When you have frozen the draft order, you can begin making picks. To make a pick manually, click on the Batters
and Pitchers tabs to look over the lists of free agents. The free agent lists use the reporting system to provide a
powerful sorting and filtering capability that makes it easy to focus your search on the types of players you're most
interested in. See the Draft window topic for more details.

When you have made your decision, you can draft that player in one of two ways:
left-click on the player, then click on the Draft player button
right-click on the player, then choose Draft this player from the popup menu
At this point, DMB assumes you want to use the first unmade draft pick to choose this player, but because it's
possible that your teams are drafting out of order, DMB pops up a window to give you a chance to assign this
player to a different pick:
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If this is the pick you want to use for this player, click OK. If not, click the Next button until the desired pick is
shown, then click OK.
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Computer Picks
After the draft order is frozen, click AutoDraft on the menu bar at the top of the screen. The following options are
available:
select One player to have the DMB computer general manager (GM) choose a player for the first unmade
pick in the draft. If the next team in the draft order has a human GM, you will be asked if you are sure you
want the computer GM to make the selection.
select Until next team with human GM to have the computer GM make picks until the next team with a
human GM comes up in the draft order.
select Until end of a round to have the computer GM make picks until the end of a round. DMB displays a
small window so you can enter the round number. If you choose this option, the DMB computer will make
picks for each team, regardless of whether the team has a human or computer GM.
select Until draft has been completed to have the computer make all picks until the end of the draft. The
draft will end when the last pick has been made or the free agent pool has been emptied, whichever comes
first. If you choose this option, the DMB computer will make picks for each team, regardless of whether the
team has a human or computer GM.
WARNING! If you choose this option, there is no command that allows you to stop the draft once the computer
begins making picks.

How the computer GM chooses players
When evaluating the available free agents, the computer GM looks at the needs of the team to make sure that it
fills all of the roles (starting pitchers, relievers, players rated at each defensive position, and so on). And it looks at
the ability of each player to help the team win in ways that go beyond hitting and pitching to include things like
defense (range, error rates, throwing, holding runners), speed and bunting.
All hitters and pitchers are judged on a park- and league-neutral basis so the true ability of the player comes
through. This is appropriate because Diamond Mind Baseball makes these adjustments when you play the games,
and it doesn't make sense to ignore them when choosing talent in the first place.
If, for instance, a pitcher was effective despite facing the DH and/or playing in a hitters park in real life, he may well
be chosen higher in the draft than someone whose stats look better but who had a more favorable real-life
environment in which to do his work.
And you might see a slugging first baseman drop lower in the draft than you might expect. Why? Because first
basemen are expected to produce more offense than players at other positions, so it's harder to stand out. And
because some first basemen don't supply the other things -- defense, speed, bunting, the ability to play more than
one position -- that make a player more valuable to a team.
We believe we have come up with a pretty comprehensive way to evaluate the overall contribution that these
players make to a team, and for that reason, we think the computer GM will provide a worthy companion in your
drafts, whether you're trying to out-think it or whether you're asking for its help in choosing players for your team.
As with any system that attempts to emulate the process that human GMs go through in something as complex as
building a baseball team, there's more we can do in the future to make the computer GM even more sophisticated.

At present, it has no way to know which players are considered to be future stars despite mediocre-to-awful stats. It
relies only on the statistics and ratings in the database. Since most of our Season Disks are based on a single
season, that means the computer GM will consider only the player's performance in that season when making its
picks.
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Drafting and Manager Profiles
As each pick is made by the computer general manager, DMB also generates a new manager profile that includes
this player. That way, when you view the roster for this team (which you can do at any time during or after the
draft), the manager profile is already there to give you an idea of what role the computer has assigned to each
player on the roster.
Those of you who have played previous version of Diamond Mind Baseball know that the manager profile generator
was designed to match real-life playing time as closely as possible. This doesn't make as much sense for newlydrafted rosters, since you may draft a player who played more than one position with the idea of using him in a
different way than he was used in real life. The new manager profile generator looks at the talent on your roster,
considers a variety of ways those players can be combined, and chooses the arrangement that produces the best
chance to win.

Resuming a Draft
At any time during a draft, you can close the draft window without losing any information, then resume the draft
later.
To resume a draft, use the View>Organizer command to display the DMB Organizer window, click on the Draft
tab, then do one of the following:
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left-click on the draft you wish to resume, then click the Modify button
right-click on the draft you wish to resume, the select the Modify draft command from the popup menu
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double-click on the draft you wish to resume
The draft window will be displayed, with everything set up just the way it was when you closed the window.

Deleting a Draft
When you use the Organizer window to delete a draft, the only thing being deleted is DMB's record of the draft.
When a draft is deleted, you will not be able to generate a draft pick report for that draft.
But it's important to note that any players who were drafted remain on their team's rosters. So if you carry out a
draft, then change your mind and decide to draft all over again, it's not enough to use the Organizer to delete the
draft and create another one. You'll also need to use the Tools>Release all players command to put the drafted
players back into the free agent pool. Alternatively, you can release players through the Roster / manager profile
window if you wish to release only some of the drafted players.

Overview of Notes
The Notes tab in the DMB Organizer allows you to store and access any plain-text document. This is helpful for
storing league charters or bylaws, newsletters, or virtually any document relating to your DMB activities.
NOTE: The Notes feature does not allow you to create notes. It simply allows you to reference and view notes that you have
created in any word processing application that allows plain-text formatting. It is important to remember that documents you wish
to access through the Notes tab must be saved in plain-text (they must have the "txt" filename extension) and they must be
stored in your DMB folder.
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To add a note:
1. Click View on the DMB menu bar and select Organizer.
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2. Select the tab labeled Notes at the bottom of the screen.
3. Click the button labeled New at the top of the tab. The following screen will appear:

4. Enter a category for the note and a title. These will appear on the Notes tab.
5. Type in the file name of the document. Remember: The document must be in the currently active database, and
you must enter the full filename (ex: "leaguecharter.txt").
6. Click OK. The note will be added to the Notes tab.
If you select a note on the Notes tab and click Copy, the Note window will appear. You can now change the
category, title, or filename. However, if you enter a new filename, it must refer to a document in the database
folder.
If you select a note on the Notes tab and click View, DMB will launch the Notepad application (or whatever
application you have configured to read "txt" files) and allow you to view or edit the document.

Editing Transactions
DMB can maintain two separate sets of transactions. One is a set of real-life transactions that are automatically
applied when you're using the Real-life transactions feature. The second is a set of DMB transactions that have
been made in the course of your DMB season. The effect of editing these transactions is different in these two
cases.
If you add, modify or delete real-life transactions, you aren't causing any roster moves to be made immediately. But
these moves will be made when you next play the season with the real-life transactions feature turned on.
If you add, modify, or delete DMB transactions, you aren't causing any roster moves to be made, now or ever. All
you are doing is correcting (presumably) DMB's record of past transactions that will show up in the transactions
reports.
To edit transactions:
1. Click View on the DMB menu bar and select Transactions. The following window will appear:

2. You have the option to view all transactions for a specific team, a league, or all transactions in your database
using the first pull down menu. If you select team or league, the second pull down menu will allow you to select a
specific team or league.
NOTE: For modern seasons, there can be over 2000 transactions, or an average of about 70 per team. A list of 2000
transactions can be difficult to work with because the list is so long and you end up spending a lot of time scrolling up and down
that list. That's why we included the option to display the transactions for one team at a time.

3. The final pulldown list allows you to select the source of the transaction data. This can be from real-life (we
provide real-life transactions with some of our season disks) or from simulated transactions that you have
conducted with your data.
4. Click OK. A window will appear that lists any existing transactions for the data you have selected.
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Adding transactions
To add a transaction, click the New button at the top of the screen. This will open the following window:

The first pull down menu lists all of the transaction types you can enter. The second pulldown allows you to set the
Transaction date. The third pull down menu allows you to set at what time on the selected date the transaction
will occur. Enter an effective date only when you place a player on the disabled list on a retroactive basis.
The last three pull down menus on this screen allow you to select the team and the player affected by the
transaction and, if the transaction involves a trade, the team to which the player is to be traded.
Click OK to complete the transaction.

Copying and modifying transactions
These commands open the same window as is shown for Adding transactions above, but with the information from

the selected transaction already filled in.

Deleting transactions
Select one or more transactions from the list and click on the Delete button. See Selecting Multiple Items in a List
for instructions on how to select multiple transactions.

Editing Injury Reports
If you use the injury log window to add, modify and delete injury reports, you are NOT causing players to get hurt or
to recover from past injuries. But you can use these commands to edit the information that displays on the injury log
reports. In order to cause players to get hurt or to recover from past injuries, you need to modify a player's injury
and usage information.
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To edit injury reports:

1. Click View on the DMB menu bar and select Injuries. The following window will appear:
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2. Use the pull down at the top of the window to select all injuries in the database, all injuries for a particular
team, or all injuries for a particular league. If you select injuries for a particular team or league, the pull down
labeled "Selection" will enable you to select a team or league.
3. Click OK. The following screen will appear. A screen will appear that lists all of the injuries in the currently active
database.

Adding injury reports
To add an injury report, click the New button at the top of the screen. This will open the following window:

NOTE: The available pull downs on this window will vary depending on whether you are entering an injury at the database,
league, or team level.

To set the Injury date, enter it directly or click on the down-arrow to open a calendar allowing you to select a date.
If the team has not already been selected, choose one. Click on the Player pull down and select a player from that
team. Click on the Cause pull down and select the cause of the injury. Enter the number of days this player was

injured for.
Click OK when you are done.

Copying and modifying injury reports
These commands open the same window as is shown for Adding injury reports above, but with the information
from the selected transaction already filled in.
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Deleting injury reports
Select one or more injury reports from the list and click on the Delete button. See Selecting Multiple Items in a List
for instructions on how to select multiple injury reports.
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Overview of Rosters and Profiles
Choose View>Rosters / manager profiles to display the DMB roster window. Through this window, you can:
view a large amount of information about the players on the roster,
make roster moves (signing and releasing players, moving players on and off the disabled list, promoting and
demoting players)
create and modify the manager profile that guides the computer manager when it is managing this team
view the full statistics and ratings profile for players on this team
This window has seven pages of information, each of which allows you to modify different portions of the roster and
manager profile information:
the Roster page displays the names of every player on the roster and allows you to make roster moves that
change their roster status, including signing free agents and releasing players into free agency
the Pitching page displays statistics and ratings for all pitchers on the roster and includes the tools you need
to set up the starting rotation and relief roles in the manager profile
the Saved Lineups page displays statistics and ratings for all non-pitchers on the roster and includes the
tools you need to set up the saved lineups in the manager profile
the Depth Chart page displays statistics and ratings for all non-pitchers on the roster and includes the tools
you need to set up platoons, defensive replacements, and utility players in the manager profile
the Manager Tendencies page allows you to choose settings that influence how frequently the computer
manager uses various game tactics when managing this team
the Player Tendencies page allows you to choose settings that influence how frequently the computer
manager uses various game tactics for specific players
the Report page displays a printable report showing the entire manager profile for a team

What is a Manager Profile?
Manager profiles guide the computer manager whenever it is making the decisions for a team. If you plan to use
the computer manager, even if it's only when you Quick Play a few innings during a game, you must make sure
that each team has a reasonably complete manager profile. DMB does not make good decisions with an empty
or sparsely filled out manager profile.
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By entering instructions into the manager profile for a team, you can exert a lot of control over the use of players
and the tactics employed during a game.

The computer manager makes decisions based on the score, inning, number of outs, who is on base, the ability of
the pitcher and catcher, the ballpark, availability of bench players, and many other factors. The instructions you
provide are among the most
important factors
are considered.
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Consider a few examples:
Suppose, in real life, a certain pitcher was always used as the closer, but was ineffective. If your goal is to
emulate a real-life season, put the real-life closer first in your list of closers. If you want to see how the
season might have turned out with another pitcher in this role, put the other pitcher first in your list of closers.
The choice is yours.
Suppose, in real life, a speedy player was used as the leadoff hitter on your favorite team, but you prefer to
give up some speed and use a player with a higher on-base percentage in this spot. Your saved lineups are
used by the computer manager to determine the batting order versus left- and right-handed pitching.
Suppose, in real life, a team used the sacrifice bunt more frequently than any other team in the league. But
you believe in playing for the three-run homer. You can instruct the computer manager to bunt less often.
The manager profile contains instructions for five aspects of managing your team:
handling your pitching staff,
choosing starting lineups,
roles for bench players,
setting limits on playing time,
influencing how various tactics should be used during a game based on manager and player-specific
tendencies.
DMB manager profiles are easy to create and modify. All of the options are clearly displayed on the screen, and
simple menu commands and forms collect all the information you need.
And, if you prefer, you can choose to have DMB generate all or part of a manager profile. You can use a generated
profile as-is or as a starting point for some fine tuning of your own.
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Pitching Chart
The pitching chart includes your starting rotation, rules for how your starters are to be used, a list of other pitchers
who may start from time to time, and the assignment of relief pitchers to various roles.

Roles
You can assign up to five pitchers to each of the following roles:
Starting rotation. You identify the pitchers that make up your starting rotation and the order in which they
appear. You can use a rotation with three, four or five pitchers -- just leave spots empty if you don't want to
use five pitchers. You also indicate whether starting pitchers should be used in strict rotation, in rotation but
with the option to jump to the #1 starter if off-days make him available, or in proportion to the number of starts
made in real life.
Spot Starters. If you want a pitcher to make occasional starts, you can designate that player as a spot
starter. The list of spot starters parallels the list of pitchers in the starting rotation. If you want someone to
start 20% of the time in place of the number four starter, enter this player in the fourth spot in the spot starter
list, and enter 20 when you are prompted for the percentage.
Mopup situations. You can designate up to five pitchers for the mopup role. This role is used for the weaker
pitchers on the team. They will normally be used only when your team is winning or losing by a large margin
and the outcome of the game isn't really in doubt, though they may appear in close games if other pitchers
are not available due to injury or fatigue.
Long Relief. You can designate pitchers for the role of long relief. Long relievers are generally used when
the starting pitcher is replaced prior to the seventh inning, but will also be used in other game situations when
required, particularly when a team is losing by a large margin and wants to preserve its better pitchers for
future games.
Setup Men. There are two lists of setup men, one to face left-handed batters and one to face right-handed
batters. Setup men are generally used in the seventh inning or later in close games, but will also be used in
other situations when required.
Closers. There are two lists of closers, one to face left-handed batters and one to face right-handed batters.
Closers are generally used in the eighth or ninth inning when the team has a lead in a close game, but will
also be used in other situations when required.
In most game situations, the computer manager uses the first available pitcher in the appropriate list whenever a
reliever is called for (excluding players on the reserve roster). So it is important that you list your players in the
order you wish them to be considered, with your first choice at the top of the list.
However, there are other situations where another choice will be made. If the bullpen has been used heavily, the
computer manager may use the most rested pitcher. If either team has a big lead, it may choose to use a less
talented pitcher to make sure your top pitchers are rested for future games. If a game goes into extra innings,
everyone in the bullpen is a candidate to enter the game.
Enter a pitcher on more than one list if you want him to be considered for more than one role. For example, your
top setup man may also be your number two closer. However, there is no need to fill up all of the lists, since the

computer manager chooses from other lists if nobody in a particular role is available.

Usage Mode
The usage mode governs how starting pitchers are selected.
Select Time mode to have the computer manager do its best to make sure that every starting pitcher and reliever
gets exactly as many starts and relief appearances as they had in real life. This mode is appropriate for teams that
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have their real-life rostersVERSION
intact, and it should
be used
you are
playing a season with
newly-drafted
rosters.
NOTE: In Time mode, the computer manager ignores your rotation. Instead, it looks at how many starts each pitcher is limited to
in the playing time limits section of your profile (this is usually set to match his real-life starts) and spreads those starts evenly
over the season. The pitcher with the most real-life starts will be selected on opening day even if he is not listed in the #1 slot in
the rotation. The computer manager will choose starting pitchers who are not in the rotation if their games started limit is greater
than zero.
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Select Strict mode to have the computer manager use your pitchers in the order they appear in the starting
rotation. The computer manager will choose another starting pitcher only if a rotation starter is injured when his turn
comes up.
Select Skip to have the computer manager use your pitchers in the order they appear in the starting rotation but
skip to the #1 starter when one or more off-days have left him rested enough to start before his turn. The computer
manager will choose another starting pitcher only if a rotation starter is injured when his turn comes up.
The Strict option is usually best for DMB leagues that are using newly-drafted rosters.

Rotation Size
You can enter a number to tell the computer manager how big the starting rotation should be. Modern teams
almost always use a five-man rotation. Four-man rotations were common until the 1970s, and smaller rotations
were the norm a hundred years ago.
Although the saved starting rotation is ignored in the Usage mode of Time, it is still important to set your rotation
size in order to get the most out of your starting pitchers. If a pitcher made 40 starts, the rotation size must be set
no higher than 4 in order for him to reach his maximum number of starts. If you set the size at 5, he won't make
more than 33 starts in a 162-game season.
The rotation size is also used to enforce a Strict or Skip rotation.
Next Starter
When you are using either the Strict or Skip rotation mode, this value tells the computer manager which rotation
slot is due to start the next game. You can change this if you want to juggle your rotation during a season.
NOTE: When the computer manager selects a starting pitcher in Strict or Skip mode, it simply chooses the pitcher who is in the
Next starter slot. It doesn't look at who was used in recent games, so it's up to you to make sure that the Next starter value is set
appropriately if you are mixing human-managed games and computer-managed games for this team.

Saved Lineups
You may create up to six saved lineups in a team's manager profile. Each lineup is tagged with two indicators so
the computer manager knows when to use the lineup:
whether to use it against left- or right-handed pitchers
whether to use it in DH games or non-DH games
Whenever you play (or autoplay) a game with the computer manager handling this team, the computer manager
searches the list of six saved lineups and selects the first one that matches the opposing pitcher and DH rule for
that game.
If you plan to manage the team yourself, you can choose to load any of the six saved lineups at the beginning of
the game.
One way to use the additional saved lineups is in leagues. If you have a five game road series coming up, you can
define a saved lineup and depth chart for each game, and tell the home manager to use these five lineups in the
series. The home manager would set your team's manager for Starting lineups to Human (leaving all other
manager options set to Computer) and make all of the pregame lineup selections. The computer manager would
then makes in-game substitutions and tactical decisions. See Managers: Human or Computer for more details.
You select who plays each defensive position and the batting order. If necessary due to injuries, fatigue, or the
desire to give a spot starter his share of playing time, the computer manager adjusts the starting lineup and batting
order. When adjusting the batting order, the computer manager moves the newly-inserted players up or down in the
order based on their ability, but preserves your saved batting order as much as possible.

Depth charts
Each saved lineup goes hand-in-hand with its depth chart. The depth chart identifies the roles assigned to all
players who are not already in the starting lineup. Whenever you make a change to a saved lineup, it's a good idea
to see if the starter you just replaced should be assigned one or more roles in the accompanying depth chart.

Usage modes
Sometimes the computer manager chooses to use a spot starter in place of the players who is listed in the saved
lineup. See the depth chart topic for a description of these usage modes and how they affect the computer
manager's decisions about spot starts.
TIP: If you want the computer manager to use your saved lineups exactly as they are in the manager profile, make sure you
have chosen the Game by game usage mode and that none of the utility players in the accompanying depth charts have spot
start percentages greater than zero. With those settings, the computer manager will replace a starter only when he is injured.

Adjusting the batting order
Whenever the computer manager is unable to use the saved lineup as-is because of injuries or spot starts, it may
make adjustments to the batting order. Its main goal when making these adjustments is to preserve your saved
lineup as much as possible.

If, for example, your #7 hitter is out with an injury, the computer manager won't change the order of the top six
hitters in the lineup. If, however, your #3 hitter is hurt, and his replacement is a much weaker offensive player, the
computer manager will shift the replacement to a lower spot in the batting order and put another player in the #3
spot. This type of adjustment may also involve moving a couple of other players around.
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Depth Charts
A depth chart goes hand in hand with a saved lineup, and guides the computer manager in its use of players who
are not in the starting lineup. There are four roles that you can assign to a bench player in a depth chart:
Platoon Player. A platoon is a pair of players, one who bats left-handed and one who bats right-handed. The
manager starts the left-hander against right-handed pitchers and the right-hander against left-handed
pitchers. If the opposing team changes pitchers, the computer manager may substitute the platoon player to
get a favorable left-right matchup.
Defensive Replacement. If you specify a player in this role, the player will be inserted into a game in the late
innings of games in which the team has a narrow lead.
Utility Player. You can list up to five players as utility players at each defensive position. These players are
used when a starter is injured or removed for a pinch hitter or pinch runner during a game. If you want
someone to be used primarily as a bench player but make occasional starts, you can indicate the percentage
of games this player should start at this position.
Pinch Hitter. You can list up to five players as pinch hitters versus left- or right-handed pitchers.
See below for suggestions and guidelines that may help you decide how to set up your depth charts.

Defensive replacements
The computer manager currently makes defensive replacement decisions one position at a time. That means that
there's no point in trying to set up your profile to make a series of defensive shifts.
For example, you cannot tell the computer manager to insert a player as a defensive replacement in center, move
the starting center fielder to right, and remove the right fielder.

Pinch hitters
You don't have to fill the list in to make the computer manager use pinch hitters. If these lists are empty, DMB
chooses pinch hitters from all available players on the bench, including starters who are resting for the current
game.
However, if you choose to enter one or more players in these lists, DMB chooses only from among these players
when a pinch hitter is called for. If none of these players is available, the computer manager then looks to the full
bench to see if another hitter could be used.
The computer manager doesn't always choose the first player in the list as the first pinch hitter in the game.
Sometimes it will choose to keep the top player available for a better opportunity later in the game.

Pinch hitting and playing time limits
If your league is using the Limit bench playing time option, potential pinch hitters will be left on the bench if they
are ahead of their playing time pace for the season. This is true even if you're down by nine runs and the pitcher is
due up.

Sometimes all potential pinch hitters are ineligible for this reason and the computer manager will allow the pitcher
to bat for himself. It may seem strange to let a pitcher bat in these situations, but the computer manager has no
way to simultaneously accomplish the two things you've asked it to do -- make good game decisions and enforce
the playing time limits. Usually the solution is to turn off the Limit bench playing time option.
See Leagues: Rules and Options for more details on this setting.

Usage modes
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The offensive portion of your manager profile is assigned one of two usage modes. These modes apply only when
the computer manager is handling this team.
Choose Track starts if you wish to simulate an entire season and you want your players to match the playing time
indicated in the depth chart.
With this setting,
computer
manager
track of how often STANDARD
each player starts atBY
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each position versus left- and right-handed pitching in your DMB games. During the season, it uses this information
to adjust the starting lineups to keep everyone on a pace to accumulate the amount of playing time indicated in
your depth charts.
NOTE: If your goal is to match real-life playing time as closely as possible, we recommend that you choose None for your
league injury rule and Yes for the Limit Bench Playing Time option. See Leagues: Rules and Options for more details on
these settings.

Choose Game by game if you want to change the roles of your players during a season. With this setting, the
computer manager takes each game at a time and randomly chooses spot starters using the spot start
percentages in your depth chart.
Example. Suppose a player is listed in a utility role in a depth chart and has been assigned a spot start percentage
of 30. And suppose you have played the first half of the season and are ready to begin the second half. Using the
Track starts option, the computer manager would immediately start this player several games in a row because he
is far behind the pace necessary to reach the target of 30% starts. Using the Game by game option, the computer
manager would give this player a 30% chance to start each subsequent game.
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Playing time limits
You may choose to put limits on playing time for one or all of the players on your team. These limits are enforced
only when other league options and manager profile settings are set a certain way, and we'll point out those
dependencies below.
You can also put limits on the ability of the computer manager to remove certain players for pinch hitters. These
limits are not dependent on any other settings -- they always apply when the computer manager is handling a team.

Pitching limits
You can limit the number of games started and relief appearances each pitcher will make. These limits apply only if
you choose a usage mode of Time for the pitching portion of your manager profile.
In Time mode, the computer manager ignores your rotation. Instead, it looks at how many starts each pitcher is
limited to and spreads those starts evenly over the season. The pitcher with the most real-life starts will be selected
on opening day even if he is not listed in the #1 slot in the rotation. The computer manager will choose starting
pitchers who are not in the rotation if their games started limit is greater than zero.
After the starting pitcher has been selected, the computer manager will mark as ineligible any relief pitchers who
are on a pace to exceed their limit for relief appearances.

Atbat limits
For batters, you can indicate how many atbats they are allowed to get against left- and right-handed pitching.
These limits are enforced only if you play games using the Limit Bench Playing Time option, which is described in
the Leagues: Rules and Options topic.
When this option is in effect, DMB will not use players as substitutes if it would put them on a pace to exceed their
limits, unless injuries or ejections make it necessary to use the player.
These limits have no effect on starting lineups. DMB assumes that if you want to limit playing time with this
option, you will take care to ensure that these players are not put in any of the saved lineups and are not assigned
spot start percentages that would cause them to get too many starts.
The purpose of the playing time limits is to control the use of players with extremely good statistics that were
compiled in a limited number of real-life atbats.
A good example is a player who batted .350 in 25 atbats. Without these limits, DMB's computer manager would be
inclined to use him very frequently as a pinch-hitter or as a replacement during a game, and he might get 100
atbats in the DMB-league season. If this player is not used in either saved lineup, the Limit Bench Playing Time
option would limit his atbats to about 25 unless injuries forced him into more games.
You may want to set limits just for the players with extremely strong batting statistics. There are many other players
who played sparingly in real life because they were in injured, on the farm team, or because there were better
players ahead of them. These players are not likely to be overused by the computer manager, so you may want to
set very high limits for them so they are available whenever they are needed.

Manager Tendencies
There are twenty tactics for which you can influence how the computer manager makes its decisions:
seven govern offensive plays: bunting for a hit, sacrifice bunting, squeeze bunting, using the hit and run,
stealing, baserunning,
and taking pitches.
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four influence how frequently pinch hitters will be used in various situations: for a pitcher, for a non-pitcher,
for a platoon partner, and in the late innings of a blowout.
three affect defensive tactics: holding runners, guarding the lines, and bringing the infield in.
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and six help determine how the pitching staff is used: pitching around hitters, intentionally walking hitters,
pitching out, making pickoff throws, using relief pitchers, and using closers.
The values you can set for each tactic are Most Frequent, More Frequent, Neutral, Less Frequent, and Least
Frequent.

Playing the Percentages
For each of these tactics, Diamond Mind has studied play-by-play data to analyze the frequency with which they are
deployed by real-life managers. We have examined how those frequencies are affected by the inning, number of
outs, the score, baserunner locations, the ability of the players involved, and other factors.
When set to Neutral, the computer manager attempts to replicate these real life patterns by choosing, for example,
to bunt with only the best bunters in the most appropriate bunting situations and when the batter wouldn't do better
against this particular pitcher by swinging away. In other words, if you set everything to Neutral, the computer
manager plays the percentages.
Based on an analysis of thousands of real-life games, the computer manager knows the odds of winning a game in
any situation (such as when you're the away team and down by a run in the seventh), and it knows the probability
of scoring a certain number of runs in any situation. So it sometimes plays for a big inning, and sometimes it plays
for one run, whichever gives it the best chance to win. And it preserves the element of surprise, so you cannot
always predict what the computer manager will do in a particular situation.
If all of your manager tendencies are set to Neutral, a team with more good base-stealers will steal more often than
a team with fewer good base-stealers. A team with more good runners will take more extra bases on hits and flies
than a team with fewer good runners. This is equally true of real-life rosters and draft-league rosters. As a result,
the Neutral setting is the best choice for most teams, especially teams with which you are not too familiar.
The other settings are intended to override the computer manager's natural inclination to play the percentages. If
you want your team to sacrifice bunt less often, despite having many good bunters, set your Sacrifice bunting
tendency to Less Frequent or Least Frequent. If you want your team to try to pressure your opponent into making
throwing errors, set your Running tendency to More Frequent or Most Frequent. But be aware that being more
aggressive may mean taking more chances than the percentages would normally call for.

What the settings mean
Because there are too many variations in game situations and talent levels among different rosters, there are no

precise answers to the question, "What will the computer manager do if I choose this setting?" However, you may
want to consider the following when making your choices, then play some games using the computer manager to
see how it handles your team in different situations:
Bunting. As is the case with all tendencies, a player's bunt rating is still the most important factor in determining
how often the computer manager asks a player to bunt, but you can use the three bunting tendencies to increase
or decrease bunt attempts by the players on your team.
The squeeze bunt tendency is used whenever there's a runner on third with less than two outs. While it is true
that some real-life managers will use the sacrifice bunt with runners on first or third in order to move the runner
from first to second and holding the runner at third, the DMB computer manager does not use this tactic. It prefers
not to give up an out when it already has a runner in scoring position.
The bunt for hit tendency is used whenever there are two out, the bases are empty, and in a couple of other
situations where runners are on base but sacrificing makes little sense. For example, with a position player at the
plate, real-life managers rarely call for a sacrifice with one out and a single runner on either first or second, so DMB
uses the bunt for hit tendency in those situations. With nobody out, or a pitcher at the plate, it's a different story,
and DMB uses the sacrifice bunt tendency in those cases.
The sacrifice bunt tendency is used with nobody out and a runner on first, a runner on second, or runners on both
first and second. With one out, the sacrifice bunt tendency is used with a pitcher at the plate, but the bunt for hit
tendency is used when a position player is batting, because real-life position players rarely sacrifice with one out.
More often than not, they're bunting for a hit even with a runner on base.
Hit and run. When deciding whether to use the hit and run, the computer manager is looking primarily at the
batter's ability to make contact (and thereby protect the runner) and the likelihood that he'll hit into a double play if
he does. High strikeout rates discourage the use of the hit and run, while high rates of ground ball double plays
encourage the use of this tactic. The settings for this tactic nudge the computer manager in the direction you
choose by adjusting the contact-rate and GDP-rate thresholds it uses to make these decisions.
Stealing. When set to Neutral, the computer manager is reluctant to attempt steals with runners owning low Steal
ratings, since they will be thrown out too often. If you want to further restrict your steal attempts to those players
with the highest steal ratings, choose Less Frequent or Least Frequent. This will not stop your best stealers from
running, but will restrain other players.
Running. This tendency governs how many chances the computer manager will take on the base paths. When the
computer manager makes a running decision, it compares the chances of gaining the extra base safely to a
minimum threshold based on the game situation.
The chances of gaining the extra base are determined by the nature of the batted ball, whether the runner was
going on the pitch or on contact, the running rating of the runner, and the throwing rating of the outfielder.
The minimum threshold is based on the game situation and whether it makes more sense to play for one run (as in
the late innings of a close game) or a big inning. Depending on the number of outs and where the runners are
situated, the value of taking the extra base can be high or low, as can be the cost of getting thrown out. The
computer manager takes these factors into consideration when deciding how high the chances of success need to
be to justify taking the risk of getting thrown out.
The Running tendency controls the minimum threshold. If you choose "less frequent" or "least frequent", the
minimum threshold rises. That causes the computer manager to send the runner only when the chances of
success are higher. If you choose "more frequent" or "more frequent", the minimum threshold is lowered, and the
computer manager will take more chances.

NOTE: This tendency applies to singles, doubles and fly balls. It does not affect the decision to send the runner home from third
on a ground ball.

Taking pitches. This tendency enables you to increase or decrease the likelihood that your best hitters will have
the green light to swing with three balls and no strikes. It doesn't affect any other counts. And you don't need to
use this tendency to prevent your weaker hitters from swinging at 3-0 pitches because the computer manager
never gives them the green light.
Pinch hitting. In all game situations other than blowouts, the computer manager uses a pinch hitter only if he is

UNREGISTERED
VERSION
CHM
TO PDF
CONVERTER
STANDARD
rated to be better than the
scheduled hitterOF
against
the current
pitcher.
This assessment takes
into account the BY THE
handedness and the left/right splits of both the batter and the pitcher.
A "least frequent" setting tells the computer manager to pinch hit less often; that is, only when the pinch hitter is
much better than the scheduled hitter. A "most frequent" setting tells the computer manager to pinch hit more
aggressively; that is, even when the pinch hitter is only a little better than the scheduled hitter.
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Pinch hitting in blowouts is a different matter altogether. In these situations, the goal is not to gain an advantage,
it's to replace the team's better players to reduce their risk of injury. In blowouts, the computer manager generally
replaces a better player with a weaker one, so the relative strength of the players is not a concern. Instead, the
blowout pinch hitting tendency influences the computer manager decisions about (a) how big a lead is needed for
the game to be treated as a blowout and (b) how early in the game it will begin to remove players. In blowout
situations, the "In blowouts" tendency takes precedence over the other pinch hitting tendencies.
Holding runners. When set to Neutral, all runners but the worst are held. Choosing Most Frequent causes all
runners to be held. Choosing Least Frequent causes the first basemen to play behind runners with low Jump and
Steal ratings.
Guard the lines. This setting controls the inning in which the computer manager begins to think about guarding the
lines:

Tendency

Inning

Most frequent, more frequent

7th

Neutral

8th

Less frequent

9th

Least frequent

never

Infield in. This setting controls the inning in which the computer manager begins looking for opportunities to bring
the infield in:

Tendency

Inning

Most frequent

1st

More frequent

4th

Neutral

6th

Less frequent

7th

Least frequent

8th

This tendency does not affect the decision to bring the infield in at the corners, which can occur anytime during a
game to discourage a batter from bunting.
Pitching around and Intentional walk. The computer manager issues intentional walks with first base open and a
dangerous hitter at the plate if the on-deck hitter is much less of a threat. If the intentional walk tendency is set to
most frequent, the computer manager will issue a walk with a smaller difference in hitting ability between the next
two hitters. If it is set to least frequent, the computer manager will issue the walk only if the current hitter is even
more dangerous relative to the on-deck hitter.
If the next hitter is more dangerous than the on-deck hitter, but not to a large enough degree to convince the
computer manager to issue an intentional walk, the computer manager might instruct the pitcher to pitch around the
next hitter. The pitching around tendency is very similar to the intentional walk tendency in that it determines how
large the gap in hitting ability must be to justify the decision to pitch around a hitter.
Pickoff throws and pitchouts. Both of these tactics are used to slow down opposing base stealers. You may find
that the "most frequent" and "more frequent" tendencies are helpful, especially if your pitcher and catcher are not
especially good at shutting down the running game without a little extra help. Keep in mind, however, that pitchouts
can give the hitter an advantage in the ball-strike count and too many pickoff throws can lead to errors and/or wear
and tear on the pitcher's arm.
Using relievers, using closers. The decision to use a reliever is very complex. Each decision involves so many
factors -- including the inning, score, location of baserunners, quality of the current pitcher, quality of the potential
reliever, left/right matchups, fatigue, the makeup of the pitching portion of the manager profile, fatigue, and more -that it's not possible to lay out simple rules that tell you exactly how these tendencies will affect the computer
manager's decisions. The basic idea, however, is that they influence how quickly the computer manager will make
the move to bring in a reliever (in non-save situations) or the closer (in save situations) when the current pitcher
begins to get into trouble.

Player Tendencies
Reasonable limits
DMB is a strategy game that is designed to provide you with a real baseball experience. It's not like many video
games that give you so much control that you can easily play games and produce statistics that bear little or no
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It's not possible, for example, to set a tendency that tells a certain player to attempt a steal every time he reaches
first base with second base open. There isn't a player in history who has done that, and it's just not realistic to allow
that to happen in your DMB games. Similarly, it doesn't make sense to allow a runner with a Poor jump rating and a
Poor steal rating to attempt 50 steals a season.

THE
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It is possible, however, to set a player's Stealing tendency to Most Frequent. By doing so, you're telling the
computer manager to give that player the green light more often than it normally would for a player with his
ratings.
How much more often? It varies from tactic to tactic, but it's generally in the range of 20-40%. In other words, you
can't use player tendencies to double or triple the rate at which a player attempts to steal, take extra bases, bunt
for hits, and so on. Game situations and player ratings are still the most important factor in how the computer
manager makes decisions.
On the other hand, it's not all that unusual for a real-life player to go several seasons without trying to steal a base
or drop down a bunt. So it is possible to assign a Never tendency, and the computer manager will honor that
request.

Offensive tendencies
Most of these tendencies have the same meaning as in the context of manager tendencies, so we won't describe
them again here.
Bunting. As is the case with all tendencies, a player's bunt rating is still the most important factor in determining
how often the computer manager asks a player to bunt, but you can use the three bunting tendencies to increase,
decrease, or eliminate bunt attempts by this player.
Setting the Bunting for a hit tendency to Never only stops a batter from attempting a bunt in non-sacrifice and nonsqueeze situations. If Sacrifice and Squeeze bunting tendencies are not set to never as well, it is still possible for a
batter to get a bunt single if he beats one out in a sacrifice or squeeze bunt situation.
Similarly, if you set Sacrifice bunting to Never but do not do the same for Squeeze bunting, it is possible for a hitter
to sacrifice in squeeze situations. This is why the batter would compile sac hit statistics.
Hit and run. DMB players don't have a hit and run rating, but the computer manager does look at a player's skills to
determine how often he should be asked to execute a hit and run play. Strikeout-prone hitters are less likely to be
called upon, while contact hitters and slower runners (who are prone to grounding into double plays) are more likely
to participate in a hit and run play. You can use the hit and run tendency to increase, decrease, or eliminate the hit
and run play when this player is batting.
Stealing. As is the case with bunting, this tendency is quite straightforward. The computer manager will continue to
rely on the ratings of the players involved (jump and steal for the runner, hold for the pitcher, throwing for the

catcher) and the game situation to decide when a steal attempt makes sense. You can, however, use this tendency
to increase or decrease the attempt rate for a player, or eliminate steal attempts altogether.
Running. This tendency governs how many chances the computer manager will take on the base paths. When the
computer manager makes a running decision, it compares the chances of gaining the extra base safely to a
minimum threshold based on the game situation.
The chances of gaining the extra base are determined by the nature of the batted ball, whether the runner was
going on the pitch or on contact, the running rating of the runner, and the throwing rating of the outfielder.
The minimum threshold is based on the game situation and whether it makes more sense to play for one run (as in
the late innings of a close game) or a big inning. Depending on the number of outs and where the runners are
situated, the value of taking the extra base can be high or low, as can be the cost of getting thrown out. The
computer manager takes these factors into consideration when deciding how high the chances of success need to
be to justify taking the risk of getting thrown out.
The Running tendency controls the minimum threshold. If you choose "less frequent" or "least frequent", the
minimum threshold rises. That causes the computer manager to send the runner only when the chances of
success are higher. If you choose "more frequent" or "more frequent", the minimum threshold is lowered, and the
computer manager will take more chances with this runner.
Setting the Running tendency to Never means that the runner will always be held if there is any chance he could
be thrown out. Because taking an extra base is automatic for even the worst runners on some batted balls (e.g.
very deep flies), especially if the hit and run is on or the runner goes on contact with two out, players with a
Running tendency of Never will run from time to time. But you won't see them trying to advance when the outcome
is uncertain.
NOTE: The Running tendency does not apply to situations where a batter tries to stretch a single into a double or a double into a
triple. In those cases, the batter/runner makes his own decision and is not influenced by any manager or player tendency.

While it's true that you can dramatically reduce the number of outs your players make on the bases by assigning
the Never tendency, that doesn't necessarily mean it's good strategy. You may miss out on high percentage
opportunities to score a runner from third on a fly ball or from second on a single, and if the other hitters don't cash
those runs in, your team will leave more runners on base. You may also hit into more double plays if your runners
aren't taking advantage of running opportunities.
Taking pitches. This tendency enables you to increase or decrease the likelihood that your best hitters will have
the green light to swing with three balls and no strikes. It doesn't affect any other counts. And you don't need to
use this tendency to prevent your weaker hitters from swinging at 3-0 pitches because the computer manager
never gives the green light to weaker hitters.

Pinch hitting tendencies
There are four tendencies in the category of "Remove for pinch hitter" that govern how often this player should be
lifted in different situations:
the "Versus LHP" and "Versus RHP" tendencies enable you to indicate how seriously the computer
manager should consider using a pinch hitter in place of this player. Choose Never to tell the computer
manager not to pinch hit for this player (except perhaps in blowout situations).
NOTE: Player tendencies were introduced in version 9. In previous versions, different manager profile settings called "can
be PH for" enabled you to indicate that a player should never be replaced by a pinch hitter against left- or right-handed

pitchers. Those settings no longer exist, and when you convert a DMB database to version 9 format, they are assigned to
the "versus LHP" and "versus RHP" player tendencies instead.

the "In a platoon" tendency applies only if this player is in the starting lineup and a platoon partner is listed
in the depth chart at his position. To prevent a player from being removed for a platoon partner, choose
Never. (You can achieve this same effect more easily by removing the platoon player from the depth chart.)
the "In blowouts" tendency applies only in the late innings of a game in which one team has a very big lead.
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In all game situations other than blowouts, the computer manager uses a pinch hitter only if he is rated to be better
than the scheduled hitter against the current pitcher. This assessment takes into account the handedness and
the left/right splits of both the batter and the pitcher.
The player tendencies for pinch hitting indicate how much better the pinch hitter needs to be. A "least frequent"
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scheduled hitter. A "most frequent" setting tells the computer manager to pinch hit more aggressively; that is, even
when the pinch hitter is only a little better than the scheduled hitter.
Pinch hitting in blowouts is a different matter altogether. In these situations, the goal is not to gain an advantage,
it's to replace the team's better players to reduce their risk of injury. In blowouts, the computer manager generally
replaces a better player with a weaker one, so the relative strength of the players is not a concern. Instead, the
blowout pinch hitting tendency influences the computer manager decisions about (a) how big a lead is needed for
the game to be treated as a blowout and (b) how early in the game it will begin to remove players.
In blowout situations, the "In blowouts" tendency takes precedence over the other pinch hitting tendencies. If a
player's tendencies are set to Never for the three non-blowout situations, he can still be replaced by a pinch hitter
in a blowout.

Pitching tendencies
Most of these tendencies have the same meaning as in the context of manager tendencies, so we won't describe
them again here.
Using relievers, Using closers. These settings indicate how aggressively the computer manager should go to the
bullpen with this pitcher already in the game. They have no any impact on how often this pitcher is brought into
the game in the first place.
The Never setting for "Using relievers" and "Using closers" doesn't really mean never. It would be highly
unrealistic to ask a pitcher to stay in the game no matter how tired he gets or how hard he's being hit. The
computer manager always reserves the right to lift a tired or ineffective pitcher regardless of your tendencies,
though it will stick with an ineffective pitcher longer if you choose "less frequent", "least frequent", or "never".
Instead, a setting of Never tells the computer manager to keep this pitcher in the game until he gets tired, until he
loses effectiveness, or until the opposing team creates a meaningful threat, whichever comes first. With this
setting, the computer manager won't go to a setup man or closer just because that potential reliever is a better
pitcher.
TIP: If you want a closer to be used as often as possible, set the team's manager tendency for "Using closers" to "most
frequent". Or, if you want a little more control, set the "Using closers" tendency for some of the team's starting pitchers and
middle relievers to "most frequent".

Roster / manager profile window
To view a team's roster and use roster management tools, click View on the DMB menu bar and select Roster /
Manager profile . The following window will appear, allowing you to select the team whose roster you would like to
see:

Click on the team you wish to see and then click OK , or just double-click on the team you want. DMB displays the
roster window for this team:
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We'll talk about each of the pages (tabs) of this window in separate topics, but let's take a moment to go over the
elements of this window that appear no matter which tab has been selected.
Across the top of this window is a toolbar with a pulldown and several buttons:

The left-most controls allow you to cycle through the teams in your active database. Choose a new team from the
pull-down list of teams or click the left-arrow button to see the previous team in the list or the right-arrow button to
see the next team in the list. If you change teams this way, DMB will ask if you want to save any unsaved changes
you may have made to the manager profile for this team.
The buttons for the current and pre-season rosters apply only when the Roster tab is selected, so we'll discuss
them as part of that topic.
Click the Save MP button to save any changes you have made to the manager profile for this team. If you don't
save your changes as you go along, that's OK. DMB will ask you about saving those changes when you try to close
this window or switch to another team.
Click the Close button when you are finished working with rosters and manager profiles.

Roster management
See the Roster / manager profile window topic for general information on how to open this window and use the
toolbar buttons.

Team roster display
When the Roster tab is selected, the following page displays the players on this roster, using color-coding and
symbols to indicate the status of each player:

This page shows the names of all players on the roster. Left-handed batters and left-handed pitchers have an
asterisk (*) added to their names. Switch hitters have a pound sign (#) added to their names.
Active players are displayed in blue , players on the disabled list are shown in red , and players currently on the
farm team are shown in green . Players will be counted in the Other category and shown in black if you are using
real-life transactions and that player is released, waived, or traded away. In those cases he will appear with the
symbol (NOR) next to his name to indicate that he is not on the roster. If a player is injured but has not been placed
on the disabled list, the player remains in blue but has the symbol (INJ) appended to his name.

You can choose to list the players in any one of three sort sequences (we'll show you how to change this below).
The box in the lower-left corner provides a snapshot to help you decide whether you have the right number of
active batters and pitchers at the moment. Most leagues limit teams to 25 active players until September 1.
The box in the lower-right corner tells you which park this team is currently assigned to and provides some park
factors so you know how the park will affect the performance (and therefore the statistics) of players who play in
that park.
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life transactions feature and you are using a database that contains a complete set of real-life transactions. (For a
complete listing of season disks that include real-life transactions, see the Diamond Mind web site.)
When the real-life transactions system is in use, the season begins with a certain number of players (usually 25
plus whomever begins the year on the disabled list) on the active roster. As you move through the season, DMB
automatically adjusts the active roster to reflect the real-life transactions. When your season is finished, you may
want to use the Restart command to get ready to play the season again. When the real-life transactions mode is in
effect, the Restart command resets the active roster to include those who were active on opening day.

When you select the Current button on the toolbar, all subsequent roster commands affect the current roster
status of the players involved. When you select the Pre-season button, subsequent roster commands affect the
pre-season status of the players involved. In other words, those status codes will take effect when you next run the
Restart command to get ready to play the season again.
When you are setting up for a season, we recommend that you select the Current button so your roster moves will
take effect immediately. When you are finished activating the players you want for opening day, use the Copy
status codes command (described below) to save these codes as the pre-season status codes.

Roster management tools
Most roster management tools are accessed via a popup menu that displays when you right-click on the name of a
player:

Signing a player
To add a player to this roster from the free agent pool, choose the Sign command from the popup menu. DMB
displays a window listing all of the available free agents by name:

Each player is listed with his full name, primary position, batting and throwing hand, and the season on which his
ratings are based. To sign a player left-click on his name and click on the OK button. If the Make player active box
is checked, this player is placed on the team's active roster; if unchecked, the player goes onto the reserve roster.

Releasing a player
To release a player into free agency, right-click on that player's name, then select the Release command from the
popup menu. Before releasing a player, DMB asks whether you are sure you want to do this.

Promoting a player
To promote a player to the active roster, right-click on that player's name, then select the Promote command from
the popup menu.

Farming a player
To demote a player to the reserve roster (sending him to the farm in baseball parlance), right-click on that player's
name, then select the Farm command from the popup menu.

Placing a player on the disabled list
To place an injured (he MUST be injured) player on the disabled list, right-click on that player's name, then select

the Disable command from the popup menu. DMB displays the following window:
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of the last game played by the injured player. It is often the same as the transaction date (listed as "Injury date" in
the above image) but can be earlier if the team waited more than one day before changing the roster.
If the player's return date wasn't already at least 15 days later than the effective date, DMB changes the return date
to ensure that the player remains on the disabled list for at least 15 days.

Activating a player from the disabled list
To activate a player from the disabled list, right-click on that player's name, then select the Activate command from
the popup menu. DMB will not allow you to activate a player who is still injured or has not spent a minimum of
fifteen days on the disabled list.

Changing the sort order
To change the order in which the players are sorted, right-click anywhere on the roster box and select the Arrange
command from the popup menu.
choose Alphabetically to list the players in strict alphabetical order, with batters and pitchers in one group
choose By role to list the players in alphabetical order within role, with batters listed first and pitchers second
choose By primary position to list the players in alphabetical order within position

Copying status codes
These commands are useful only if you are using DMBs real-life transactions feature and you are using a database
that contains a complete set of real-life transactions. See the Pre-season and current roster status codes
section above for some important background information on these status codes.
Use the Copy status codes>from current to pre-season to save the current status codes as your pre-season
codes that will be restored the next time you run the Restart command (assuming the real-life transactions feature
is enabled).
WARNING! Do not modify the pre-season status codes if you are using a DMB season disk that already comes with real-life
transactions and lineups in the product. Only modify them if you are entering the real-life transactions yourself.

Use the Copy status codes>from pre-season to current to restore the pre-season status codes.

Viewing a player profile
You can view a player profile by double-clicking on the name of any player or by right-clicking on a name and
choosing the Player profile command from the popup menu.

Pitching chart page
See the Roster / manager profile window topic for general information on how to open this window and use the
toolbar buttons.
See the Pitching Chart topic for descriptions of the roles and options that you can set on this page.
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The pitching chart page includes a list of all of the pitchers on this roster, with tabs at the bottom for browsing
several sheets of statistics, ratings, and status information. Various buttons and popup menus give you access to
commands for viewing the pitchers assigned to different roles, adjusting the list of pitchers assigned to a certain
role, and asking the computer to generate all or part of a manager profile. Here's what it looks like:
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Window Layout
The largest portion of the window is used to display the players on a roster. Pitchers who are in the starting rotation
are shown in red.
Because you may need access to a lot of information during this process, there are five tabs at the bottom of the
window that you can select from. Click on a tab to display a different set of stats, ratings or status information for
the players.

Double-click on the name of any player to display (in a separate window) a complete player profile that includes
most of his ratings, statistics, and fatigue/usage information.
Click on the Show batters button (above the player list) to toggle between showing the team's batters and pitchers
in the player list. When the Show reserves button is checked, all players are included in the list; when it is not
checked, the list includes only the players on the active roster.
To the right of the player list is a box (see below) showing the pitchers who are assigned to one of the roles in the
pitching chart portion of the manager profile. The pull-down list above the box enables you to display the pitchers in
a different role. The arrows to either side of the pull-down list allow you to cycle through these roles either forward
or backward.

See the Pitching Chart topic for descriptions of the roles and options that you can set on this page.

Changing a Pitching Chart
Using the Roster popup menu
In the pitching roster on the left part of the screen, right-click on the name of any player to display a popup menu of
commands:

Choose Insert player to add the selected player to the first empty slot in the role list that is displayed to the right.
Choose Show player profile to display the full profile for the selected player.
Choose View player settings to set playing time limits and other options for this player. DMB displays the following
window:
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You can use this window to put limits on the number of games pitched (as a starter in relief) when you are using
the Time mode for this pitching chart. If the usage mode for this pitching chart is Strict or Skip, these limits do not
apply.
The Atbat limit values do not apply to pitchers, so we will discuss them in another topic.

Using the Role List popup menu
In the role list at the right of the window, right-click on any entry in the list to display a popup menu of commands:

Choose Insert selected player to place the "selected" pitcher into this position in the role list. This command works
only if you previously left-clicked on a pitcher in the roster portion of the window to "select" him as the one to be
inserted.
Choose Remove this player to create an empty slot in the role list.
Choose Move to move the selected pitcher to another slot in the role list, shifting the pitchers in between by one
slot to make room.
Choose Exchange to exchange slots with another pitcher, leaving the pitchers in between where they are.
Choose Player profile to display the full profile for the selected player.

Inserting a Pitcher using Drag-and-Drop
To insert a pitcher using drag-and-drop:
1. Left-click once on the name of the pitcher in the roster list, then release the mouse button.

2. Position the mouse near the top or bottom edge of the pitcher's name. When the cursor changes from the
normal arrow cursor to the special drag-and-drop arrow (see image below), left-click again, hold your mouse button
down, and drag the pitcher over to the role list on the right side of the screen.

3. Release the mouse button over the slot you wish to insert this pitcher into. If that slot is already filled, the
selected pitcher replaces the one who was previously listed there.

Changing spot start percentages
Click on the spot start percentage column for any spot starter to display a small window in which you can enter a
new value for the player's spot start percentage:

Pitching Chart Options
There are three pitching chart options in the lower-right portion of the pitching chart window. See the Pitching Chart
topic for descriptions of these options and comments on how the computer manager is affected by your selections.

Other actions
Click on the Other actions button to display a popup menu with additional commands that apply to the entire
pitching chart or the entire manager profile.
Choose Erase entire pitching chart to empty all of the roles and set the options to default values.
Choose Generate manager profile to ask the computer manager to erase the entire manager profile (including
saved lineups and depth charts) and replace it with a newly-generated one. See the Manager profile generator
topic for details.
Choose Generate pitching chart to ask the computer manager to select a starting rotation and assign the other
pitchers to relief roles. DMB displays the following window:
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Here's how your selections affect the computer manager's choices:

Set the Method to Match real-life playing time to set the pitching chart up in Time mode. This is a good
choice for teams that are using real-life rosters.
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Set the Method to Use player ratings to have the computer manager look at the ratings and statistics of the
players when assigning pitchers to roles. You should always use this method for teams that have newlydrafted rosters.
Set the rotation size to whatever value you prefer. We recommend that you always use 5 for modern
seasons, since few of today's pitchers are durable enough to perform in a four-man rotation.

Saved lineups page
See the Roster / manager profile window topic for general information on how to open this window and use the
toolbar buttons.
See the Saved Lineups topic for a description of the role that saved lineups play in computer-managed games.
The saved lineups page includes a list of all of the non-pitchers on this roster, with tabs at the bottom for browsing
several sheets of statistics, ratings, and status information. Various buttons and popup menus give you access to
commands for viewing the different saved lineups in the manager profile and asking the computer to generate all or
part of a manager profile. Here's what it looks like:

Window Layout
The largest portion of the window is used to display the players on a roster. Players who are in the starting lineup
are shown in red.
Because you may need access to a lot of information during this process, there are five tabs at the bottom of the
window that you can select from. Click on a tab to display a different set of stats, ratings or status information for

the players.
Double-click on the name of any player to display (in a separate window) a complete player profile that includes
most of his ratings, statistics, and fatigue/usage information.
Click on the Show pitchers button (above the player list) to toggle between showing the team's batters and
pitchers in the player list. When the Show reserves button is checked, all players are included in the list; when it is
not checked, the list includes only the players on the active roster.
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To the right of the Show reserves
button isOF
a pulldown
that allows
to switch among the STANDARD
(up to) six saved
lineups that can be stored in a manager profile. The arrows to either side of the pull-down list allow you to cycle
through these lineups either forward or backward.
The upper-right corner shows the name of the current saved lineup (type in this box to change it), the lineup, and a
defensive position grid that shows which positions are currently unfilled (unfilled positions are in red).

UNREGISTERED VERSION OF CHM TO PDF CONVERTER STANDARD BY THE

Below the defensive position grid are other controls that enable you to indicate whether this saved lineup should be
used against left- or right-handed pitchers and whether it should be used in games where designated hitter (DH) is
used or is not in use.
NOTE : As in the image above, the name and makeup of the lineup may indicate that it is to be used versus LHP when there is
no DH. But the computer manager will only use this lineup in that situation if you correctly set Versus to Left and leave the Use in
DH games box unchecked.

Changing a Saved Lineup
Using the Roster popup menu
In the roster in the left part of the screen, right-click on the name of any player to display a popup menu of
commands:
Choose Show player profile to display the full profile for the selected player.
Choose View player settings to set playing time limits and other options for this player. DMB displays the following
window:

You can use this window to put limits on the number of atbats this player will get when you have the Limit Bench
Playing Time option turned on for this league. See Leagues: Rules and Options for more details on this options.
See Playing time limits for much more on how these settings are used by the computer manager.

Using the Lineup popup menu
In the lineup box at the right of the window, right-click on any lineup slot to display a popup menu of commands:

Choose Insert player to place the "selected" player into this lineup position at the defensive position you choose
from the pull-right menu. This command works only if you previously left-clicked on a player in the roster portion of
the window to "select" him as the one to be inserted.
Choose New defensive pos to assign this player to a new defensive position that you choose from the pull-right
menu.
Choose Remove player to create an empty slot in the lineup.
Choose Move to move the selected player to another lineup slot, shifting the players in between by one slot to
make room.
Choose Exchange to exchange slots with another player in the lineup, leaving the players in between where they
are.

Inserting a Player using Drag-and-Drop
To insert a player using drag-and-drop:
1. Left-click once on the name of the player in the roster list, then release the mouse button.
2. Position the mouse near the top or bottom edge of the player's name. When the cursor changes from the normal
arrow cursor to the special drag-and-drop arrow (see image below), left-click again, hold your mouse button down,

and drag the player over to the lineup on the right side of the screen.

3. Release the mouse button over the slot you wish to insert this player into, then select a defensive position from
the popup menu that appears. If that lineup slot is already filled, the selected player replaces the one who was
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Other actions

Click on the Other actions button to display a popup menu with additional commands that apply to saved lineups
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and/or depth chart or theVERSION
entire manager profile.
Choose Erase saved lineup and/or depth chart to empty this saved lineup and its associated depth chart.
Choose Copy saved lineup and depth chart to copy this saved lineup and its associated depth chart into another
one of the six manager profile slots for saved lineups. If, for example, you already have saved lineups for non-DH
games and you want to create saved lineups for DH games, you can use this command to copy your non-DH
lineups and then make any changes from there.
Choose Generate manager profile to ask the computer manager to erase the entire manager profile (including
saved lineups and depth charts) and replace it with a newly-generated one. See the Manager profile generator
topic for details.
Choose Generate saved lineup and/or depth chart to ask the computer manager to select a starting lineup and
associated depth chart, replacing the currently displayed lineup.
NOTE : Platoons will not be generated when generating a single depth chart (vs LHP, for example). You must generate the
entire manager profile for a team in order to have the computer setup platoons.

DMB displays the following window:

Here's how your selections affect the computer manager's choices:
Set the Method to Match real-life playing time to choose a lineup featuring the players who started the
most games at each position in real life. This is a good choice for teams that are using real-life rosters.
Set the Method to Use player ratings to have the computer manager look at the ratings and statistics of the
players when choosing the starters. You should always use this method for teams that have newly-drafted

rosters.
Check the Keep the saved lineup box if you want to preserve this lineup but regenerate the platoon roles,
defensive replacements and utility roles that go with this lineup.

Depth charts page
See the Roster / manager profile window topic for general information on how to open this window and use the
toolbar buttons.
See the Depth charts topic for a description of the role that saved lineups play in computer-managed games.
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The depth charts page includes a list of all of the non-pitchers on this roster, with tabs at the bottom for browsing
several sheets of statistics, ratings, and status information. Various buttons and popup menus give you access to
commands for viewing the different depth charts in the manager profile and asking the computer to generate all or
part of a manager profile. Here's what it looks like:
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Window Layout
The largest portion of the window is used to display the players on a roster. Players who are in the starting lineup
are shown in red.
Because you may need access to a lot of information during this process, there are five tabs at the bottom of the
window that you can select from. Click on a tab to display a different set of stats, ratings or status information for

the players.
Double-click on the name of any player to display (in a separate window) a complete player profile that includes
most of his ratings, statistics, and fatigue/usage information.
Click on the Show pitchers button (above the player list) to toggle between showing the team's batters and
pitchers in the player list. When the Show reserves button is checked, all players are included in the list; when it is
not checked, the list includes only the players on the active roster.
To the right of the Show reserves button is a pulldown list that allows you to switch among the (up to) six depth
charts that can be stored in a manager profile. The arrows to either side of the pull-down list allow you to cycle
through these depth charts either forward or backward.
In the upper-right corner is a pulldown list from which you can select a different defensive position. The arrows to
either side of the pulldown list allow you to cycle through these positions either forward or backward.
Below the position name is the list of players currently assigned to roles at that position. From top to bottom, these
roles are starter (from the associated saved lineup), platoon player, defensive replacement, and up to five utility
players with their spot start percentages.

Changing a Depth Chart
Using the Roster popup menu
In the roster on the left part of the screen, right-click on the name of any player to display a popup menu of
commands:

Choose Insert as platoon player to put the selected player into the depth chart as the platoon player at the current
position. If a player is already in that role, he is replaced.

Choose Insert as defensive sub to put the selected player into the depth chart as the defensive replacement at
the current position. If a player is already in that role, he is replaced.
Choose Insert as utility player to put the selected player into the depth chart in the first empty utility player slot at
the current position. You cannot use this command if all of the utility slots are filled.
Choose Show player profile to display the full profile for the selected player.
Choose View player settings to set playing time limits and other options for this player. DMB displays the following
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window:
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You can use this window to put limits on the number of atbats this player will get when you have the Limit Bench
Playing Time option turned on for this league. See Leagues: Rules and Options for more details on this options.
You can also use this window to indicate whether or not the computer manager has permission to pinch hit for this
player. See Playing time limits for much more on how these settings are used by the computer manager.

Using the Position List popup menu
In the box at the right of the window, right-click on any slot to display a popup menu of commands:

Choose Insert selected player to place the "selected" player into this slot. This command works only if you
previously left-clicked on a player in the roster portion of the window to "select" him as the one to be inserted.
Choose Remove this player to create an empty slot.
Choose Move to move the selected utility player to another utility slot, shifting the players in between by one slot to
make room. You can only move players within the utility roles.
Choose Exchange to exchange slots with another utility slot, leaving the players in between where they are. You
can only move players within the utility roles.

Inserting a Player using Drag-and-Drop
To insert a player using drag-and-drop:
1. Left-click once on the name of the player in the roster list, then release the mouse button.
2. Position the mouse near the top or bottom edge of the player's name. When the cursor changes from the normal
arrow cursor to the special drag-and-drop arrow (see image below), left-click again, hold your mouse button down,
and drag the player over to the position box on the right side of the screen.

3. Release the mouse button over the slot you wish to insert this player into. If that slot is already filled, the selected
player replaces the one who was previously listed there.

Changing spot start percentages
Click on the spot start percentage column for any utility player to display a small window in which you can enter a
new value for the player's spot start percentage:

Changing the usage mode
Below the defensive position grid is another control that allows you to select the usage mode for the offensive
portion of the manager profile. The same mode is used for all saved lineups and depth charts in the manager
profile.
See the Depth charts topic for details on how the mode affects the computer manager's decisions.

Other actions
Click on the Other actions button to display a popup menu with additional commands that apply to the entire
pitching chart or the entire manager profile.
Choose Erase saved lineup and/or depth chart to empty this saved lineup and its associated depth chart.
Choose Copy saved lineup and depth chart to copy this saved lineup and its associated depth chart into another
one of the six manager profile slots for saved lineups. If, for example, you already have saved lineups for non-DH
games and you want to create saved lineups for DH games, you can use this command to copy your non-DH
lineups and then make any changes from there.

Choose Generate manager profile to ask the computer manager to erase the entire manager profile (including
saved lineups and depth charts) and replace it with a newly-generated one. See the Manager profile generator
topic for details.
Choose Generate saved lineup and/or depth chart to ask the computer manager to select a starting lineup and
associated depth chart, replacing the currently displayed lineup. DMB displays the following window:
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Here's how your selections affect the computer manager's choices:
Set the Method to Match real-life playing time to choose a lineup featuring the players who started the
most games at each position in real life. This is a good choice for teams that are using real-life rosters.
Set the Method to Use player ratings to have the computer manager look at the ratings and statistics of the
players when choosing the starters. You should always use this method for teams that have newly-drafted
rosters.
Check the Keep the saved lineup box if you want to preserve this lineup but regenerate the platoon roles,
defensive replacements and utility roles that go with this lineup.

Manager tendencies page
See the Roster / manager profile window topic for general information on how to open this window and use the
toolbar buttons.
See the Manager Tendencies topic for comments on how the computer manager is influenced by the settings on
this page.
The Manager tendencies page allows you to set how frequently a manager is likely to make a particular call in
various defensive, offensive, and pitching situations. The page looks like this:

The sliders on this screen have 5 settings that allow you to set manager tendencies in the situations described.
The settings range from Most frequent to to Neutral to Least Frequent.
To adjust any of these settings, either click and drag the slider to its new location, or click on either side of the
slider to move it one notch in that direction.
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Player tendencies page
See the Roster / manager profile window topic for general information on how to open this window and use the
toolbar buttons.
See the Player Tendencies topic for comments on how the computer manager is influenced by the settings on this
page.

Overview
The DMB computer manager automatically adapts to game situations and the ratings and stats of the players
involved in those situations. For example:
when faced with a baserunning situation, it attempts to take the extra base more often with a better
baserunner and less often against an outfielder with a good arm
it is more likely to let a starting pitcher work out of a jam if he's a very good pitcher and/or the potential relief
pitchers aren't very good
it will use one-run strategies such as the bunt and the hit and run much more often in close games than in
blowouts
As a result, it is not necessary to use manager tendencies or player-specific tendencies to get the computer
manager to handle players in a way that makes good baseball sense.
To put this another way, if you create a full set of tendencies for every player on a roster, simply to get them
to act in a way that is already indicated by their stats and ratings, you're doing a lot of unnecessary work.
Sometimes, however, you may wish to override the computer manager's desire to play the percentages. By setting
manager tendencies , you can influence how often the computer manager uses certain tactics for all players on a
team. And by setting player-specific tendencies , you can influence how often the computer manager uses
certain tactics when that player is involved.

Player tendencies are optional
Because the DMB computer manager can produce very accurate results simply by consulting player ratings,
manager and player tendencies are optional. If there's an opportunity to take an extra base involving a player with
no Running tendency, the computer manager uses the manager tendency for Running instead. If that manager
tendency is Neutral, the decision is made solely on the basis of the player's Running rating.

Changing player tendencies
The player tendencies window enables you to change the tendencies for any player on a roster:
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To add, remove or change tendencies for a player, start by selecting that player using the drop-down list at the top
of this window. DMB displays the current set of tendencies for that player. If no tendency is assigned for a
particular aspect of the game, the box is unchecked and the slider does not appear. As noted in the above window,
if a box is unchecked, there is no tendency of that type for the player, and the computer manager uses the
corresponding manager tendency instead.
The sliders on this screen have 6 settings that allow you to set player tendencies in the situations described. The
settings range from Most frequent to to Neutral to Least Frequent to Never.
To assign a tendency, check the box to make the slider appear, then click on the slider bar or drag the slider until
you're happy with the setting. To change a tendency, click on the slider bar or drag the slider. To delete a tendency,
uncheck the box.

Manager Profile Report
See the Roster / manager profile window topic for general information on how to open this window and use the
toolbar buttons.
See the What is a Manager Profile? topic for descriptions of the roles and options that you can set on this page.
The MP Report page allows you to view and/or print all of the information in a manager profile. It looks like this:

To print this report, choose File>Print from the main DMB menu.

Manager profile generator
There are two ways to generate a manager profile for a team:
choose the Generate manager profiles command from the Tools menu
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choose the Generate manager profile command using the Other actions button on any of the pages of the
Roster / manager profile window
Manager profiles are also generated automatically when you use the DMB drafting system to add players to a
team.
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When you choose to generate all or part of a manager profile using either of the two methods shown above, DMB
displays a window with the following options:

Here's how your choice of a method affects the computer manager's choices:
select Match real-life playing time to choose a pitching rotation and saved lineups featuring the players who
started the most games at each position in real life. This is a good choice for teams that are using real-life
rosters.
select Use player ratings to have the computer manager look at the ratings and statistics of the players
when choosing the rotation and saved lineups. You should always use this method for teams that have

newly-drafted rosters.
In the Pitching chart box:
check the Generate box to produce a new pitching chart for this team. If this box is not checked, the current
pitching chart will be left as is.
Set the rotation size to whatever value you prefer. We recommend that you always use 5 for modern
seasons, since few of today's pitchers are durable enough to perform in a four-man rotation.
In the Saved lineups and depth charts box:
Check the Keep existing saved lineups box if you want to preserve the existing saved lineups and generate
only the depth charts that go with them. Leave this box unchecked to generate new saved lineups and depth
charts.
Check Include DH versions to generate saved lineups and depth charts that include the designated hitter.
Check Include non-DH versions to generate saved lineups and depth charts that do not include the
designated hitter. If you leave both the DH and non-DH boxes unchecked, no saved lineups or depth charts
will be generated.
Check the Generate manager tendencies box to set all tendencies back to their default (Neutral) settings.
Check the Generate playing time limits box to set all playing time limits to match each player's real-life playing
time and to allow the computer manager to pinch hit for all players.
Check the Reset player tendencies box to eliminate the use of player-specific tendencies, and therefore default to
using the manager tendencies for all players on a roster.

Batting order generator
After the computer manager has selected the starters at each position (using either the real-life playing time or
ratings method to choose them), it must then assemble those players into a batting order.
DMB chooses a batting order by looking at two aspects of each player's ability to:
get on base and get himself into scoring position (measured by on-base percentage, extra-base hits, and
speed),
drive in runners (measured by slugging percentage, but also including the ability to avoid hitting into double
plays).
The best overall hitters make up the top and middle of the order. Among these players, those who contribute more
by getting on base get the top spots, and the ones who are stronger at driving in runs get the middle spots.
These lineups are often different from the ones used in real-life. Why? Because the real-life manager had to make
out his lineups ahead of time, and the computer manager has the luxury of seeing how every player performed over
the course of the season. And because the computer manager values on-base percentage more highly than speed
when choosing players for the top of the order. These lineups may be different, we're confident that they will

produce as many or more runs than their real-life counterparts.

Roster status
Players can be placed in the starting lineups only if they are active. Players on the reserve roster can be placed in
relief and utility roles.
We allow reserve players to fill relief and utility roles because it saves time when you activate these players during
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the season. If reserve players
were not allowed,
they would
deleted CONVERTER
every time you demoted
a player to the
reserve roster. So you would have to add them back to the manager profile every time they were promoted.
Because many reserve players play several positions, it can take some time to add a player to each of those
positions, and to do it for each of your depth charts.
There is no harm in leaving these players in the profile. If a reserve player appears anywhere in a manager profile,
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the computer manager knows
that he is not
active
for theTO
game,
and that
player will not be used.

Playing Games: Overview
There are two basic types of games that you can play with DMB.
Exhibition games are just for fun. You can choose any two teams, any era, and any ballpark from any of the DMB
databases you have installed. You can choose whatever rules and options you like. After the game, you can print a
boxscore, play-by-play scoresheet, and game log.
Scheduled league games are fun, too, but there's more structure. The teams are determined by the league
schedule, the era is the one assigned to the league, and all games are played in the home team's park. The rules
and options are governed by the league settings. Players can get hurt (if you have injuries turned on) and players
will get tired, so you cannot use the same pitchers every day. DMB compiles a full set of statistics and other
information from these games, allowing you to generate a wide variety of reports.
The process of playing interactive games is basically the same. In each case, you choose some options before the
game starts, you (or the computer manager) choose starting lineups, and then you play the game.
If you are playing scheduled league games, you can also autoplay all or any part of a season.
You can play both exhibition and scheduled league games using DMB's NetPlay feature.

Exhibition Game Options
When you play an exhibition game in DMB, you can customize virtually all of the features of the game including the
teams, where they play, the weather, boxscore format, and much more.
To play an exhibition game, select Game then Exhibition . The following window appears:
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Exhibition Game Options
Exhibition games can involve teams, parks, and eras from any DMB database. The pulldown lists under the
heading "Database" allow you to select a different database for each of these items. The pull down lists under the
heading "Selection" allow you to pick specific teams to play against one another, specific parks, and specific eras
of play. When you select the home team, DMB automatically selects that team's home park.
The bottom portion of this window shows a number of options that you can choose when playing a game.
Using the Display pulldown list:

choose Show all pitches to have DMB show the play-by-play commentary for every pitch and to give
yourself a chance to change tactics after every pitch
choose Show all plays to show the play-by-play commentary only when the ball is put in play, runners
advance or are put out, and other important events.
choose Show nothing to allow you to Quick Play until the end of an inning or the end of the game.
Using the Stop after pulldown list:
choose Each play to see the results of each play or pitch.
choose some other stopping point for two game play options:
1. If your Display option is set to Show all pitches or Show all plays , click the Go button on the
game screen to see play-by-play commentary without interruption for all plays up to the selected
stopping point.
2. If your Display option is set to Show nothing , the game will Quick Play to that point before giving
you a chance to interact with the game. (This option does not apply if you have your Managers set to
Human for choosing the starting lineups.)
Using the Boxscore pulldown list, choose the format you'd like the on-screen boxscores displayed in.
Using the Month pulldown list, choose a month for the purposes of generating the weather report for the game.
This option applies only if you check the Use weather system box.
Check the Use designated hitter box to allow these teams to use designated hitters in this game.
Check the Use bullpen warmup rule to force human managers to start warming up their relief pitchers before
bringing them into the game. See Bullpen Warmup Rule for details.
Check the Use weather system box to generate a weather report for this game and to have the game affected by
the temperature, wind, and rain. If this box is checked, you can also check the Show weather report before game
box to display that weather report before you choose starting lineups. Otherwise, you can still access the weather
report from the game window later.
Check the Use clutch/jam ratings box to use those ratings in this game. See Clutch and Jam Ratings for details.
The Play by play settings box allows you to set the speed of the play-by-play commentary by using the Delay
between messages slider to choose a comfortable speed. You can also control the amount of time it takes to
switch from the play-by-play window and the tactics buttons by using the Delay at end of play slider. Click on the
Play by play font button to change the look of the play-by-play messages. If you want to keep the play descriptions
as simple as possible, uncheck the Show color commentary box. Otherwise, leave this box checked for more
detailed commentary. You can change these settings during the game, so you can experiment them later.

Managers: Human or Computer
The Managers tab lets you set whether a human player or the computer will manage some or all of the action for
the game for each team. The image below is taken from the Exhibition Game options window, but these manager
choices are exactly the same for scheduled league games.
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Starting Lineups
When you choose Human for one or both teams, DMB displays the starting pitcher and starting lineup selection
windows before the game starts. Using commands available on those windows, you can still ask the computer
manager to make selections for you. But if you want to bypass those lineup selection windows altogether, choose
Computer for both teams.
If you are playing a game in a league that is using the Real-life transactions and lineups feature, the actual starting
lineups for this game are chosen, regardless of whether the teams are set to Human or Computer. If one or both
teams is set to Human, however, the lineup selection window will display. You can inspect those lineups, and even
change them, though we're not sure why you would want to change them if you've previously opted to use the reallife lineups.

Substitutions
When you choose Computer , the computer manager will make all decisions about pinch hitting, pinch running,
changing pitchers, and making defensive substitutions. When you choose Human , it's up to you to use the
available commands to make these moves when you feel they're needed.

Game tactics
When you choose Computer , the computer manager will make decisions about pitching tactics , defensive tactics
, and offensive tactics with the exception of baserunning and throwing. When you choose Human , it's up to you to
make these decisions for your team.

Running and throwing
On some plays, the offensive manager is asked whether to try to advance an extra base on the play, and if more
than one runner is trying to advance, the defensive manager is asked where to throw the ball. You can make all of
these decisions yourself by choosing Human , or let the Computer handle them for you.

Game view preferences
The Colors / Text tab lets you determine how DMB looks on your computer. You can set a wide variety of color
combinations for such things as the scoreboard, the lineup screen, the background, and other features. You can
also set the text size for many of the displayed fields.
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Most of these items should be self-evident. If not, feel free to experiment until you get a feel for which colors go
where. There's no harm in experimenting, because you can always click on the Restore defaults button to return
all settings to their original values.

Colors
When you click on the down-arrow for any color choice, DMB displays a small color picker window that looks like
this:

If you're not happy with these basic colors, click on the Other... button to access the expanded color picker
window. This window provides you with color choices that are limited only by the color options on your computer.

If you're not sure how to interpret some of these settings, click on the question-mark button in the top right corner,
then click on the item you're wondering about. A brief explanation will pop up in a small window.

Text sizes
The sizes that work best for you will depend on your personal tastes, the resolution of your screen, and the size of
the DMB window. We encourage you to experiment with these choices until they suit you.
There is only one text size setting for all of the boxes that overlay the ballpark image. That setting is the one on the
Offense line. The boxes that display the names of the fielders, baserunners and batter will automatically resize
based on the text size you choose and the length of each player's name.

Scheduled game window
When you choose Game>Scheduled to begin the process of playing one or more scheduled games, DMB displays
a control panel for that purpose. Here's what the window looks like, followed by a quick tour of the items on this
window.
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The pull down in the upper left corner of this screen allows you to select the league or organization whose schedule
you want to work with.
Below that is a calendar. Use the left and right arrows beside the month to change months.
When you click on a day in the calendar grid, the list of games for that day displays in the box below the calender.
If a game has been completed, the final score will be shown, along with the number of innings (but only if the game
went to extra innings) and an asterisk (*) if a saved boxscore, scoresheet, and/or game log is available for that
game. You may also see the Cxl code if a game has been cancelled (as it would be if a post-season series was

clinched early) or InPr if the game was saved while in progress.
Between the calendar and the game list is a message box that displays status messages from time to time.
Next to the calendar is a series of buttons that allow you to start a single game, autoplay one or more games, stop
any autoplayed games that are underway, change the view options for this window, and close this window and
return to the main menu.
To the right is a series of tabs with team standings (regular season), game results, boxscores, scoresheets, and
game logs, and the post-season tournament bracket. You can interact with these reports even while autoplayed
games are in progress. See Displaying Reports on the Screen for details on how to interact with reports.

Starting scheduled games
The buttons on the scheduled game window allow you to control how much of the action you want to see.
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Play
Click on Play to display a menu that lets you play the first unplayed game on the day you selected in the Calendar,
or, if you have selected a particular game in the Scheduled Games area, play the game you have selected,
whether it is the first scheduled game that day or not.
When you choose to play a game, the Scheduled Game Options window appears as the first step in playing the
selected game. Use this window to choose game options, decide which (if any) functions should be handled by the
computer manager, and choose view preferences for the game window. After you have chosen these options, the
game will begin.

Autoplay
Click on Autoplay to display a menu that lets you:
Play the first unplayed game on the day you have selected,
Play a game you have selected in the scheduled games area,
Play every unplayed game up to a game you have selected in the scheduled games area,
Play every unplayed game on the day you have selected, or
Play all of the remaining games in the season.
When you autoplay games, the computer manager makes all of the decisions for both teams and continues playing
the games in rapid succession until the games you requested have been completed. Depending on the speed of
your computer, each game takes anywhere from less than a second to a few seconds to complete, so DMB doesn't
show you the progress of the game in any way. As each game is completed, the score is posted to the game list
and the standings and other reports are immediately updated.

Stop
If you have told DMB to autoplay a series of games, press Stop to quit playing those games. The game that is
currently is progress will play to completion, but any remaining games will not be played.

Options
Clicking on the Options button will bring up the following screen:

This screen allows you to choose:
the boxscore format,
the achievements that will cause boxscores and scoresheets to be generated when your league is set up to
save those items only when special events occur
text sizes and colors for various parts of the scheduled game selection window.

Cancel
Click on Cancel when you have finished playing or autoplaying games and you wish to close this window. You
cannot close the window while any game is in progress.

Scheduled Game Options
Anytime you elect to Play a single scheduled game (as opposed to autoplaying a game), DMB displays a window
so you can choose the options you wish to use for this game.
The two teams are determined by the schedule, of course. The game is played using the league rules for injuries,
warming up the bullpen, the
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use of the weather system. If you choose to use DMB's weather system, the weather for the game is based on the
game date in the schedule. The computer manager can be used for one team, both teams, or not at all. You can
also choose the format for the boxscore.
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Using the Display pulldown list:
choose Show all pitches to have DMB show the play-by-play commentary for every pitch and to give
yourself a chance to change tactics after every pitch
choose Show all plays to show the play-by-play commentary only when the ball is put in play, runners
advance or are put out, and other important events.
choose Show nothing to allow you to Quick Play until the end of an inning or the end of the game.

Using the Stop after pulldown list:
choose Each play to see the results of each play or pitch.
choose some other stopping point for two game play options:
1. If your Display option is set to Show all pitches or Show all plays, click the Go button on the
game screen to see play-by-play commentary without interruption for all plays up to the selected
stopping point.
2. If your Display option is set to Show nothing, the game will Quick Play to that point before giving
you a chance to interact with the game. (This option does not apply if you have your Managers set to
Human for choosing the starting lineups.)
Using the Boxscore pulldown list, choose the format you'd like the on-screen boxscores displayed in.
Check the Show weather report before lineups are chosen box to display that weather report before you choose
starting lineups. (The report will not be displayed if your league is not using the weather system.) Otherwise, you
can still access the weather report from the game window later.
The Play-by-play settings box allows you to set the speed of the play-by-play commentary by using the Delay
between messages slider to choose a comfortable speed. You can also control the amount of time it takes to
switch from the play-by-play window and the tactics buttons by using the Delay at end of play slider. Click on the
Play by play font button to change the look of the play-by-play messages. If you want to keep the play descriptions
as simple as possible, uncheck the Show color commentary box. Otherwise, leave this box checked for more
detailed commentary. You can change these settings during the game, so you can experiment them later.
See Managers: Human or Computer and Game view preferences for details on the second and third tabs in this
window.

Special Events
When you autoplay games, you can have DMB save the boxscore, scoresheet, and game log after every game or
only where there is a special event. The options are specified on the league and organization forms so they are
consistently applied for all games. You can determine what a special event is by using the Special Events Options
window which is accessed by clicking the Options button on the Scheduled game window (see Starting scheduled
games for more information).
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You tell DMB what qualifies as a special event by entering limits for thirteen statistics. If something happens during
a game that is over or under these limits, DMB generates the boxscore, scoresheet, and/or game log. For example,
you can choose to generate these items only when:
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a no-hitter is thrown,

a team scores more than 15 runs,
a game lasts more than 15 innings
a player hits 3 or more home runs in a game
a pitcher strikes out 15 or more batters
When you click the button labeled Special Event Options, the following window appears:

Set the values for which you want to see boxscores and/or scoresheets, then press OK to save these settings.

Overview of Lineup Selection
For a quick tutorial on how to play a game using Diamond Mind Baseball, including the process of selecting starting
pitchers and starting lineups, see the Basic Tutorial. For detailed information about lineup selection, read this topic
and those linked to it.
The lineup selection window displays all of the information you need to choose starting pitchers and lineups and to
make substitutions during a game. In addition to the ratings and statistics displayed here, you can easily access the
player profile window to see all of the stats and ratings for one or more players. And you can look at the same
information for your opponent so you can tailor your choices to his strengths and weaknesses.
DMB uses the lineup selection window for three distinct phases of lineup selection:
1. Before a game starts, you use this window to select the starting pitchers for both teams. In this mode, the text in
the title bar of the window is "Starting Pitcher -- <team year and name>". The list of players on the roster initially
shows the pitchers for each team, and the commands on the popup menus are the ones you need for pitcher
selection.
2. After both starting pitchers have been chosen and you have clicked on OK to lock these pitchers into their
lineups, DMB displays the same window with the text in the title bar of the window changed to "Starting Lineup -<team year and name>". The list of players initially displays the batters, and the commands on the popup menus
are the ones you need for lineup selection.
NOTE: DMB requires that both starting pitchers are selected before you choose either starting lineup because the computer
manager may be required to select or generate a starting lineup for the opposing team, and the computer manager needs to
know that your pitcher will not be changed after that.

3. During a game, you also use this window to make substitutions. Again, the title bar changes to reflect the mode
you are in and the popup menus reflect the options that are available to you during a game.
The following topics explain the elements of the lineup selection window and how to work with it to find the
information you want and make all of the lineup moves you may need to make:
Lineup selection: Window layout and tools
Lineup selection: Using real-life lineups
Lineup selection: Choosing starting pitchers
Lineup selection: Choosing starting lineups
Lineup selection: Making substitutions during a game
Saved lineups
Player status codes

Lineup Selection: Window Layout and Tools
The lineup selection window consists of four regions that display important information about where you are in the
lineup selection process plus some buttons and a checkbox that allow you to interact with these four regions.
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Player Status
The first column, the one headed by the letter S, indicates the player's status using a series of status codes .
Before the game starts, the most common of these codes are A for available and T for tired. For an exhibition
game, everyone will be shown as Available. For a scheduled game, you may see some pitchers marked as Tired.
Starting pitchers are marked as Tired if they would not be able to complete at least five innings before hitting their
fatigue limit for the game. In other words, if they haven't been used a whole lot recently, you might be able to get a
few innings out of a Tired starter, but he's not going to pitch deep into the game. At the same time, an A status
code doesn't guarantee that he'll be able to go seven or eight innings. He might be Available if he started two days
ago but got knocked out early, but that's not the same as saying he's at 100% and could go the distance if you
needed him to. You still need to take his recent pitch counts into consideration.
Relief pitchers are marked as Tired if they wouldn't be able to face 2-3 batters before getting hitting their limits.
You might be able to get a batter or two out of a Tired reliever, but you'd be taking your chances. As is true for

starting pitchers, don't assume that an Available reliever is at full strength. He may not be able to give you much
more than that 2-3 batter minimum if he's been used in recent days.
If a pitcher is rated as both a starter and a reliever, it's not always clear whether to mark him as Tired. He may be
too tired to give you five innings as a starter but rested enough to go an inning in relief. If the pitcher is in the
starting rotation, his status is based on his status as a starter; otherwise, the relief rules are used.

Rosters
The largest portion of the window is used to display the players on a roster. Because you may need access to a lot
of information during this process, there are five tabs that you can select from. Each begins with the player's status
for this game, his name, and his batting or throwing hand. The remaining columns on each tab are used as follows:
Pch : durability ratings, usage/fatigue info, bullpen warmup info, and key real-life pitching stats
NOTE : On this page, the Up column tells you how many times a pitcher has been warmed up in this game. This is important
only if you have the bullpen warmup rule turned on.

Bat : primary position, key real-life batting stats
Def : primary position, range ratings
BatRtg : left/right batting stats, other batting and running ratings
PchRtg : left/right pitching stats, other pitching ratings
Double-click on the name of any player to display (in a separate window) a complete profile for that player,
including most of his ratings, statistics, and fatigue/usage information. The player profile window allows you to
easily browse through the profiles for all players in the current roster list.
Right-click on the name of any player to display a popup menu of commands that are available for the current
phase of lineup selection. You can also use drag-and-drop to add a player to the lineup. This technique and the
menu commands are described in detail in other topics such as Lineup Selection: Choosing Starting Pitchers .
At any one time, this region lists either the pitchers or the batters on a roster. You can switch back and forth by
clicking on the button above and to the left of this player list. The text of that button changes between Show
batters and Show pitchers as you do this.
NOTE : Using this button to toggle between batters and pitchers is not the same as switching between starting pitcher and
starting lineup selection. If you're on the Starting Pitcher Selection window and you click on Show batters and choose a batter to
insert into the lineup, the batter will be inserted as the pitcher. The only way to move from starting pitcher selection to starting
lineup selection is to click Ok in the lower right corner of the Starting Pitcher Selection window.

Click on the Show available only checkbox to control whether the player list shows every batter/pitcher on the
roster or just those players who are available to enter the game. When this box is not checked, all players are
shown, with the available players in a different color. When it is checked, only the available players are listed.
Click on the Opponent button to show the players and lineup for the opposing team.
Next to the Opponent button is the Other actions button. Click on this to display a popup menu of commands that
are appropriate for the phase you are in.

Current lineup

The current lineup is shown to the right of the rosters.
The first column shows the batting order positions (1-9), with the pitcher shown at the bottom (P). This pitcher may
already be in the batting order, but if the designated hitter is used, this slot is needed to show who the pitcher is.
The second column shows the name and current defensive position for each player in the lineup. If a player has
been injured or ejected , but has not yet been replaced, his name is preceded by E- or I- respectively.
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Right-click on any lineup slot to display a popup menu of commands that are available for the current phase of
lineup selection. When selecting starting lineups, you can also use drag-and-drop to move a player to another
lineup slot. This technique and the menu commands are described in detail in other topics such as Lineup
Selection: Choosing Starting Pitchers .
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Defensive position grid
Below the current lineup box is a grid showing which defensive positions have been filled and which are currently
vacant. If a position is shown in blue, it means the position has been filled. Vacant positions are shown in red.

Opposing pitcher
Below the defensive position grid is a box showing a few key pieces of information about the opposing pitcher that
can help you with your lineup selections. Double-click anywhere on this box to display a full profile for the opposing
pitcher.

Status message
Below the roster is a status message that is used for different purposes. When the window first appears, it reminds
you that you can right-click to display menus with the commands you need.

OK button
Click on the OK button when you are finished and wish to move on to the next phase of the game. If either or both
lineups fail to conform with the rules of baseball, DMB will display error messages and prevent you from leaving
this window until corrections are made.

Cancel button
During the selection of starting pitchers and starting lineups, click on the Cancel button if you change your mind
and do not wish to play this game after all.
During a game, click on Cancel if you change your mind and wish to resume the game without making any changes
to your lineup. During a game, you are not stuck with any changes you have made to your lineups until you hit the
OK button.
If, however, you are required to make changes because one or more players have been ejected or injured, or
because your lineup doesn't include a player at every defensive position, you cannot leave this window before
fixing your lineup. Clicking on Cancel under these circumstances will display an error message and leave the

window open.

Lineup Selection Using Real-life Lineups
Some DMB users like to carry out detailed replays of a real-life season using the real schedule and the actual
starting lineups for each game. Some DMB season disks include a full set of real-life roster moves (trades, minorleague moves, injuries) and complete game-by-game starting lineups. For a complete list of season disks that
include this information, visit our web site.
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If you are using one of these season disks, and if you have turned on this feature for your league using the DMB
Organizer, the real-life lineups will be loaded and displayed automatically when you start playing any game from the
schedule. If one or both teams, are being handled by a human manager, you can change the starting pitcher and/or
starting lineup if you wish.
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Leagues and Organizations: Rules and Options
Real-life transactions and lineups

Lineup Selection: Choosing Starting Pitchers
When you choose to play a game, whether it be an exhibition game or a scheduled league game, DMB looks at
your manager settings. If both teams are using the computer manager, the lineup selection window is skipped and
DMB displays the game window immediately. Otherwise, the lineup selection window appears, with the roster and
lineup for the human-managed team (if there is only one) or the home team (if both teams are human-managed).
See Lineup selection: Window Layout and Tools for a description of this window and the actions you can take to
browse the information displayed in this window.
There are four ways to choose a starting pitcher:
right-click on the player in the roster and choose a command from the popup menu
right-click on the lineup and choose a command from the popup menu
left-click on the "Other actions" button and choose a command from the popup menu
use drag-and-drop to move a player from the roster to the lineup
These options are described below. When starting pitchers have been chosen for both teams, click on the OK
button to indicate that you are ready to move on to choose the rest of the starting lineups for both teams.

The roster popup menu
When you right-click on the name of a player on the roster, the following menu appears:

Select Insert as starting pitcher to take the selected player and put him into the lineup.
Select Computer manager to ask the computer manager to choose a starting pitcher and put him into the
lineup.
Select Make ineligible to tell the computer manager not to use this pitcher at any time in this game, except
in an emergency. This action has no effect if a human manager handles this team for the entire game.
Select Make eligible to reverse the effect of previously marking this player as ineligible for this game.
Select Player profile to see a complete profile of the selected player. You can also see a profile by doubleclicking on the player's name.

The lineup popup menu

When you right-click on a lineup slot, the following menu appears:
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Select Insert as starting pitcher to take the selected player and put him into the lineup. Before doing this,
make sure that you have left-clicked on the desired starting pitcher in the roster grid, so DMB knows which
pitcher you are trying to insert with this method.
Select Computer manager to ask the computer manager to choose a starting pitcher and put him into the
lineup.
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Select Player profile to see a complete profile of the selected player. You can also see a profile by doubleclicking on a lineup slot.

The other actions menu
When you click on the Other actions button, the following menu appears:

During pitcher selection, the only command you can choose from this menu is "Computer manager". Select this to
ask the computer manager to choose a starting pitcher and put him into the lineup.

Using drag-and-drop
To put a pitcher in the lineup using drag-and-drop:
1. Left-click once on the name of the pitcher you want to start and release the mouse button.
2. Position the mouse near the top or bottom edge of the pitcher's name. When the cursor changes from the
normal arrow cursor to the special drag-and-drop arrow (see image below), left-click again, hold your mouse
button down, and drag the pitcher over to the lineups area on the right side of the screen.

3. Release the mouse button anywhere over the lineup. The starting pitcher will be placed in the 9th position in the
batting order if the designated hitter is not being used for this game, and will be shown only in the P slot if the
designated hitter rule is in effect. You can change his batting order position later (during lineup selection) if you
wish.
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Lineup Selection: Choosing Starting Lineups
After the starting pitchers have been selected for both teams and you have clicked on the OK button to move on,
DMB displays the lineup selection window again. It looks just about the same as it did before, but the menu
commands are different. And there are a couple of additional drag-and-drop options at your disposal.
See Lineup selection: Window Layout and Tools for a description of this window and the actions you can take to
browse the information displayed in this window.
There are five ways to manipulate your starting lineup:
right-click on the player in the roster and choose a command from the popup menu
right-click on the lineup and choose a command from the popup menu
left-click on the Other actions button and choose a command from the popup menu
use drag-and-drop to insert a player from the roster into the lineup
use drag-and-drop to rearrange your batting order
These options are described below. When starting lineups have been chosen for both teams, click on the OK
button to dismiss this window and move on to start the game. DMB verifies that your lineup complies with the rules
of baseball before proceeding; if not, an error message is displayed and the window remains open.

The roster popup menu
When you right-click on the name of a player on the roster, the following menu appears:

Select Computer manager to ask the computer manager to choose a starting lineup.
Select Make ineligible to tell the computer manager not to use this player at any time in this game, except in
an emergency. This action has no effect if a human manager handles this team for the entire game.
Select Make eligible to reverse the effect of previously marking this player as ineligible for this game.
Select Player profile to see a complete profile of the selected player. You can also see a profile by doubleclicking on the player's name.

The lineup popup menu

When you right-click on a lineup slot, the following menu appears:
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Select Insert player to take the selected player and put him into the lineup in the slot on which you rightclicked. When DMB pops up a list of defensive positions, choose one. Before doing this, make sure that you
have left-clicked on the desired player in the roster grid so DMB knows which player you are trying to insert.
Select New defensive pos to switch the defensive position of the player in the lineup slot on which you rightclicked.
Select Insert pitcher for DH to insert the pitcher into the lineup in place of the designated hitter. This
command is disabled if the pitcher is already in the lineup or there is no designated hitter to replace.
Select Move to move the player in the selected lineup slot to another position in the batting order and to shift
the players in between by one slot. If, for example, you right-click on the #3 slot and choose the #5 slot as his
new place in the batting order, the fourth hitter moves to third, the fifth hitter moves to fourth, and the third
hitter fills the fifth slot.
Select Exchange to exchange the batting order positions of two players. If, for example, you right-click on
the #3 slot and choose the #5 slot as his new place in the batting order, the third hitter moves to fifth, the fifth
hitter moves to third, and the #4 hitter stays where he is.
Select Computer manager to ask the computer manager to choose a starting lineup.
Select Load saved lineup to choose one of the saved lineups from this team's manager profile. DMB
displays a small window that allows you to choose which lineup to load. See Loading Saved Lineups for more
information.
Select Save this lineup > to manager profile to store the current lineup in the manager profile for future
use. DMB displays a small window that allows you to choose where in the manager profile to place this
lineup. See Saved Lineups for more information.
Select Save this lineup > to real-life lineup log to store the current lineup as one that should be used
anytime this game is played. This assumes that you may want to play the season more than once.
Select Player profile to see a complete profile of the selected player. You can also see a profile by doubleclicking on a lineup slot.

The other actions menu

When you click on the Other actions button, the following menu appears:

The first three commands on this menu are also on the popup menu that displays when you right-click on the
lineup. These commands are described above.
The fourth command is Undo all changes and is disabled during pregame lineup selection. You are not committed
to use your pregame lineup until you hit the OK button, so there is nothing to undo during this phase. Or, to put it
another way, everything can be redone anyway, so there is no need for an additional undo command here.

Inserting a player using drag-and-drop
To put a player in the lineup using drag-and-drop:
1. Left-click once on the name of the player you want to start and release the mouse button.
2. Position the mouse near the top or bottom edge of the player's name. When the cursor changes from the normal
arrow cursor to the special drag-and-drop arrow (see image below), left-click again, hold your mouse button down,
and drag the player over to the lineups area on the right side of the screen.

3. Release the mouse button over the lineup slot into which you wish to insert this player. DMB displays a popup
menu so you can choose his defensive position.
4. Choose a defensive position from the popup menu.

Moving a player using drag-and-drop
You can move players around in the batting order using drag-and-drop. The technique is a little different from that
used for inserting a player:
1. Left-click once on the lineup slot of the player to be moved and DO NOT release the mouse button.
2. While holding your mouse button down, drag the mouse to the lineup slot to which you would like to move this
player.
3. Release the mouse button.
If, for example, you drag the #3 hitter to the #5 slot, the fourth hitter moves to third, the fifth hitter moves to fourth,
and the third hitter fills the fifth slot.
If you hold the Shift key down while dragging a player to a new lineup slot, that player will swap positions in the

batting order with the player in the new slot, leaving anyone in between where they are.
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Lineup Selection: Loading Saved Lineups
Each team has a manager profile containing up to six saved lineups. You can load any of these saved lineups
during the starting lineup selection phase of a game by choosing the "Load saved lineup..." command from the
popup menu that appears when you click on the "Other actions" button or right-click on the team's current lineup.
When you do this, the following window appears:

Click on one of the six lineups to preview that lineup in the box on the right.
To load a saved lineup, click on the lineup you wish to use and then click on the Load button. This does not force
you to use this lineup as is. You will still have a chance to replace players, change defensive positions, move
players around in the batting order, or load another saved lineup. Your starting lineup is locked in only when you
press OK on the Lineup Selection window.
Click on the Cancel button to close this window without loading a saved lineup.

Lineup Selection: Making Substitutions During a Game
At any time during a game, you can choose to view the lineup selection window to make substitutions. The lineup
selection window looks the same as it does for pregame lineup selection, but the menu commands are different.
And the menus are different for each team, because the available options depend on whether the team is batting or
playing defense.
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See Lineup selection: Window Layout and Tools for a description of this window and the actions you can take to
browse the information displayed in this window.
There are four ways to make substitutions from this window:
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right-click on the player in the roster and choose a command from the popup menu
right-click on the lineup and choose a command from the popup menu
left-click on the Other actions button and choose a command from the popup menu
use drag-and-drop to insert a player from the roster into the lineup
These options are described below.
When you have finished making changes to the lineups, click on the OK button to dismiss this window and return to
the game. DMB verifies that your lineup complies with the rules of baseball before proceeding; if not, an error
message is displayed and the window remains open.
If you wish to abandon any changes you have made, click on the Cancel button to return to the game. If, however,
you are required to make changes because one or more players have been ejected or injured, or because your
lineup doesn't include a player at every defensive position, you cannot leave this window before fixing your lineup.
Clicking on Cancel under these circumstances will display an error message and leave the window open.

The roster popup menu
When you right-click on the name of a player on the roster of the batting team, the following menu appears:

When you right-click on a player on the roster of the defensive team, the pinch hit and pinch run commands are not
there. The other five commands are the same for both the batting and defensive team, so we'll describe them only
once:

Select Pinch hit to insert the selected player into the lineup as a pinch hitter for the player who is due to bat
next.
Select Pinch run to insert the selected player into the lineup as a pinch runner.
Select Start warming up to have this player start warming up in the bullpen. This is necessary only if you are
using the bullpen warmup rule for this game. If you are using this rule, and you want to have a relief pitcher
ready to start the next inning, you'll need to begin warming him up while your team is still batting.
Select Stop warming up to instruct a reliever who is warming up to sit down.
Select Make ineligible to tell the computer manager not to use this player at any time in this game, except in
an emergency. This action has no effect if a human manager handles this team for the entire game.
Select Make eligible to reverse the effect of previously marking this player as ineligible for this game.
Select Player profile to see a complete profile of the selected player. You can also see a profile by doubleclicking on the player's name.

The lineup popup menu (batting team)
When you right-click on a lineup slot, the following menu appears:

Select Pinch hit to insert the selected player into the lineup as a pinch hitter for the player who is due to bat
next. Before doing this, make sure that you have left-clicked on the desired player in the roster grid so DMB
knows which player you are trying to insert.
Select Pinch run to insert the selected player into the lineup as a pinch runner for the player in the lineup
slot on which you right-clicked. Before doing this, make sure that you have left-clicked on the desired player
in the roster grid so DMB knows which player you are trying to insert as a runner.
Select Insert pitcher for DH to insert the pitcher into the lineup in place of the designated hitter. This
command is disabled if the pitcher is already in the lineup or there is no designated hitter to replace.
Select Save this lineup > to manager profile to store the current lineup in the manager profile for future
use. DMB displays a small window that allows you to choose where in the manager profile to place this
lineup. See Saved Lineups for more information.
Select Save this lineup > to real-life lineup log to store the current lineup as one that should be used
anytime this game is played. This assumes that you may want to play the season more than once.
Select Player profile to see a complete profile of the selected player. You can also see a profile by doubleclicking on a lineup slot.

The lineup popup menu (defensive team)
When you right-click on a lineup slot, the following menu appears:
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Select Insert bench player to insert the selected player into the lineup slot on which you right-clicked. When
DMB pops up a list of defensive positions, choose one. Before doing this, make sure that you have leftclicked on the desired player in the roster grid so DMB knows which player you are trying to insert.
Select New defensive pos to switch the defensive position of the player in the lineup slot on which you rightclicked.
Select Insert bench player in P slot to insert the selected player into the lineup as the new pitcher without
putting him into the batting order (because the designated hitter is being used). This command is disabled if
the team does not have the right to use the DH.
Select Insert pitcher for DH to insert the pitcher into the lineup in place of the designated hitter. This
command is disabled if the pitcher is already in the lineup or there is no designated hitter to replace.
Select Move pitcher to insert the pitcher into a lineup slot other than the slot currently held by the designated
hitter. When DMB pops up a list of defensive positions, choose one. This command is necessary only if the
designated hitter rule is in effect and only if you have previously given up the right to use a designated hitter
by moving your DH to a fielding position. In order to use this command, you must first click on the lineup slot
in which you would like to insert the pitcher.
The Save this lineup command enables you to save the current lineup to the manager profile for this team or
to the real-life lineup log. These commands are described earlier in this topic.
Select Player profile to see a complete profile of the selected player. You can also see a profile by doubleclicking on a lineup slot.

The other actions menu
When you click on the Other actions button, the following menu appears:

During a game, the Computer manager and Load saved lineup commands are disabled.
The Save this lineup command enables you to save the current lineup to the manager profile for this team or to
the real-life lineup log. These commands are described earlier in this topic.
Choose Undo all changes to revert to the lineups that were in place when you first entered the lineup selection
window. That way, you can change your mind or recover from any changes that you made by mistake. Changes
that you make are not committed until you click Ok in the lower right corner of the lineup selection window.

Inserting a player using drag-and-drop
To put a player in the lineup using drag-and-drop:
1. Left-click once on the name of the player you want to start and release the mouse button.
2. Position the mouse near the top or bottom edge of the player's name. When the cursor changes from the normal
arrow cursor to the special drag-and-drop arrow (see image below), left-click again, hold your mouse button down,
and drag the player over to the lineups area on the right side of the screen.

3. Release the mouse button over the lineup slot into which you wish to insert this player. DMB displays a popup
menu so you can choose his defensive position.
4. Choose a defensive position from the popup menu.

Game Window
For a description of the various elements of the game window, see the Basic Tutorial.
For descriptions of the tactics that you can employ during a game, see Pitching Tactics, Defensive Tactics,
Offensive Tactics, and Baserunning Decisions.
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We assume that you know how to read a baseball boxscore, but if you want to know how to interpret the DMB playby-play scoresheet and game log, see Reading the scoresheet and Reading the game log.
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Pitching Tactics
Challenge hitter
Select Challenge hitter to have your pitcher challenge the batter with his best pitches. In most cases, it is the best
way to get the batter out.

Pitch around hitter
Select Pitch around hitter to instruct your pitcher to be careful to avoid giving the batter a pitch that he can hit for
power. As a result, the batter will hit fewer doubles, triples, and home runs, but will allow more walks and get fewer
strikeouts than when he challenges the hitter. Of course, since your pitcher is human, the batter may still get a
great pitch to hit. This strategy should be used only in certain situations, such as when a dangerous hitter is at the
plate with first base open. Using this strategy too often will cause you to give up more runs than if you challenge
most hitters, because many more runners will get on base.

Intentional walk
Select Intentional walk to intentionally give a walk to the hitter. You may want to use this strategy when the batter
is very dangerous, or when you want to set up for a double play or a force play at home.

Pitch out
Select Pitch out to throw a fastball wide of the plate and give your catcher the best possible chance to throw out a
runner who might be attempting to steal on this pitch. This option is not available when the bases are empty or
when there are three balls on the hitter.

Pickoff throw (Shift-123)
Select Pickoff throw to have the pitcher throw to a base in an attempt to catch the runner off guard. This option is
not available when the bases are empty.
If you click on this button with only one runner on base, DMB assumes the pickoff throw should go to that base. If
there are two or more runners, DMB pops up another series of buttons to allow you to choose the base you want to
throw to.
This second series of buttons is fine if you are playing alone, but if you are playing with another person, it gives
away the fact that you want to make a pickoff throw somewhere. So, to maintain secrecy, DMB includes a special
keystroke sequence that you can use to bypass this menu. Hold down the shift key and press 1, 2 or 3 to throw to
first, second, or third, respectively.

Quick 1-1-1 or Quick 1-1
The most common sequence of commands is Challenge the hitter, Normal defense, and Swing away. So DMB
offers you a quick way to choose these sequences when you are playing alone or playing against the computer
manager.

If both managers are set to Human, select Quick 1-1-1 to make these choices and have DMB immediately begin
generating the result of the play. If the DMB computer manager is handling the offensive team, this command
reads Quick 1-1 and causes you to challenge the hitter with the infield at normal depth. The computer manager
then makes a decision for the offense.
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Defensive Tactics
After you have selected your pitching tactic, the tactics button array will switch to allow you to position your infield.

Normal defense
Select Normal defense to give the infielders the best opportunity to reach ground balls and make double plays.

Infield in
Select Infield in to bring all four infielders toward home plate. This strategy gives the defense a much better
chance to throw out a runner who tries to score from third on a ground ball. It also provides for better defense on
bunts to first and third.
However, it increases the chance that a ground ball will go through the infield for a single, and reduces the chance
for double plays at second base by taking the second baseman and shortstop out of position.

In at the corners
Select In at the corners to bring the first and third basemen toward home plate, so they can better handle bunts in
their direction and increase their chances of throwing out a runner at the plate while keeping the shortstop and
second baseman at double-play depth. This defense increases the chance that ground balls toward first and third
get through for hits.
Guard lines
Select Guard lines to have the first and third baseman play at normal depth but much closer to the baseline than
normal. This strategy reduces the number of ground balls down the line that go for doubles and triples in the
corner, but increases the number of singles hit through the hole.
This strategy is most commonly used in the late innings of a close game, when a double or triple might win the
game, but a single may not.

Hold runner
Select Hold runner to have the first baseman stay on the bag to keep a runner close and reduce his chances to
steal second or take an extra base on a hit. When there is a runner on first and second base is open, DMB
assumes you want to hold the runner close at first. However, ground balls between first and second are more likely
to go through for hits.

Play behind runner
Select Play behind runner if your first baseman is currently holding the runner close but you want him to ignore
the runner and play at normal depth.
This tactic is most commonly used when the runner at first is not a threat to steal or if the defensive team is ahead
by a comfortable margin and it is more important for the first baseman to be able to reach ground balls than it is to

prevent a steal of second. The offense's chances of a successful steal increase when the defense plays behind the
runner.
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Offensive Tactics
When your team is at bat, the tactics button array will change to allow you to tell your batters and baserunners how
to behave.

Swing away
Select Swing away to instruct your batter to wait for a good pitch to hit and have your baserunners (if any) run only
when the batter makes contact.

Bunt
Select Bunt to instruct your batter to bunt. Depending on the number of outs and the location of any baserunners,
different types of bunts may be called for -- bunts for a base hit, sacrifice bunts, suicide squeeze bunts and safety
squeeze bunts.

Hit and run
Select Hit and run to instruct your runners to go as soon as the pitcher releases the pitch and to have the batter
swing at the next pitch. This improves their chances to take an extra base on a hit and sharply reduces the
likelihood of a double play ground ball.
If the batter does not make contact, however, a runner may be thrown out trying to steal. The odds of stealing the
base are a little lower than for an ordinary steal attempt because the runner is slowed by the need to look back to
see if the batter made contact.
Because the batter must swing at this pitch, no matter how good or bad it is, he is less likely to hit for power.
However, more ground balls will go through for singles because an infielder must move to take a throw from the
catcher should the batter fail to make contact.
This strategy is most effective when the batter has a high average and/or seldom strikes out, since he will almost
always make contact and protect the runner.

Steal
Select Steal to instruct one or more of your baserunners to attempt a stolen base. If the runner does not steal
often, or the pitcher is good at holding runners close, the steal attempt may not happen. The runner will go only if
he feels he gets a good jump on the pitcher.
If the pitcher makes a pickoff throw to the base occupied by a runner who has the signal to steal, his chance of
getting picked off or caught stealing are much higher than if the pitcher makes an ordinary pitch. But there is no
guarantee that a pitcher who guesses right will pick off the runner. That's because the runner is studying the
pitcher's every move and can often detect that the pitcher is throwing over early enough to get back safely.
With runners on first and third, the offensive manager chooses whether to steal only second or try a double steal
(steal both second and home simultaneously). The former sets up the following chain of decisions:

if the offensive manager chooses to steal only second, the defensive manager decides whether to concede
second, or to try to throw the runner out.
if the catcher throws to second, the offensive manager decides whether to have the runner on third try for
home on the throw.
if the runner goes for home, the defense decides whether to cut off the throw to second and make a play at
the plate, or let the throw go through and try make a play at second base. If the third out is made at second
base, the inning ends before the runner at third scores, and the run does not count.
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With runners on first and second, with third base open, the offensive manager decides whether to send one or
both runners. If both runners are going, the defense can throw to third or second.

UNREGISTERED VERSION OF CHM TO PDF CONVERTER STANDARD BY THE

Baserunning Decisions
When you set up a game, you have the option to control the running and throwing action for your team or to
delegate those decisions to the computer manager.
DMB never asks you when the outcome is certain. If a ball is lined into the gap for a single and the runner is
guaranteed to score from second, DMB does not ask you whether you want to try to score on the play. It just
announces that there's no play at home.
However, in cases where the outcome is in doubt and a human manager is making the decisions, the DMB play-byplay commentary pauses until you have made your decision. This topic covers some of the strategy you need to
consider.
The runner's chances to take an extra base depend on the batted ball (distance, direction, and how hard it was hit),
the speed of the runner, and the throwing rating of the outfielder. It's easier to take an extra base on a single when
it's a soft line drive in the gap than when it's a hard line drive directly toward a fielder. It's easier to go from second
to third when the ball is hit to right field than when it is hit to left. It's easier to advance on deep fly balls than
shallow ones.
Over the years, we've found that baseball fans tend to overestimate their chances of taking an extra base on a hit
or fly ball. For some reason, it's a lot more memorable to see a runner dart around second base and cruise into
third than to see someone put on the brakes and hold at second on a single. Maybe TV cameras tend to show the
runner in motion but keep the lens elsewhere if the runner pulls up.
It may surprise you to learn that big-league runners go from first to third on a single to left field only about 10-15%
of the time. That shouldn't come as too much of a surprise because the throw from left field to third base is quite
short. The advancement rate rises to 30-40% on balls hit to the center fielder and 40-50% on balls hit to right.
These figures cover batted balls that are hit more or less at the outfielder in question; the opportunity to advance
is greater than that on balls hit to the gaps and down the lines, but even so, the extra base is not always a sure
thing.
If the runner is going on the pitch (hit and run) or on contact (two outs), the chances to advance increase
significantly, but they're often less than 100%. Some fans have the impression that the extra base is automatic in
these cases, but big-league play-by-play data clearly shows that is not the case. Most runners can safely go from
first to third on a hit and run single to right, but even with a head start, it's tough to make third on a sharper
grounder or line drive to left.
As you would expect, it's much easier to score from second on a single because the throw home is longer than the
throw to third for most outfielders. (It's about the same distance to both bases for a right fielder.) Consequently,
you'll find that 50-60% of all runners can score from second on a single, and that rate rises to more than 80% with
two out because the runner can go on contact. Scoring from second on a hit and run single is an even better
proposition.
Scoring all the way from first on a double is a difficult proposition, though a lot depends on where the ball is hit.
Balls hit down the lines result in the shortest throws home and present the biggest challenge to the runner. Only
about 25-35% of baserunners make it home from first on those doubles. The runner's chances improve on doubles
hit toward the center of the diamond, with the advancement rate rising into the 45-65% range on doubles hit into
the gaps. You can add about 20% to those figures when there are two out and even more if the hit and run is on,
assuming (in the case of the hit and run) the runner doesn't have to hold up to see if the ball will be caught.
Our review of play-by-play data has also shown that third base coaches tend to be very conservative. Only about

1% of all runners who have the opportunity to go from first to third on a single are thrown out in the attempt. The
other 99% are either safe at third or choose to hold at second in the first place. In other words, big-league coaches
don't like to give away outs at third base, preferring to hold the runner unless the advance is almost certain.
The risk/reward trade-off is a little different for plays at the plate, with the percentage of runners thrown out rising to
about 3%. That's still a low rate, but it does show that coaches are willing to take a few more chances when given
the opportunity to score an extra run right away.

You may decide that you're will to take more chances on the basepaths, and that may well turn out to be a winning
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even your fastest runners, to be safe every time. Those extra bases are valuable, but you will pay a price in extra
outs if you're aggressive.
And it's worth repeating that you won't be asked about sending the runner if the advance is a sure thing. So if you
ARE asked whether you want to try for the extra base, there is at least a small chance (and maybe a large one)
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that the runner will be thrown out, no matter where the ball was hit, who's throwing, and how fast your runner may
be.
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Ground balls
On ground balls with the bases loaded, the runners are always moving and DMB makes the best available play for
the defense.
On other ground balls with a runner on third, the offense is asked whether to send the runner home or hold him at
third. If the runner holds, the defense makes the best available play. If the runner is sent, the defense is asked
whether to throw home. If the defense chooses not to throw home, the defense makes the best available play
(which may be a double play, a force out at second, or an out at first).
It's very difficult for runners to score from third on a cleanly-fielded ball that is hit more or less at an infielder. In
many cases, the runner on third is a sitting duck who is sent home only to force the defense to make that play
instead of going for a double play.
The runner's chances of scoring increase if the runner is fast, the ball is hit slowly, or the ball is not hit directly at a
fielder. The chances of scoring decrease if the fielder making the throw is playing in.

Doubles
Some doubles are deep enough to score a runner from first; some never score the runner. On the ones in between,
the offense is asked whether to try for home. If the runner is sent, the defense always throws home, and the batter
always stops at second base. The runner's chances depend on his speed and the strength of the highlighted
fielder's throwing arm.

Singles and fly balls
On many of these plays, the offense must choose whether to send runners on third or second. If two runners are
sent, the defense chooses the base to throw to. If there is also a runner on first, the defense may choose not to
throw home and keep the runner on first from trying for second.
If a runner is sent home and the defense throws home, there may be another strategy option for both sides. If there
is a runner on first, the offense may have him try for second on the throw home. If the runner goes for second, the
defense can choose to cut off the throw home and try for the man at second. If the third out is made at second, it is

always after the runner has scored from third, so the run counts.

Warmups and Substitutions
Whenever you want to start or stop warming up a pitcher or make any substitutions during the game, click on the
Defensive lineup or Batting lineup button to display the substitutions window.
You can also make pinch hitting and pinch running substitutions by right-clicking on a player listed on the bench
window in the lower left corner
of the game
screen.
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If you are using the bullpen warmup rule and have already warmed up a pitcher or two from the substitutions
window, you can insert a relief pitcher into the game by right-clicking on the bullpen window that appears on the
game screen.
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Other Options
At any time during a game, you can take the following actions:

Replay
At the end of the action that determines the fate of the batter/baserunner(s) or after each pitch (if you are playing in
pitch-by-pitch mode), you can review the action simply by clicking on the tab labeled Replay beside the tactics
button array any time prior to the next pitch.

Boxscore
You can view the in-progress boxscore for the game by selecting the tab labeled Boxscore in the upper left corner
of the screen.

Scoresheet
You can view the in-progress scoresheet for the game by selecting the tab labeled Scoresheet in the upper left
corner of the screen.

Game log
You can view the in-progress game log for the game by selecting the tab labeled Game log in the upper left corner
of the screen.

Reports
You can view standard, customized, or memorized reports by selecting Report from the menu at the top of the
DMB window.

Weather Report
You can view the current weather by clicking the button labeled Weather report on the tactics button array.

Quick Play
Clicking on the button labeled Quick play on the tactics button array allows you to have DMB control all of the
action through the next half inning, to the end of a particular inning, or until the game is completed. This happens
very quickly, so DMB doesn't display anything until the quick play period is over.
Keep in mind that the computer manager is making the decisions for both teams during a quick play period. That
means that both teams must have manager profiles that are reasonably well filled out. Without this information, the
computer manager will not make good decisions. If you're using a DMB season disk, all teams have manager
profiles assigned, but if you have drafted new rosters, it's up to you to make sure a manager profile has been put
together for that roster.

To pitch/batter mode
If you have elected to have DMB stop at the end of every play that decides the batter/baserunner(s) fate, you can
switch back to pitch-by-pitch mode by clicking To pitch mode. The button will change to read To batter mode and
allow you to switch back.

Change options
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Clicking the button on the tactics button array labeled Change options will call up the Game Options window and
allow you to change any game play settings.
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Saving a game in progress
If you are in the middle of a game and do not wish to finish it right away, choose the Save game and exit command
from the Game menu on the menu bar across the top of the screen.
DMB writes out a file with all of the information about the game. If this is a scheduled game, that game is marked
as In progress (you'll see the symbol InPr on the game list) as a reminder that it has already been started.

Resuming a saved game
If you have previously saved a game in progress, you can resume it in one of two ways.
If you saved an exhibition game, the next time you choose Game>Exhibition game from the menu, DMB asks you
whether you wish to resume the game that was saved. Select Yes to resume the game or No to abandon that
game (permanently) andVERSION
start a new one. OF
You cannot
more
than one
exhibition game at aSTANDARD
time.
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If you saved a scheduled league game, choose Game>Scheduled game to open the scheduled game window.
The saved game shows in the game list with a status code of InPr to indicate that it is already in progress. Start
that game using the techniques described in Starting scheduled games. Instead of taking you through the normal
sequence of pregame option and lineup selection, DMB displays the game screen immediately.
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NetPlay Overview
The NetPlay feature allows you to play Diamond Mind Baseball games head-to-head with other DMB owners over
the internet, assuming both of you have internet access.
Both players must be running their own copies of the DMB software. One uses a menu command to prepare to
host the session. The other uses a menu command to establish a connection to the host.
To establish the connection, the remote user needs the host's IP address. We'll show you, as the host, how to find
that IP address. Once it is known, you can send it to the remote user via email, instant messaging, telephone, or
some other communication method.
If the host is using a hardware- or software-based firewall, the host may need to take steps to ensure that the
remote user is able to get a connection. The Firewalls topic covers these issues.
After the remote user has successfully connected to the host, the two players can chat with each other. You can
play more than one game during a NetPlay session. The host can manage either the home team or the visiting
team, with the remote manager taking the other side. For now, others can participate on a chat-only basis, but they
cannot see the game window as the game progresses.
The host is responsible for starting the game. You can use NetPlay to start a new exhibition game, start a new
league game, or resume a previously saved game.
When the host starts a game, both managers see the pitcher selection window on their respective computers.
When both managers have selected their starting pitchers, the game displays the lineup selection window on both
computers. When the lineups are in for both teams, the main game window appears, and you're ready for the first
pitch.
During the game, a stoplight icon tells you whether it's your turn to make a decision (green light) or whether to wait
the opposing manager (red light). When the tactics for both teams have been entered, the game displays the
outcome of the play on both computers simultaneously.
It's almost as if you were both sitting at the same keyboard and using a single computer. But it's better than that,
because there's no chance that your opponent can watch your mouse actions or peek at the keys you're pressing
while choosing your tactics, and you're both free to browse game information (boxscore, scoresheet, game log,
player profiles) in your own way at the same time. DMB makes sure the two systems stay in synch as you move
through the game.
While the game is in progress, a floating chat window appears. You can move, resize, or hide this window if you
like, and if it is hidden, you have the option of being notified by a sound whenever a new message arrives.
When the game is over, the host uses the normal end-of-game commands to save the results of the game to the
database. Both managers can continue to browse the game window information. When both managers have closed
their respective game windows, the host can start another game.
Using menu commands, the remote user can choose to disconnect from the NetPlay session and the host can
choose to shut down the session.

Preparing to Host a NetPlay Session
To host a NetPlay session, choose the Host NetPlay game(s)... command from the Game menu. The following
window appears:
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Enter the user name by which you wish to be known. This identifies any chat messages that you send during the
session. Then choose the role you wish to play. When you click on the OK button, the NetPlay window appears.
A status message indicates that you are ready to host the NetPlay session and displays your IP Address. Remote
users need this address to connect to your computer.
NOTE: If your computer has more than one network adapter enabled (many computers do, even if some are not used), the IP
Address displayed by DMB may not be the one you need to provide to remote users who wish to connect to the session. Please
see Finding Your IP Address for more information.

Finding Your IP Address
An IP address is a number that uniquely identifies your computer among all of the machines on the internet. It is
usually displayed as a series of four or six numbers separated by periods.
If you want to host a NetPlay session, remote users need your IP address to establish a connection. Unfortunately,
if your computer has more than one way to connect to the internet, it will have more than one IP address. If so, you
might need to experiment a little to determine which IP address to use.
For example, you may have a network card that connects to a DSL modem, and that network card will have an IP
address. You may also have a modem for dial-up access, and that modem will have its own IP address.
Furthermore, it's possible that other network adapters are installed on your computer even if you don't use them.
The most reliable way to find out what IP addresses are known to your computer is to click on the Windows Start
menu, click on Run, enter the command IPCONFIG, and press Enter. (IPCONFIG doesn't have to be in capital
letters.)
If you are unable to run the IPCONFIG command from the Run window, try opening the MS-DOS Prompt or
Windows Command Prompt. When the window appears, type the command IPCONFIG and press Enter.
Windows will open a new window that displays a list of all of the installed adapters and their IP addresses. If you
have multiple adapters installed, you may need to scroll up the screen to find the first listed adapter.
NOTE: If you cannot scroll from the MS-DOS window, type the IPCONFIG command again but add a space and then type
|more.

If an adapter is not in use, it may have an IP address of 0.0.0.0, and it can be ignored. If you have more than one
adapter with a non-zero IP address, one of them will allow remote users to connect to your computer. It's not
always obvious which one, so you may need to experiment a little.
NOTE: IP Addresses can change over time. If you connect to the internet through a modem, chances are you will be assigned a
different IP Address each time you connect. If you use a DSL connection, you may have a different IP Address assigned each
time you reboot the computer and reestablish the connection to your DSL provider.
As a result, if you regularly host NetPlay sessions, you may need to provide a different IP address to your remote users on
different days or even at different times on the same day, depending on your setup and how often you connect and disconnect
from your internet provider.

Firewalls
Firewalls prevent unwanted internet traffic from reaching your computer, and by doing so, they play a very
important role in protecting your data and your privacy. We join all of the security experts in recommending that you
make sure your computer is protected, one way or another, from the threat of viruses, Trojan horses, and other
unauthorized attempts to access your system.
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If you do have a firewall installed, either on your computer or on a router that connects your computer to the
internet, and you wish to be the host in a NetPlay session, it's likely that you'll need to take steps to make sure the
remote users can connect to your computer. Without making the necessary preparations, your firewall is likely to
deny access because it regards the remote user as a potential threat.
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- over an office LAN when both computers were behind our firewall
- over a dial-up connection with no firewall installed
- over a DSL line with a firewall disabled before the session and then restored after the session
- over a DSL line with the firewall enabled and a specific port opened to allow DMB traffic to get through (see
Opening a Port for instructions)
Because virtually all corporate networks have firewalls, it's likely that you won't be able to use NetPlay from your
office to play someone who is outside your company network and your company's network administrators will not
permit a port to be opened for this purpose.

Opening a Port
One way to receive connections while retaining the protection of a firewall is to open a specific port and leave all
other ports closed.
A port is simply a mechanism used by networking software to direct different types of internet traffic to different
parts of your system. For example, there's a standard port for browsing the web, another for email, a third for file
transfers, and so on.
Each port is identified by a number. A block of low numbers is reserved for the standard ports. Higher numbers are
available for other application developers. The Internet Assigned Numbers Authority (IANA) maintains a web site
with a complete list of all of the standard port numbers and an incomplete list of the nonstandard port numbers that
are used by other applications.
Diamond Mind Baseball uses port 32158. We chose this number in part because the IANA site shows that it is
available. Application developers are not required to register their port numbers with IANA, so this doesn't
guarantee that you're not running another application that is also using this port number. If so, you may encounter a
conflict, but we believe this is highly unlikely.
If you have a firewall installed and you wish to host a NetPlay session, see if your firewall provides a way to open
the DMB port. Based on our experience with a few of the firewall products in the market today, we have found this
to be a simple process. When the port is opened, you should have no trouble receiving connections from remote
users.
Some hackers attack certain standard ports, but others use programs that scan all ports on a computer to find a
way to get through. If you close the Diamond Mind Baseball port after your NetPlay session has ended, you
minimize the risk that someone might use this open port to gain access to your computer.

The NetPlay Control Panel
The following NetPlay control panel is the command center for the NetPlay session:
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Across the top is a status message pane.
Below that is a list of all chat messages that have been sent or received during the session along with notification
messages generated by DMB.
Below the chat output area is a place to enter chat messages. Simply type your message and press Enter to send it
to the other participant(s) of the session.
To the right is a list of all of the session participants and the roles they are playing. For now, this list is limited to the
two managers and chat-only participants. Chat-only participants will not be able to play or even view the game, but
they can chat with the two managers and any other chat-only participants. In time, we plan to add support for
spectators who can watch the game and chat among themselves.
By selecting the NetPlay menu command, the host can swap manager roles and all members of the session can
change the NetPlay options to control the font and colors used to display chat messages.

NetPlay Options
When the NetPlay window is the active window, you can choose the Change options... command from the
NetPlay menu to control certain aspects of your NetPlay session. The following window appears:

Three types of messages are displayed in your chat area -- outgoing chat messages, incoming chat messages, and
system messages -- and you can choose the colors used for each of these messages.
You can also choose the font for all messages that are displayed.
If you would rather not see messages from chat-only participants, there's an option to suppress those messages.
Another option controls whether a sound is generated when a chat message is received. You can specify that a
sound should never be generated, always be generated, or generated only when the chat window is hidden.

Connecting to the Host
To connect to a host for a NetPlay session, choose the Connect to NetPlay host... command from the Game
menu. The following window appears:

UNREGISTERED VERSION OF CHM TO PDF CONVERTER STANDARD BY THE

UNREGISTERED VERSION OF CHM TO PDF CONVERTER STANDARD BY THE

Enter the user name by which you wish to be known. This identifies any chat messages that you send during the
session. Choose the role you wish to play. And enter the IP Address of the host to which you wish to connect.
NOTE: DMB remembers the last IP address you entered through this window, but because IP Addresses can change from
session to session, there's no guarantee that the host will be using the same address at different times. You may need to
change this address even if you are connecting to the same host.

When the connection is established, the NetPlay window appears. If a connection cannot be established
immediately, DMB will make several attempts to connect using the IP address you provided. If all of those attempts
fail, DMB displays a message indicating that the connection could not be established.
The most common reasons for the inability to establish a connection are:
- the host hasn't yet used the Host NetPlay game(s)... command and therefore is not ready to receive connections
- the IP address you entered is incorrect
- the host is using a firewall and has not taken steps to bypass that firewall, either by disabling it temporarily or
opening the port used by Diamond Mind Baseball
If a connection is established, you will see the name of the host in the list of participants on the NetPlay window,
and you will be able to start chatting with the host.
If you and the host have accidentally chosen the same role, your role will be changed so that you and the host have
the opposing manager roles. The host can change these role assignments before starting a game.

Chatting Before or After a Game
When no game is in progress, all chat messages are displayed on the NetPlay window.
Typically, messages you send are displayed in one color and messages received from others are displayed in a
different color. Using the Change options... command from the NetPlay menu, you control these color choices, so
you can use the same colors for all types of messages if you like. You also control the font used to display these
messages.
To send a message, type your message in the text box that appears below the list of chat messages. When you
are finished typing, press Enter.

Starting a Game (host only)
Only a host can start a game. On the remote user's copy of DMB, the Exhibition Game command is disabled and
the various ways to start a game via the Scheduled Game window will lead to a message indicating that this is not
a permitted action for a remote user. DMB does allow a remote user to open the Scheduled Game window,
however, for the purpose of viewing league standings, boxscores and other information.
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The host can start an exhibition game or league game, or resume a previously saved game, using the same
commands that are use for non-NetPlay games. Because the game information is loaded (and the results saved)
on the host's computer, the remote manager does NOT need to have the same DMB database installed.
After the game has been started by the host, all of the necessary information about the teams, players, ballpark
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very fast on a DSL line, and may take a while on a slower dial-up line. This is the only time a large amount of
information is transferred between the participants, so it's the only time you might need to wait a little while before
proceeding.

Choosing Starting Pitchers and Lineups
After the initial transfer of information, each participant is presented with the starting pitcher selection window. Both
can interact with this window at the same time and in any way -- scrolling lists of pitchers, looking at player profiles,
checking out the opposing team's roster of hitters, asking the computer manager to nominate a starter, and so on -before choosing a starting pitcher and pressing OK.
You and the opposing manager are NOT looking at the same screen image, you are working independently. When
a pitcher is selected, the ID of that pitcher is sent to the other manager. It doesn't matter who finishes that process
first. DMB knows when both pitchers have been selected and it's time to move on to the starting lineups.
After the starting lineups have been selected by both managers, the game window is displayed on both computers.
As with pitcher and lineup selection, the two displays are independent. It doesn't matter whether you and your
opponent are using the same resolution, the same color scheme, or the same play-by-play font. You can even have
different settings for the speed of the play-by-play messages.

Playing a Game
The following image depicts the NetPlay game window:
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NOTE : The user has the freedom to move the chat window to any location, resize and reshape the chat window, or may choose

to hide the window with the option of displaying it again at a later time. This image represents one possible layout.

During a game, you and the opposing manager take turns making your decisions, just as you would when playing
someone who is sitting right next to you. On each play, the offensive manager cannot choose tactics until after the
pitching and defensive tactics have been received from the other manager. When baserunning and throwing
decisions are needed during a play, each manager must wait until the other has made a decision. A stoplight icon
(located in the upper-right corner of the play-by-play window in the above image) tells you whether it's your turn to
make a decision (green light) or whether to wait the opposing manager (red light).
But DMB does not impose any unnecessary limitations here, either. While trying to decide what to do, or while
waiting for the other manager to make a decision, each manager can be sending a chat message, looking at the
boxscore, flipping to the replay of the last event, or calling up a player profile. In other words, DMB won't let you get
ahead of the other manager in the flow of the game, but it won't stop you from thinking and browsing independently,
either.
After both managers have entered their tactics, the host's computer executes the play and sends the play-by-play
commentary and a coded description of the play to the remote machine. The remote computer uses that
information to update the state of the game and all relevant statistics. The result is that both managers have
independent access to the stats and everything else about the game.
During the selection of game tactics, your opponent never sees your mouse cursor or your hands moving over the
keyboard, so there's no possibility that your tactics will be revealed too early.

Quick Play
If time is short, the participants have the option to quick play a portion of the game. If one manager chooses a
quick play command, the other is asked if he agrees, and if so, the game is autoplayed to that point. (NetPlay is
fast, though, so you'll be able to use quick play when you want to, not because you have to.)
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Chatting During a Game
During a game, a floating chat window appears so you can converse with your opponent without having to return to
the NetPlay window. If you don't expect to be chatting very much, and if you'd rather be able to see the portion of
the game window that is behind the chat window, you can hide the chat window.
To hide the chat window, choose the Hide chat window command from the NetPlay menu on the menu bar
across the top of the screen. You can access the chat window again by choosing the Show chat window
command from the same menu.
You can reposition and resize the chat window at any time. To reposition, click and hold down the mouse button on
the title bar of the chat window and drag to its new location. To resize, click and hold down the mouse button on
the window's border and drag to make it wider or give it more height.
The chat window is not confined to the game window or the entire DMB window. You can resize and reposition
DMB and the chat window so both can fit on your screen without overlap.

Abandoning a Game
If, for some reason, either manager is unable to complete a game that is in progress, DMB allows for a graceful exit
from that game.
If the remote manager closes the game window, a message is sent to the host indicating that this has happened. At
that point, the host has the
same two choices
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If the host closes the game window, with or without saving the game first, a message is sent to the remote
manager indicating that the game cannot be continued.

UNREGISTERED VERSION OF CHM TO PDF CONVERTER STANDARD BY THE

When a Game is Over
At the end of a game, the host saves the results of the game. As with non-NetPlay games, this is not strictly
required, but it would be a major breach of etiquette if the host failed to save the game without the consent of the
remote manager.
One or both managers may choose to keep the game window open for a while, providing time to review the
boxscore, scoresheet, game log, or player statistics before returning to the NetPlay window.
As with non-NetPlay sessions, the host cannot start another game while the game window is still open. NetPlay
adds an additional restriction. As long as the remote manager has the game window open, the host cannot start
another game.
When the remote manager has closed the game window, DMB notifies the host using a status message that
appears in the chat area of the NetPlay window. That signals the host that another game can be started at any
time.

Disconnecting
A remote user can disconnect from a NetPlay session using the Disconnect... command on the NetPlay menu. If a
game is in progress, the remote user must first exit that game, thereby notifying the host that the game has been
abandoned by the remote manager. When the remote user disconnects, the host is notified via a status message
that appears in the chat area of the NetPlay window.
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The host can end the NetPlay session using the End session... command on the NetPlay menu. If a game is in
progress, the host must first exit that game (with or without saving the game for later completion), thereby notifying
the remote manager that the game has been abandoned. When the host ends the session, the remote manager is
notified via a status message that appears in the chat area of the NetPlay window.
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If the Connection is Dropped
The internet is not a 100% reliable medium. Whenever you are using the internet for any purpose, you run the risk
of losing your connection at any time. (This won't come as a surprise to anyone who has played chess, hearts or
other multi-player games on any of the popular gaming sites.) DMB cannot prevent that from happening, but it can
help ensure that you don't lose any information if it does.
DMB automatically saves all of the game information (on the host's computer) after each play, and it can use that
information to resume the game from that point. In other words, if you or your opponent loses the connection, you
won't have to start over.

Trouble-shooting
If something goes wrong during a NetPlay session, it may reflect a problem with the DMB software. Perhaps the
two copies of the game have gotten out of synch in some fashion. Or it may be something unrelated to the DMB
software, like a problem with your networking gear or a temporary outage on the internet itself.
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restarting the session from scratch. If both participants exit from the NetPlay session, exit the DMB game, start
DMB again, and reestablish the connection, the clean start may allow you to pick up where you left off without any
further difficulties.
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Overview of Reports
DMB comes with an extensive set of Standard Reports that enable you to see league standings, league leaders,
player and team statistics, injury and transaction logs, game results, and more.
You can also design your own Custom Reports and save those reports for later use. Custom reports allow you to
change the structure of any of DMB's standard reports -- adding/moving/deleting columns and entire sections,
changing sort sequences, and choosing how to format the columns in the report. After you have saved a Custom
Report, you can use it just like a standard report.
Many of these reports include options that allow you to control the content of the reports. For example, you can
specify which team's players should display in the team batting report. Or choose the number of players who
appear in each category of your leaderboard reports. And on the batting and pitching registers, you can use the
options to exclude players with small amounts of playing time. For a list of all of the report options, see Reporting
Options.
If you chose to compile game-by-game statistics for your league, you can choose any time period for DMB
statistics that are displayed on your reports. Choose from some standard intervals -- each month, last 7 days, last
14 days, and so on -- or select any start and end date you like. (Time interval reports are not available for real-life
statistics because the game does not ship with real-life game-by-game statistics.)
And you can create Memorized Reports. A memorized report defines both the structure and the content. In other
words, you can save the settings you would ordinarily specify in the options window. When you generate a
memorized report, DMB doesn't need to ask you for the options, so it produces the report immediately.
All reports, including Custom and Memorized reports, can be displayed on the screen, sent to a printer, or saved
to a text file in plain-text or HTML format.
By creating Report groups, you can generate a collection of memorized reports with a single command. This can
be a real time saver if you have a specific set of reports that you like to generate on a regular basis. These reports
can be sent directly to a printer or saved to disk in plain-text or HTML format.
You can also generate a complete set of linked pages for a web site. The contents of the web site are determined
by a series of report groups that you establish, so you have a lot of control over how the web site is organized.

Generating Reports
DMB allows you to generate a wide variety of standard, custom, and memorized reports to be displayed on the
screen, printed, or saved to a text file in plain-text or HTML format.

Selecting the Report
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Begin by choosing Report on the DMB menu bar, and then choose Standard, customized, memorized. DMB
displays a window that allows you to select the type of report and the specific report within that type:
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As you can see, there are a variety of standard, custom, and memorized report types available. The Include in
report list box allows you to choose which category of reports (Standard, Custom, and/or Memorized) are
displayed in the Report name box.
The report names, displayed on the right will vary depending on which report type you select. For example, the
Batting Register report type provides four reports by default; the standard DMB and Real-life batting registers and
two memorized batting registers (League and Organization) that are included to allow you to easily generate report
groups and web sites. The Game log report allows you to select game-by-game batting or game-by game pitching.

Click on the report type you want to generate, then select the report name you are interested in.
The Output box allows you to choose the destination for this report. When you choose Display, the report is
displayed in a window on the screen. You can interact with the report, changing options and browsing through
different teams and leagues, and still choose to print it or save it to a file. If you don't want to see the report on the
screen before you print it or save it to a file, choose one of the other options.
Click Generate to produce the report. DMB displays an options window. For most reports, this window has three
tabs:
the Options page is used to select the scope of the report and choose options that govern the content of the
report. Different reports have different options, so this page won't look the same for all reports.
the Time period page is used to choose a time interval for any DMB statistics that are contained in the
report. You can choose to display year-to-date statistics or statistics for a time interval. And you can choose
whether to use regular-season statistics or statistics from a round of the post-season.
the Sections page is used to choose which of the report's sections will be printed or saved to a file. Use
these options to conserve paper and keep file sizes small by suppressing any sections that you don't want to
include in the output.

Choosing report options

The options vary from report to report, but there are some common elements. Most reports have some options

related to scope -- which leagues, teams or players should be included. Just about all of them let you choose which
column is to be the basis for sorting the report when it first displays or when it is printed or saved to a file. The other
options are quite specific to the type of report being generated.

Choosing a time period
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DMB's database tracks statistics for the pre-season, regular season, and different rounds of the post-season. The
Use statistics for pulldown list is used to select which stage of the season you wish to use for this report.
When you have chosen the season stage, you can choose a date interval. The default is To date, which includes
everything for that season stage. But you can also click on the Interval type button to choose one of the standard
time intervals or choose a Custom range of dates.

Choosing sections

Most DMB reports include too much information to fit on one screen or one printed page. The columns in these
reports are divided up into page-sized sections. The third tab lets you choose which of these sections are to be
included when the reports is printed or saved to a file. All sections are always included when you display reports on
the screen.

What happens next
When you are happy with your options, time period, and section selections, click OK to generate the report. The
next steps depend on the Output option you selected, and these are described in the following topics:
Displaying Reports on the Screen
Printing Reports
Saving Reports to a File

Displaying Reports on the Screen
See Generating Reports for details on selecting the report you wish to generate and choosing options for that
report.
This topic discusses the things you can do with a report once you have displayed it on the screen. We'll use the
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The toolbar across the top of the window looks the same for all reports. At the left side is a pulldown list that lets
you choose a different scope for the report. In this case, because we're looking at a team batting report, this is a list
of teams. You can use this pulldown list and the left- and right-arrow buttons next to it to cycle through the teams
within the scope you selected on the report options window.
The other buttons on the toolbar do what their names suggest. Click Options to change the options for this report.
Click Memorize to memorize this report. Click Customize to customize this report.
Use the tabs in the lower-left corner to switch quickly from section to section.
In the body of the report, you'll see that the column on which the report is currently sorted is shown in red . Doubleclick on any column heading to sort the report on that column. If the report is already sorted on that column,
double-clicking on the heading reverses the sort direction.
For reports that contain player names, double-clicking on a name will display the player's player profile . For reports
that contain game results (League game results and Game log reports), double-clicking on the game will display
the boxscore, scoresheet, and/or game log if those files were saved for that particular game.

Use the Print and Print preview commands (from DMB's File menu) to print this report. If you don't want all
sections to be printed, first click the Options button and use the Sections tab to choose the sections you want.
Then choose the print command.

Printing Reports
See Generating Reports for details on selecting the report you wish to generate and choosing options for that
report.
Whenever you choose to print a report, DMB displays the standard Windows print options window:
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Use this window to choose which printer to use, whether or not you want to print all of the pages of the reports, and
how many copies of the report you would like. Click OK when you are ready to send the report to the printer.

Saving Reports to a File
See Generating Reports for details on selecting the report you wish to generate and choosing options for that
report.
Whenever you choose to save a report to a file, DMB displays the standard Windows File Save window:

DMB assumes you will want to save this file into the folder for the active database, but you can use the Save in
pulldown list to browse your hard disk and choose another location.
DMB also creates a default file name that matches the name of the report you are saving, but you can change the
File name to anything you like.
Click Save to generate the report and save it to disk.

Custom Reports
DMB comes with an extensive set of Standard Reports that enable you to see league standings, league leaders,
player and team statistics, injury and transaction logs, and game results. Many of these reports include options
that allow you to tailor those reports to your preferences. All reports can be displayed on the screen, sent to a
printer, or saved to a text file in plain-text or HTML format.
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You may find that all of your needs are met by the standard reports and the options that are available with each of
them. But you can also design your own Custom Reports and save those reports for later use.
Using the DMB report customization tools, you can:
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add, remove, and rename any section, or put the sections in a different order
remove or resequence the columns in any section
manipulate a second row of headings to a section to help clarify the data that is displayed in the columns
below (version 7 has numerous examples where an extra row of headings makes a big difference)
add a column, or change the data displayed in an existing column, choosing from virtually any piece of
information in the database, including real-life and simulated stats and the splits (left/right and others)
change the heading that appears above a column
choose whether a column is left-justified, centered or right-justified
choose the width of the column (most useful for printer and file output)
choose the default sort sequence for the column
A report can have up to 10 sections, and each section can have up to 24 columns. In many cases, it will make
sense to limit the number of columns in a section to something less than 24. If you put too many columns in one
section, you may not be able to see them all on the screen without having to scroll the report horizontally. And you
may find that the data will not fit on a single page when you print the report.

Customizing a report
To customize a report, start by displaying that report on the screen using the steps described in the Generating
Reports topic. Then click the Customize button to display the following window:

Use the Columns page to work with the columns in one section of the report, and use the Name / sections page
to add and remove entire sections.

Customizing the columns in a section
The tools on the Columns page allow you to manipulate the columns for a section. Use the For section pulldown
list to choose a section to work on, then use the buttons to add, modify, delete, move columns and extra column
headings.

Moving a column
To move a column, click on the column you want to move, then use the Up and Down buttons to change the order
in which the default columns for the report you selected appear.

Adding a column
When you click the Add button within the Columns box, DMB displays a window that allows you to choose the data
item for this column and determine how it should be formatted. See Adding a New Column for details.

Modifying a column
To modify a column, click on the column you want to modify, then click on the Modify button. DMB displays the
same window that is used for adding a column, but fills in with the information for the column you chose to modify.
See Adding a New Column for details.

Removing a column
To remove a column, click on the column you want to remove, then click on the Remove button.

Adding an extra column heading
Extra column headings appear as a second row of headings above the primary column headings. They are useful
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might have two columns with the AB heading and two with the H heading. To tell them apart, you could create extra
column headings called "Real-life" and "Simulated".
To add an extra column heading, click the Add button within the Extra column headings box. DMB displays the
following window:
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Enter the range of columns this heading is to span, the text for the heading, and how that text should be aligned,
then click OK.

Modifying an extra column heading
To modify an extra column heading, click on the heading you want to modify, then click on the Modify button. DMB
displays the same window that is used for adding an extra column heading.

Removing an extra column heading
To remove an extra column heading, click on the heading you want to remove, then click on the Remove button.

Working with sections
The tools on the Name / sections page allow you to add, remove, and rename sections:

Working with this page is pretty easy. The real work of defining a section is creating all of the columns for that
section (see above). On this page, all we need to do is name the section, choose a keyword for a section (needed
only for a few report types), and put the sections in the right order.

Moving a section
To move a section, click on the section you want to move, then use the Up and Down buttons to change the order
in which the sections are listed.

Adding a section
When you click the Add button within the Sections box, DMB adds a new section to the end of the list and gives it
the name "New". To rename this section, click on it, then enter a new Name in the Section Info box.

Renaming a section
To rename a section, click on it, then enter a new Name in the Section Info box.

Removing a section
To remove a section, click on it, then click on the Remove button.

Section keywords

For most reports, the basic structure of all sections are the same. Two reports, however, have different logic for
different sections:
in the league standings report, most sections are presented in a divisional structure, but the wildcard
standings combine all of the teams into one listing.
in the team roster report, some sections includes batters, some include pitchers and some include both
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to return to the report window. The report is immediately updated to reflect the changes you have made.
Your custom report has not yet been saved, however. When you close the report window, you will be asked
whether you want to save your changes as a custom report. Answer Yes if you want to save this custom report for
future use. DMB prompts you for a name and then saves it. The next time you use the Report > Standard,
customized, memorized command, this customized report will be displayed in the report selection window when
you click on the appropriate report type if the Custom box is checked in the Include in report list section.

Adding a New Column
The Custom Reports topic takes you through the steps involved in customizing a report.
When you click the Add button on the report customization window, the following window appears:

This window allows you to create a full description of the column you wish to add to the report.
Check Is a blank column to insert a narrow, blank column in the report. This is usually not necessary for reports
that are viewed on the screen. But when you print a report that has a right-justified column followed by a leftjustified column, those columns will appear very close together. Sometimes the report will be easier to read if you
insert a blank column between them.
The Data Item box tells DMB which piece of information from the database is to be displayed in this column. The
Presentation box describes how that item should look.

Choosing data items
The information in the DMB database is divided into groups such as batting stats, pitching stats, and player
information. The Group pulldown list includes those groups that are available for this type of report, and selecting a
group is the first step in defining a data item.
When you select a group, DMB fills the Item pulldown list with all of the items (statistics, ratings and other
attributes) that belong to the selected group. Choose the item you wish to display in this new column.
When you choose an item that is available for both real-life and your simulated DMB seasons, the Source
pulldown list enables you to indicate which source to use for this new column.
If you choose the batting splits group, you must also select a Split type. Otherwise, DMB won't know whether you
want to use batting versus left-handed pitching or pitching versus left-handed batters, or one of the other splits.

Presentation
When you choose an item for this column, DMB populates the presentation attributes with default values that are
appropriate for the selected item. In many cases, these will work very well for you, but if you want to change them,

you can.
Use the Title box to change the text that displays as the column heading.
Set the Width in characters. DMB allocates exactly this much space on reports that are printed or saved to a file.
When displaying reports on the screen, DMB translates this value into a number of pixels and sets the column
width accordingly.
Set the Alignment for the column's data to Left, Center, or Right.
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Choose whether to Sort this column in Ascending or Descending order.
When you are happy with your selections, click OK to add this column and return to the report customization
window.
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Memorized Reports
DMB comes with an extensive set of Standard Reports that enable you to see league standings, league leaders,
player and team statistics, injury and transaction logs, and game results.
Many of these reports include options that allow you to tailor those reports to your preferences. All reports can be
displayed on the screen, sent to a printer, or saved to a text file in plain-text or HTML format.
Each time you generate a standard report, DMB fills the options window with default values that we defined. You
may find that our choices work well for you most of the time. If, however, you prefer other choices for a report that
you run very frequently, you can create a Memorized Report that saves those choices.
What's the difference between a custom report and a memorized report? A custom report defines the structure
(sections and columns), while a memorized report defines the content (which teams and players to include, which
date interval to use, how to sort the report, and which options to use).
Memorized reports give you the ability to say things like "I want to be able to run the team batting report for every
team in my league, with pitchers shown as a group, and the players sorted by slugging percentage." More
precisely, they give you the ability to save those choices for future use.
Generating a standard report involves two steps -- choosing the report and choosing the options -- before the
report is displayed, printed, or saved to a file. When you generate a memorized report, only the first step is
required, since the options have been stored as part of the memorized report.
This can save you a mouse-click or two when you generate a report to the screen (and you can still change the
options via the Options button when you do this), but the real value is when you're generating reports to the printer
or a file.
Suppose you're running a league and you have a dozen reports (standard or customized) that you like to produce
for your league members at regular intervals. By memorizing these reports, you save yourself the trouble of
entering the options each time. All you need to do is select each report, choose the destination (printer, plain-text
file, HTML file) and out it comes.

Creating a Memorized Report
To memorize a report, start by displaying that report on the screen using the steps described in the Generating
Reports topic. If necessary, use the Options button to get everything just the way you want it. Then click the
Memorize button. DMB displays a window in which you can enter the name of the report and choose where it is
stored:
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If the options, including the scope information (the organization, league, team or player to be displayed), are quite
specific to the active database, select "Store this report for use only with this database". The memorized report file
will be placed in the same folder with the other files for the active database. If you choose to export the league
database and distribute it to other members in your league, these memorized reports will be transferred along with
the other files.
If your database has a structure that is very similar to that of our season disks -- one or two leagues, perhaps
linked by an organization, with 16-30 teams that are numbered from 1 to 30 -- it might make sense to "Share this
report with other DMB databases." Because memorized reports contain scope information in the form of
organization IDs, league IDs, and team IDs, the report can be generated successfully only if matching IDs are
found in the active database. That's why it makes sense to share a memorized report only if it was created with a
database where the IDs are similar to those in your other databases.
If you choose to share the memorized report, it is placed in a common folder that is visible to all DMB databases
and will appear on the list of available reports no matter which of your databases is active. This, by the way, is
where all memorized reports were stored in DMB version 8.
The list of report names already in use is provided to help you choose a unique name for your new report.
After you have named the report and chosen where to store it, click OK to save this as a memorized report. The
next time you use the Report > Standard, customized, memorized command, this memorized report will be
displayed in the report selection window when you click on the appropriate report type if the Memorized box is
checked in the Include in report list section.

HTML formatting
Whenever you save a report to a file in HTML format, whether that be a single report, a group of reports, or a
complete web site, the formatting of those HTML files is determined by the contents of a cascading style sheet that
is automatically copied into the folder where your report is saved.
If you are comfortable with HTML coding, you can edit that style sheet and thereby control the fonts and colors that
are used in those reports.
NOTE: Diamond Mind cannot provide tutoring in this area. If you are not familiar with HTML coding and the use of style sheets, please
use the DMB style sheet as-is or find someone who knows HTML to assist you.

Report Options Overview
Most Diamond Mind reports can be tailored using options that vary from report type to report type. This section
describes these options, which are always displayed on the Options page of the window that displays when you
generate a report. The Time period page and the Sections page are essentially the same for all reports, and are
described in Standard Reports.
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Scope
A common theme in these options is the selection of a scope for the report. The scope defines the league, team,
or other group of items that should be displayed.
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For example, the standings report can include all teams in a league or all teams in an organization. The batting
register report can include all players in the database, all players in a league, or all free agents. A transaction report
can include all players in the database, all players in a league, or all players on a roster.
There are two parts to defining a scope -- the type of scope you Select from and the specific selection you make
within that scope. For example, with the team batting report you could select from all teams in the league and then
make a selection of one of those teams.

Sort sequence
Another common option is the default sort sequence that controls how the report is sorted when it is first displayed
on the screen and when it is printed or saved to a file. You can, of course, double-click on any column heading to
change the sort sequence for a displayed report.

Include all teams in the output
Finally, some of the team reports have an option to include all teams. This doesn't affect how reports are displayed
on the screen, since displayed reports always show one team at a time and give you the ability to cycle through the
other teams in the scope using the arrow buttons and the pulldown list on the report window.
This option is handy for reports that are printed or saved to a file. If you elect to include all teams, the printed or
saved output includes every team in the scope you selected. If not, only the selected team is included.

Batting Register Report Options
See Reporting Options Overview for a general discussion of report options and the role they play in generating
reports, and for a discussion of the first three options on this page:

Using the checkboxes in the Role box, you can choose to display batters only, pitchers only, or both batters and
pitchers. (You must select at least one or the report will be empty.)
Using the checkboxes in the Multi-team players box, you can choose whether to display their team-specific
records, their combined records, or both. See Deleting team-specific records for definitions of these terms.
Using the checkboxes in the Batting hand box, you can choose to display any combination of left-handed batters,
right-handed batters, and switch hitters. (You must select at least one or the report will be empty.)
The Positions box allows you to limit the report to players who played a certain defensive position. Choose the
position using the Show players rated at pulldown list. To limit the report to players who played a minimum
number of games at that position, enter a value for Min games at pos. If the Primary position only box is
checked, players are included only if this was their primary position; if unchecked, anyone who has a range rating
at that position is included.
NOTE: For some seasons disks (such as our Projection Disks) that do not include real-life fielding statistics, you can change the
Min games at pos value to zero to ensure that this value will not eliminate all players from the report.

Using the values in the Plate appearances box to limit the report to players who accumulated the minimum and

maximum number of plate appearances. This is especially useful when you want to sort the report on an average
and you do not want the leaders to be a bunch of players with only a handful of atbats, and when you're searching
for the right free agent to sign and you need a player who played a lot.
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Report Groups Overview
When you generate a large group of reports with a single command, you don't want to be asked to enter the
options for each report. That would almost defeat the purpose of generating a group of reports at once. Memorized
reports, therefore, are the logical foundation for a report group because they already contain all of the options
needed to generate the report immediately.
As a result, the process of defining a group of reports begins with the creation of the memorized reports you wish to
include in the group. Creating a memorized report is very easy. Begin with either a standard or custom report,
choose the options, and when the report appears on the screen, click on the Memorize button and supply a name
for this memorized report. You can do this in a matter of seconds.
When your memorized reports have been created, you can choose the "Report groups" command, create a new
group, and add these memorized reports to that group. You choose which reports are in the group and the
sequence in which they appear.
When the report group is generated, you choose whether to send the reports directly to a printer or save them in
one or more files on your hard disk. The files can be in plain-text format or HTML format. And you have complete
control over how many files are created, which reports go into which files, and where on your hard disk the files are
stored.
Add it all up and you have almost complete control over your report groups. Because the memorized reports in the
group can be based on standard reports or custom reports, and because every report has a set of options specific
to that type of report, you control the structure and content of every report in the group. And you have a lot of
control over how the group is organized and generated.

Two Ways to Use Report Groups
One way to use report groups is to create a mixed bag of memorized reports. Perhaps you are running a league
and wish to periodically generate a diverse collection of reports with a single command. Your group might include
league leaders reports; team batting, pitching and fielding reports; game results reports; transactions and injury
logs; and a few others.
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Each of these memorized reports contains the options to be used for the report, and among those options is the
scope of the report. By scope, we mean the data to be displayed on the report. For example, is a leader board
report to include all players in the database, all players in an organization, or all players in a single league? The
scope of each memorized report can be quite different, and that's fine. DMB will generate each report using
whatever scope you specified.
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You can also create groups of similar reports for web site generation. By similar, we mean that they have the
same scope. For example, you might wish to create a group of league-oriented reports (such as standings, leader
boards, and registers) and another group of team-oriented reports (such as team batting and pitching reports,
rosters, injury and transaction logs for a single team).
You gain a certain measure of flexibility when you create groups that are comprised of memorized reports with
similar scope. At the time you generate the group, you can tell DMB which league or organization or team you wish
to use, and DMB will use that scope information for each report in the group. This way, you can create a group and
use it in many ways.
In summary, there are times when you want to create a group of mixed reports, where the scope information can
vary from one report to the other, and where the main advantage is in your ability to generate a variety of reports
with a single command. And there are times when you want to create a group of similar reports, where the main
advantage is to be able to choose different scope information each time you generate the group.

Generating a report group
When you choose the Report group command from the Reports menu, the following window appears:

To Generate a report group:
1. Click in the list of report groups to select the group you want to generate.
2. Choose one of the output options. You can save the reports to a file in HTML format, save the reports to a
file in plain-text format, or send the reports directly to a printer.
3. If you chose to save the reports to a file, specify the name of the folder where you would like to write the files.
You can either type the full path of that folder or click on the ellipsis (...) button to choose a folder.
4. If you're saving to a file in HTML format, you can choose the extension (typically .htm or .html) to use for all
the reports.
5. When you are happy with your choices, click the Generate button.

5.

Choosing the scope
After you click on the Generate button, DMB displays a scope dialog.
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There are two main uses for report groups. A group can consist of a mixed bag of different reports or a collection
of reports that have similar scope.
If the selected report group contains many different types of reports, you should choose NOT to override the scope
information that is contained in those reports. This enables you to generate, in a single command, a diverse set of
reports.
If the selected report group contains memorized reports that have similar scope -- that is, a group of leagueoriented reports or a group of team-oriented reports -- you can override the scope information that is stored in
those memorized reports. This way, you can generate a group of team reports for team A and then do it again for
team B, without having to change the memorized reports that make up the group.

Viewing reports that are saved to a file
If you choose to save the reports to one or more files, you can browse those files using Windows Explorer or My
Computer.
The formatting of HTML files is determined by a cascading style sheet that comes with DMB and which is
automatically copied into the folder into which your files are saved. If you are comfortable with HTML coding, you
can modify this style sheet to use your own fonts and colors.

Creating and Modifying a Report Group
When you choose the Report group command from the Reports menu, the following window appears:

To create a new Report Group, click on the New group button. To modify an existing Report Group, click on the
report to select it and then click on the Modify group button, or just double-click on the name of the report you wish
to modify.
Whether you are adding or modifying a group, DMB displays the following window:
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If you are creating a new report group, enter a name at the top of the window. If you are modifying an existing
group, you can change its name at any time.
The memorized reports that make up the report group are displayed in two columns on the Modify Report Group
window. The first column shows the name of the memorized report and the second column shows the name of the
output file into which that report will be saved.
To create or modify the reports that make up the group, use the Add report, Modify report, and Remove report
buttons.
NOTE: Removing a memorized report does not delete that report, it only takes it out of the group.

The Up and Down buttons are used to change the sequence in which the reports are generated. To change the
sequence, click on the report you wish to move, then click on the Up or Down buttons until it is where you want it.
Adding a report to a report group

Adding a Report to a Report Group
When you click on the Add report button of the Modify Report Group window, DMB displays the following window:

Use the Report name drop down list to select one of the available memorized reports. This list includes memorized
reports that ship with DMB and any memorized reports that you may have created.
In the Output file name box, enter the name of the file into which this report is to be saved. If you enter a unique
name, this will be the only report that is saved into this file. If you enter the same name for more than one
memorized report in this group, this report will be added to the others that share this output file name. In this way,
you can control whether all of the reports are saved to a single output file, to one file per report, or to a mix of
single-report files and multi-report files.

Overview of Web Site Generation
The web site generator provides you with a lot of flexibility. You specify whether you want to generate a site for an
organization (two related leagues) or a single league. You specify up to three report groups, one for any
organization reports you wish to generate, one for league reports, and one for team reports.
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generate a comprehensive web site without having to set anything up first.

However, if you want to have control over the content of your site, you can do that by substituting your own report
groups for the standard ones. In this way, you can remove any reports you're not interested in and add memorized
versions of your own custom reports.

UNREGISTERED VERSION OF CHM TO PDF CONVERTER STANDARD BY THE
The web site generator optionally includes any boxscore files that have been saved for your league.

To tie everything together, the generator produces an index page for the organization (if applicable), each league,
and each team. Each of these index pages includes links to the others and links to every report that was generated
for that organization, league or team. In addition, if your report groups include game results reports, those reports
contains links to the boxscore/scoresheet/gamelog file for each completed game.

Generating a web site
When you choose the Web site generation command from the Reports menu, DMB displays the following window:

The Scope and Selection controls enable you to specify the organization or league for which you'd like to generate
the site.
The controls in the Report groups to include box determine the web pages that are generated.
If you want the site to include organization reports (such as organization-wide standings and leader boards), check
the Organization reports box and use the adjacent drop-down list to choose a report group that identifies the
organization reports to be generated.
If you want the site to include league reports (such as standings, leader boards, and injury logs), check the League
reports box and use the adjacent drop-down list to choose a report group that identifies the league reports to be
generated.
If you want to include one or more reports for each team, check the Team reports box and use the adjacent dropdown list to choose a report group that identifies the team reports to be generated.
If you want any game results or game log reports to be linked to the related boxscores, scoresheets, and game
logs, check the Boxscore files box. These links are generated only if boxscores, scoresheets, and/or game log
reports were saved at the time the games were played.

Use the Write files to control to enter a path to the folder into which the generated HTML files are to be placed.
You can type the path or click on the ellipsis button to select a folder graphically.
NOTE: If you want to create a new folder in which to store web files, you must type in a path. Clicking on the ellipsis to browse
will only allow you select a folder that was previously created.

Use the Top-level page name field to name the file that acts as your web site's index. Typically, this file is called
index.htm.
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The formatting of the HTML files is determined by a cascading style sheet that comes with DMB and which is
automatically copied into the folder into which your files are saved. If you are comfortable with HTML coding, you
can modify this style sheet to use your own fonts and colors.
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Transfers: Overview
Many DMB owners participate in leagues with other owners of the game. It's a great way to increase your
enjoyment by testing your skill at drafting players, negotiating trades, and managing your team in league games.
And it's also a great way to get to know other baseball fans from around the country and the world.
There are a few of these leagues where all of the managers live near each other and can get together to play
league games on a single computer. But most leagues use more than one computer to play the games because
the league members are widely dispersed. Even local leagues often use more than one computer so they can be
playing more than one game at the same time.
The commands on the Transfer menu provide you with the tools you need to run a league or play in a league
where games are played on more than one computer. These tools enable you to transfer game results, statistics,
injury reports, transaction reports, roster moves, and manager profile changes to they can be consolidated into a
single DMB database and shared with the rest of the league members.

Terminology
In these topics, we'll use the term Commissioner to refer to the person who runs the league, the one who
maintains the master copy of the League Database and periodically sends updates of this database to league
members. And we'll use the term Manager to refer to the other members of the league, the ones who play the
games. Of course, in most leagues, the Commissioner is also a Manager, but even if it's the same person, we'll use
these terms to describe the role he is playing at a given moment.
And we'll use the term Play Cycle to describe a period of time that begins with the Commissioner sending out an
updated league database, the Managers playing one or more series and then exporting the results of those series,
and the Commissioner importing those results into the master copy of the league database.

Guidelines and Limitations
Some limits are necessary in order to make sure that the results of a Manager's games can be successfully
imported into the League Database. If Managers were empowered to do anything they wanted to, the rosters and
other information in their copies of the League Database would soon become out of synch with the master copy
that is administered by the Commissioner.
The Commissioner is the only person who should make changes that affect which players are on which rosters.
The Commissioner sets up the rosters and carries out any trades that are made before or during the season. When
the results of a Play Cycle are imported into the League Database, the team rosters are checked for compatibility,
and if those rosters do not agree, the results are rejected. The best way to ensure that results can be imported
successfully is to have the Commissioner make all such player moves (trades, signings, releases) on the League
Database between Play Cycles.
Managers can freely change the status of the players on their rosters -- moving players between the active roster,
the disabled list and the reserve roster. And they can make any changes they want to their manager profiles. These
changes will be successfully transferred to the League Database provided that players have not been added to or
removed from the roster during a Play Cycle.

Copyright Violations

DMB Season Disks are copyrighted products. This means that you are breaking the law if you send a copy of
your League Database to anyone who does not already own the DMB game and the DMB Season Disk upon
which your league is based.
Suppose, for example, you are serving as Commissioner of a league based on the 2003 Season Disk. If you send
copies of your League Database to the Managers in your league, you must ensure that those Managers are legal
owners of DMB version 9 and the 2003 Season Disk. If not, you will be distributing copyrighted material illegally.

We can help you make sure that you are not inadvertently sending illegal copies of our copyrighted products to
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people who are not entitled to receive them. Send us a list of the Managers in your league, or tell us where to find
that list on your league's web site, and we'll check our database of registered owners. We'll get back to you within a
couple of days if there are people on your Manager list who are not entitled to receive the League Database.
In summary, we want you to play in leagues, and we want to make it as easy as possible for you to operate and
play in those leagues. Use
the Transfer tools
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DMB owners in good standing.

Non-commercial Use
Diamond Mind Baseball and related Season Disks are licensed for non-commercial use only. Running a business,
no matter how small, in which you charge fees to play in DMB leagues is a violation of our license agreement.
Some DMB leagues collect dues to cover out-of-pocket expenses such as phone bills, postage, and web site fees.
That is a very reasonable thing to do and does not violate our license agreement provided that the leagues are run
as a hobby and nobody is making a profit or getting paid for their time.

Flow of Information
At the beginning of a Play Cycle, the Commissioner distributes an updated League Database that contains
everything that has happened to that point in the season. When a Manager installs this updated League Database,
he can view game results, look at any of the other reports (standings, leader boards, player stats, injury reports,
and so on), update his manager profile, and play the games he's assigned.
At the end of the Play Cycle, the Manager exports the results of those games together with updated manager
profiles (for the teams involved in his games) and any transactions (promotions, demotions, disabled list moves)
that have been made. The information is written into a single Transfer File that is sent to the Commissioner by
email or some other method. The Commissioner imports those results along with those of the other managers.
Whenever a Play Cycle is longer than a single series, the same team can be playing games on different computers
in the same Play Cycle. That means that no one copy of the League Database contains all of the information
necessary to track time-dependent data such as hitting streaks and fatigue. If your league has turned on the option
to save game-by-game statistics, this time-dependent data can be reconstructed by the Commissioner at the end
of each Play Cycle by scanning the game-by-game logs.
The Transfer menu also includes a command for rebuilding the database indexes. Most of you will never need to
use this feature because it is done automatically. League Databases can grow to be very large, and larger files
make for longer download times at the beginning of a Play Cycle. To keep those download times as short as
possible, Diamond Mind Baseball:
automatically compresses and uncompresses the League Database files

THE

gives you the option to exclude the game-by-game logs.
sends only the data files and automatically rebuilds the indexes of those files at the other end
To repeat, the rebuilding of the index files is automatic and is something you will probably never need to do. But the
command is there just in case it needs to be done.

Setting up the League
Before a Commissioner distributes the League Database at the beginning of the season, it is important to make
sure that the right options have been selected for the league or organization.
To set these options, use the View>Organizer command to open the Organizer window, click on the Leagues tab,
double-click on the League
you wish to modify,
then TO
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window. (If your setup includes two leagues that are linked by an Organization, go to the Orgs tab instead.) The
options tab looks like this:
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We recommend that you choose Always for the options to automatically save boxscores and scoresheets. It
doesn't matter which boxscore format you choose.
We also recommend that you check the Game-by-game statistics box. Without this, the DMB database will not
include the information needed to generate reports for a time interval, and you will not be able to use the Update
streaks and usage command.

NOTE : You MUST check the Game account box. Without this, DMB will not save the information about each game that allows
that game to be transferred using the Export statistics and Import statistics commands.

The Transactions and lineups option should almost always be set to Do not use transactions and lineups .
Most DMB leagues (that transfer statistics) use rosters that have nothing to do with where the players played in real
life, so any attempt to use real-life transactions and game-by-game lineups is meaningless.
You can choose whatever settings you like for the other league rules.

Exporting a League Database
Before using this feature, see Transfers: Overview for important information about the process of distributing
league databases for the purposes of running a DMB league.
At the beginning of a Play Cycle, the Commissioner uses the Export league database command to create a single
transfer file that can be sent
to the Managers
the league.
This
transfer
file is compressed and
has a ".zip"
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To export a league database:
1. Click Transfer on the DMB menu bar and select Export League Database. The following window will appear:
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2. The default location where the transfer file will be written is the export folder that is contained within the folder
that stores the active database. Use the Save in pulldown to choose another location if you like.
3. In the File name field, enter a name for the transfer file that will holds the exported database. DMB chooses a
default name that matches the name of your active database.
NOTE: You cannot select a Save as type because DMB requires that the transfer file have the .zip extension.

4. Click Save.
5. If your organization or league is set up to automatically save boxscores, scoresheets, game logs, and/or gameby-game statistics, the following options window appears (if not, the export begins immediately):

If these boxes are checked, the transfer file will be much larger than if you exclude these items.
If you exclude the game-by-game statistics, the Managers in the league will not be able to generate reports based
on time intervals (by month, last 7 days, and so on), but will still have all of the information they need to generate
reports using the full year-to-date statistics.
If you exclude the boxscores, scoresheets, and game logs, Managers will not be able to look at these items for
games that were played on other computers. But the transfer file will be much smaller and, if it is sent electronically,
much faster to download.
When the export begins, you will see status bars indicating the progress of the export, and you will be notified when
the export is complete.

Installing a League Database
Before using this feature, see Transfers: Overview for important information about the process of distributing
league databases for the purposes of running a DMB league.
At the beginning of a Play Cycle, the Commissioner uses the Export league database command to create a single
transfer file that can be sent
to the Managers
the league.
This
transfer
file is compressed and
has a ".zip"
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WARNING! Installing a DMB database overwrites any existing data in the active database. Make sure you have the right
database as your active database before using this command.

UNREGISTERED
VERSION OF CHM TO PDF CONVERTER STANDARD BY THE
The first time a Commissioner exports the League Database at the beginning of the season, use the Create
league database command to install it. This will create a new DMB database in which to store the League
Database for the new season, leaving the contents of your active database alone.
After that, when the Commissioner exports the League Database with the latest results from your league, use the
Install league database command to replace the previous version of that league database.
To install a league database:
1. Use the File>Change active database to make sure your copy of the league database is currently shown as the
active database.
2. Click Transfer on the DMB menu bar and select Install league database. The following window will appear:

3. By default, DMB assumes that you placed the transfer file to be imported in the import folder that is contained
within the folder that stores the active database. But the file may actually be somewhere else on your hard disk. If
you received this transfer file from the Commissioner as an attachment to an email message, the file may be in the
folder where your email attachments are stored. If the transfer file is not already in the import folder, use the Look
in pulldown to browse your hard disk and locate the transfer file.

4. Click on the name of the transfer file, then click Open. You will be asked if you are sure you wish to continue with
the operation since the installation will overwrite any player data in the currently active database. If you wish to
continue, click Yes. Clicking No will abort the installation process.
You will see status bars indicating the progress of the install, and you will be notified when the installation is
complete.

Creating a League Database
Before using this feature, see Transfers: Overview for important information about the process of distributing
league databases for the purposes of running a DMB league.
At the beginning of a Play Cycle, the Commissioner uses the Export league database command to create a single
transfer file that can be sent
to the Managers
the league.
This
transfer
file is compressed and
has a ".zip"
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THE

WARNING! Using Install league database overwrites any existing data in the active database. Make sure you have the right
database as your active database before using this command.
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The first time a Commissioner exports the League Database at the beginning of the season, use the Create
league database command to install it. This will create a new DMB database in which to store the League
Database for the new season, leaving the contents of your active database alone.
After that, when the Commissioner exports the League Database with the latest results from your league, use the
Install league database command to replace the previous version of that league database.
To create a league database:
1. Click Transfer on the DMB menu bar and select Create league database. The following window will appear:

2. This window allows you to browse your hard disk to find the transfer file that was sent by the Commissioner.
When this window first opens, it shows the files in the folder in which DMB is installed (which will be C:\DMB9 for
most of you). The image above shows how the window might look if you had used the Look in pulldown to open the
folder in which you typically store your email attachments, and then clicked on a the transfer file for the WIBL
league.
3. Click on the name of the transfer file, then click Open. DMB displays a window allowing you to choose a location
and name for the new database to be created:

NOTE: The default location for the new database is the folder where you installed Diamond Mind Baseball. If you would like to
create your new database at another location, click on the ellipsis (...) button to open the following screen.

4. When you have chosen a location and name for your new database, click OK to install it.
You will see status bars indicating the progress of the install, and you will be notified when the installation is
complete.

Exporting Statistics
Before using this feature, see Transfers: Overview for important information about the process of distributing
league databases for the purposes of running a DMB league.
At the end of a Play Cycle, a Manager uses the Export statistics command to create a single transfer file that can
be sent to the Commissioner.
This transferOF
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This command actually exports more than statistics -- it also includes manager profiles, game accounts, and
transactions. So the process of exporting statistics involves three forms.

Manager Profiles
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When you click Transfer on the DMB menu bar and select Export statistics, the following window appears:

When this window first appears, the selected teams are the ones that have been involved in the games that you
played during this Play Cycle. It's usually best to include the manager profiles for these teams and to leave out the
manager profiles for teams that did not play any games in this Play Cycle.

But you can use the standard techniques for choosing multiple items from a list, plus the Select All and Deselect
All buttons to choose the teams for which you wish to export a manager profile.
When you include a team's manager profile, DMB also includes the team's roster, so if you have promoted or
farmed any players on that team, their new status will be communicated back to the Commissioner.
When you have finished selecting manager profiles, click Next to move to the next step.

Game Accounts
The next form displays the list of games that were played during this Play Cycle.

Most of the time, these are exactly the games you want to export, so all you need to do is click the Next button to
continue.
You can, however, click the Logged games button to display games that were played before the beginning of this
Play Cycle (and have already been logged by the Commissioner). Or click the All games button to show both
groups of games.
You can use the standard techniques for choosing multiple items from a list to choose the specific game accounts
you wish to export. You may need to do this if the Commissioner asks you to resend some games that you had

previously exported.
Click the Next button to continue or the Back button to return to the manager profile form.

Transactions
The next form displays the list of transactions that were made during this Play Cycle.
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Most of the time, these are exactly the transactions you want to export, so all you need to do is click the Finish
button to continue.
You can, however, click the Logged transactions button to display transactions that were made before the
beginning of this Play Cycle (and have already been logged by the Commissioner). Or click the All transactions
button to show both groups.
You can use the standard techniques for choosing multiple items from a list to choose the specific transactions you
wish to export. You may need to do this if the Commissioner asks you to resend some transactions that you had
previously exported.
Click the Finish button to continue or the Back button to return to the game account form.

Exporting
When you click the Finish button, DMB displays a screen that allow you choose a name and location for the export
file:

The default location where the transfer file will be written is the export folder that is contained within the folder that
stores the active database. Use the Save in pulldown to choose another location if you like.
In the File name field, enter a name for the transfer file that will hold the exported information. You cannot select a
Save as type because DMB requires that the transfer file have the .zip extension.

Importing Statistics
Before using this feature, see Transfers: Overview for important information about the process of distributing
league databases for the purposes of running a DMB league.
At the end of a Play Cycle, a Commissioner uses the Import statistics command to import each of the transfer
files that have been sent VERSION
in by the Managers
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This command actually imports more than statistics -- it also includes manager profiles, game accounts, and
transactions. So the process of importing statistics involves three forms.
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Choosing the transfer
file
To import statistics, click Transfer on the DMB menu bar and select Import statistics. The following window will
appear:

By default, DMB assumes that you placed the transfer files to be imported in the import folder that is contained
within the folder that stores the active database. This is a convenient place to store these files before you import
them, but you don't have to use this folder if you don't want to. To import files that are in other locations, use the
Look in pulldown to browse your hard disk.
When you have found the right folder, click on the name of the transfer file, then click Open. DMB scans the
transfer file and displays the first of three forms that show the contents of the transfer file and allow you to choose
whether to import some or all of those items.

Manager profiles
The first form lists the manager profiles that are included in the transfer file:

When this form first appears, all of the profiles in the transfer file are selected, and if you click on Next, all of them
will be imported. You can use the standard techniques for choosing multiple items from a list, plus the Select All
and Deselect All buttons to choose the profiles you wish to import.
When you have finished selecting manager profiles, click Next to move to the next step.

Game accounts
The next form displays the list of games that are included in the transfer file:
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Most of the time, you will want to import all of these games, so all you need to do is click the Next button to
continue.
You can, however, click the Logged games button to display games in the transfer file that have already been
logged into the master copy of the league database. Or click the All games button to show both groups of games.
You can also use the standard techniques for choosing multiple items from a list to choose the specific games you
wish to import.
NOTE: If you choose a game that has not already been logged into the master copy of the league database, that game will be
added to the database. If you choose a game that has already been logged, that game will besubtracted from the master copy
of the league database. You can use this technique to back out the results of a game that was imported in error.

Click the Next button to continue or the Back button to return to the manager profile form.

Transactions
The next form displays the list of transactions that were found in this transfer file:

Most of the time, these are exactly the transactions you want to import, so all you need to do is click the Finish
button to continue.
You can, however, click the Logged transactions button to display transactions that have already been applied to
the master copy of the league database. Or click the All transactions button to show both groups.
You can also use the standard techniques for choosing multiple items from a list to choose the specific transactions
you wish to import.
NOTE: When you are importing a transaction, you are really just importing a record of a transaction that has already been made
for the purposes of including in a transaction report. Importing a transaction does NOT cause the transaction to be made in the
master league database.
NOTE: These transactions should not include any moves that involve moving a player from one roster to another -- those moves
should only be made by the Commissioner and should only be done between Play Cycles.See Transfers: Overview for more
information on how to manage transactions.

Click the Finish button to continue or the Back button to return to the game account form. Clicking the Finish
button is DMB's signal to begin importing the contents of the transfer file.
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Rebuilding Database Indexes
It is unlikely that you will ever need to use this feature. It doesn't do any harm, but it will be necessary only if
something goes wrong with the indexes that allow DMB to find information in your database very quickly.
We included this command on the Transfer menu only because a transfer file created by the Export league
database command (also on the Transfer menu) does not include the indexes. These indexes are automatically
rebuilt by DMB when the Manager uses the Create league database or Install league database command. In the
unlikely event that the indexes do not get rebuilt correctly, you can use the Rebuild database indexes command
to force them to be rebuilt.

Updating Streaks and Usage
When you play games within a single DMB database, DMB continually updates the database with current
information about injuries, pitcher and catcher usage, and hitting streaks. All of this information is time-dependent,
so when games are played out of order or imported from several different computers, these values may be
incorrect.
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At the end of a Play Cycle, after a Commissioner has imported all of the transfer files that were sent in by the
Managers in the league, the Commissioner can run the Update streaks and usage command to scan the games
in the order they were scheduled and rebuild all of these time-dependent values.

NOTE: This command works correctly only if you are saving game-by-game statistics for your league or organization. It is these
game-by-game records that allow DMB to ascertain when players were used and when hitting streaks occurred. See Leagues:
Rules and Options for more on this setting.
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Restarting a Season
You can restart a season for a selected league or organization by using the Restart Season feature.
To restart a season:
1. Click Tools on the DMB menu bar and select Restart a season. The following window will appear:

2. Use the pulldown to select the organization or league whose season you want to restart.
3. Click OK. You will be asked to confirm that you wish to restart the season for the selection you have made.
4. Click Yes. All team and player statistics are reset to zero. All game-by-game statistics, injury logs and DMB
transaction logs are erased. Any boxscores, scoresheets, and game logs that you saved are erased. In summary,
you're ready to start playing the season again.
NOTE: Team rosters are handled differently depending on the Play Mode you selected for your league before the season
started. If you played the season with the real-life transactions feature turned on, all roster status codes are reset to their
opening-day values and all real-life transactions are marked as unprocessed. Any players who were traded in real-life remain on
their original rosters. If, on the other hand, you played the season without using the real-life transactions feature, and if you made
your own trades during the season, these players are not automatically returned to their former teams.

Resetting player usage
At any time during a season, you can use the Reset player usage command to wipe out any accumulated injuries
or fatigue information.
This is often not a good idea because it could allow players to be used more than they should. But we know there
are some leagues whereVERSION
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To reset player usage, choose Reset player usage from the Tools menu. DMB displays the following options
window:
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Use the Scope and Selection pulldown lists to choose the team or teams for which you would like to do this. Then
check one or both of the Reset usage and Reset injuries boxes to reset the information you want.

Trading Players
You can use the Trade Players feature in DMB to conduct player trades between any teams in your database.
To trade players:
1. Click Tools on the DMB menu bar and select Trade Players. The following window will appear:

2. Use the pull down lists at the top of this window to select the two teams that you want to involve in the trade. The
players for each of the teams you select will appear in the areas below the teams.
3. Select the player(s) from each team you wish to trade by clicking on their names and clicking the button labeled
Add that is below this team's list of players.
NOTE: You can select more than one player at a time by holding down the Ctrl key and clicking on their names. You can remove
a player from the trading areas by selecting his name and clicking the button labeled Remove below his team.

4. When you are ready to make the trade, click the button labeled Make Trade. You will be asked if you are sure if
you want to make the trade.
5. Click Yes to confirm the trade. You will be notified when the trade is complete.

Releasing Players
If you are preparing to draft new rosters, use the Release Players command to quickly release all of the players
from one or more teams into the free agent pool. However, if you wish to release one player, or just a few players,
use the Roster / manager profile window to select those players and release them individually.

To release players:
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1. Click Tools on the DMB menu bar and select Release all players. The following window will appear:
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2. Use the pull down labeled Scope to select whether you want to release the players from a single team, all the
teams in a league, all the teams in an organization, or all of the teams in your database.
The options available in the pull down labeled Selection will change depending on the scope of your release. If you
are releasing players from a single team, you can select the team. If you elect to release all of the players in a
league, you must select the league, etc.
3. Click OK. You will be asked if you are sure you want to complete the release. There is no "undo" available for
this action.
4. Click Yes to confirm the release.

Deleting team-specific player records
In most cases, the statistics and ratings represent that player's performance in one season, but that is not always
true. If a player was traded or released during a season, he may have statistics for more than one team. In those
cases, you may find more than one record for that player in your database -- one for each of his real-life teams (we
call these team-specific records) and one for his overall performance (we call these combined or composite
records).
When Diamond Mind creates a Season Disk, it places the team-specific player records on the appropriate team
rosters and puts the combined player records into the free agent pool.
If you release players from one or more teams, you may end up with a free agent pool that contains more than one
record for the same player. That doesn't do any harm, but there are two situations where you might want to delete
the team-specific records and leave only the combined records:
if you are preparing to use the DMB drafting system and you want the computer GM to consider only the
combined records when choosing players.
if you are running a DMB league and want to make sure that each player is represented only once in the
database.
To delete team-specific player records, click Tools on the DMB menu bar and select Delete team-specific
records. Because these deletions are permanent and cannot be reversed, DMB asks whether you are sure you
want to do this. Click Yes to proceed.

Generating Manager Profiles
You can generate manager profiles using the Roster / manager profile window or using the Generate manager
profiles command on the Tools menu.
To do this from the tools menu:
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1. Click Tools on the DMB menu bar and select Generate manager profiles. The following window appears:
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2. Use the pulldown list labeled Scope to select whether you want to generate manager profiles for a single team,
all the teams in a league, all the teams in an organization, or all of the teams in your database.
The options available in the Selection pulldown list will change depending on the scope you chose. If the scope
was a single team, select the team. If the scope was all teams in a league, select the league. And so on.
3. Click OK. DMB displays a window through which you can choose the portions of the profiles you wish to
generate and options that guide the generator. These options are described in the Manager profile generator topic.

Bullpen Warmup Rule
If you elect to use the Bullpen Warmup Rule for a game you must send your pitcher to the bullpen prior to putting
him on the mound. The following rules will apply:
A relief pitcher must be warmed up for two batters before he is at full strength. If he is brought into the game
before he is ready, he is not at his best for the first batter or two.
A pitcher who warms up four or more times in a game will be tired when he enters the game.
At the end of a half-inning, any pitcher who was warming up for the defensive team sits down while his team
is at bat.
At the end of a half-inning, any pitcher who was warming up for the offensive team continues to warm up.
This pitcher is available to be brought in during the team's defensive half-inning.
The time between half-innings counts as one batter faced for determining whether the pitcher is warm
enough. This applies only to pitchers who are warming up for the offensive team, since the defensive team's
pitchers automatically sit at the end of each half-inning.
If a pitcher is injured, the warm-up rules do not apply. Any pitcher may be brought in, and is given enough
time to warm up properly.
These rules mean that you must think ahead. If you want to bring in a new pitcher for the next inning, you must
warm him up while your team is at bat. While on defense, you must think at least two batters ahead. And you
cannot warm pitchers up all the time, just in case, without tiring out your staff.
NOTE: The bullpen warm-up rule does not apply to teams handled by the computer manager.

Catcher fatigue
The catcher fatigue system is designed to ensure that you limit your starting catcher to about 85-90% of total
playing time. It does so by monitoring usage within a moving ten-day window as the season goes along.
If you're in a stretch where your team has no days off, your catcher will almost certainly get tired if you start him ten
games in a row. Giving aVERSION
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A catcher's workload is determined on a batters-caught basis. In a modern season, a team typically faces about
6250 batters over a 182-day schedule. That's about 344 batters per ten day period, and because we try to limit
catchers to 85-90% of total
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If a catcher is used more than this, he will be less productive as a hitter and fielder, with the penalty being greater
the further the catcher is over the limit. The penalty is very severe if you let someone catch every inning of every
game, so it's not something you'd want to try on a regular basis.
Using a catcher at another position (including designated hitter) is equivalent to giving him the day off, but you
need to do this in advance. If you catch him too much and he gets tired as a result, you can't play him at another
position the next game without penalizing him at the plate. But if you play him somewhere else once in a while, that
will help keep him rested in the first place.

Clutch and Jam Ratings
All DMB batters have Clutch ratings and all DMB pitchers have Jam ratings. Both ratings are used to raise the level
of performance in the late innings of close games. DMB gives out a limited number of good clutch and jam ratings
each season, and these players are more valuable in those late-inning situations.
But the baseball research community has yet to find any compelling evidence that certain players are able to raise
their game consistently in these situations. The evidence seems to suggest that any apparent clutch performance
is an illusion, that the laws of chance predict that some players are going to be up, some down, and some normal
when you choose any subset of 50-60 atbats out of his total for the season. So the fact that a player raised his
game in the 50-60 atbats that fit the late-inning-close-game definition probably means he was just lucky.
Consequently, we give you the option to use the clutch ratings or to turn them off. If you use them, batters and
pitchers with better-than-normal clutch and jam ratings will be a little better than usual in the late innings of close
games. But this isn't a strong factor in the design of the game, so we recommend that you avoid placing a lot of
weight on these ratings when making your decisions. It's rarely a good idea to use a weaker player over a better
one just because the weaker player may have a better clutch or jam rating.

Player Status Codes
The lineup selection window displays a status code for every player that indicates his availability for the current
game, as follows:
Code

Meaning

A

Available

E

Has been ejected from the game

I

Injured and cannot be used

O

Over pro-rated time limit

R

Warmed up and ready to pitch

T

Tired, but may be used

U

Used in this game and cannot be used again

W

Warming up in the bullpen

X

Held out of the game to prevent over-use
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Currently playing

The 'X' status code appears in two situations:
if you have used the "Make player ineligible" command, or
if your pitching profile is in Time mode and the computer manager has marked a pitcher as being ineligible to
enter the game in relief because he's ahead of his pace for relief appearances

Playing out of postion
You can use a player at a defensive position for which he is not rated, but his performance will suffer. How much?
It depends.
Players can make a relatively painless transition to an easier position that is similar to one they're already rated for.
The penalties are much greater for moving to a very different position that is also more difficult to play.
For example, a CF can play LF or RF without suffering much at all. Both positions are similar and easier than the
one he's rated for. A LF or RF moving to CF has a more difficult time because there's more ground to cover.
Similarly, a move from SS to 2B won't cost you too much, while a move from 2B to SS will hurt more. And the
moves that will hurt the most are (a) from any position to catcher, (b) a catcher moving to any position except 1B,
and (c) a 1B moving to CF or another infield position.
How will these penalties show up? In lots of ways. More balls in their zones will go for hits. They'll make more
errors. Guys without outfielder throwing or catcher throwing ratings will be easier to run on. Unrated catchers will
have more passed balls. Unrated middle infielders won't start as many double plays on balls hit to them, and they
won't turn two as often when they're the pivot man on the play. Pitchers without hold ratings will be easier to run on.
You might ask why we apply penalties even when a player is moving to a less difficult position. Couldn't a top-rated
SS play 2B as well or better than the average 2B? In the many years that we've been assigning fielding ratings,
we've seen a lot of players get higher ratings when they make the transition from a harder position to an easier one
(especially SS -> 2B, 3B -> 1B, and CF -> LF), but we've also seen plenty of cases where the player needed some
time to learn how to play the new position.
Every position requires mastery of a different set of skills. A CF moving to RF needs to learn how to play the
caroms on balls hit down in the corner. A 3B needs great reflexes to handle the hot smashes that come his way,
and that might not be the strong suit of a middle infielder moving to 3B. A SS moving to 2B must learn how to make
the pivot with his back to the runner.
If our out-of-position adjustments assumed that every player could instantly adapt to a new position, even an easier
one, we think it would create too many opportunities for managers to abuse the game by moving players around in
ways that real-life managers would never get away with. So the game imposes penalties of varying degrees on all
out-of-position players.

Reading the Scoresheet
This tutorial describes the notation used for all plays on the scoresheet. With this type of scoresheet, all plate
appearances are assigned a unique code. After all of the plays are listed, there is a summary of which
appearances a pitcher was used for, so you can see exactly which batters were faced by each pitcher.

Click here to view a sample
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Plate appearance codes

On the scoresheet, the plate
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letters indicate which pass through the batting order this is (A is the first time, B the second, etc.) and the numbers
indicate the batting order position. Thus, A4 is the cleanup hitter's first time up and E8 is the 8th batter's fifth trip to
the plate.
The pitcher summary at the end of the scoresheet shows the appearance codes when the pitcher entered the
game and when he left the game. This section also shows the number of earned runs he allowed.

The three parts of a play
On the scoresheet, the outcome of a play is divided into a result, an explanation, and advances. There is always a
result. If there is an explanation, it appears after the result and starts with a slash. If any runners advanced or were
put out on the play, this is shown after a period. If more than one runner advanced or was put out, a semicolon
separates the advances.
For example, the play 643/gdp.3-H;2-3 is interpreted as:
Part

Description

643

Result

/gdp

Explanation

3-H

Advancement of runner on 3rd

2-3

Advancement of runner on 2nd

New Innings
The n> symbol next to a play on the scoresheet indicates that this is the first play of a new inning with n being the
number indicating what inning is starting. Thus 8> indicates the start of the 8th inning, 5> the start of the 5th inning,
and so forth.
NOTE: In order to conserve space, only the last digit of innings after the 9th inning (if played) are displayed. Thus 4> would be
used to indicate the start of the 4th, 14th, and 24th innings.

Defensive Position Numbers
On the scoresheet, all defensive positions have a number that is used to indicate which fielders handled the ball on

any play where an out is recorded:
#

Abbreviation

Position Number

1

p

Pitcher

2

c

Catcher

3

1b

First baseman

4

2b

Second baseman

5

3b

Third baseman

6

ss

Shortstop

7

lf

Left field

8

cf

Center field

9

rf

Right field

Hits
Hits are indicated by the following values:
Play

Description

S

Single

D

Double

T

Triple

HR

Home run

Fly Balls
On fly balls, popups, and line drives, only one fielder is involved, so only the number of the player making the catch
is shown on the scoresheet. Explanations are added for sacrifice flies, line drives, double plays, and triple plays.
Here are some examples:
Play

Description

7

Fly ball caught by the left fielder

3

Popup caught by the first baseman

8/SF.3-H

Sacrifice fly to center; runner scores from third

4/L

Line drive to the second baseman

5/ldp

Line drive to the third baseman who catches it and steps on
the bag for a double play

53/ltp

Line drive to the third baseman who steps on third for the
second out and throws to first for the triple play

Ground Balls

On ground balls, there may be more than one fielder involved. In this case, the number of each fielder is shown in
the order they touched the ball. Explanations are added for force plays, double plays, and bunts.
For example:
Play

Description

53

Grounder fielded by the third baseman and thrown to first for

64/f

Grounder fielded by the shortstop and thrown to second for the
force out

163/gdp

Grounder to the pitcher, thrown to the shortstop first for a
ground ball double play

out
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43/gdp
Grounder
to the second
who steps
second for the
force and throws to first for the ground ball double play
3/g

Grounder to the first baseman, who steps on the bag for the
out (Without the "g", this could be confused with a popup)

16/b

Bunt to the pitcher, who throws to the shortstop for the out at
second

52.B-1

Grounder to the third baseman, who throws to the catcher for
the out at home while the batter takes first

Stealing
Steals are indicated by SB if successful, and CS if not, followed by the base being stolen. When an out is made,
the fielders who made the play are shown in parenthesis.
Here are some examples:
Play

Description

SB2

Steal of second base

SBH;SB2

Double steal of home and second

CS3(25)

Caught stealing third; throw from the
catcher to the third baseman

Errors
An error can be the sole outcome of a play or an extension to the result of a play:

Play

Description

e5.B-1

Grounder booted by the third baseman, and the batter ends
up at first

e6.B-2

Bad throw by the shortstop, and the batter ends up at second

S.B-2(e7)

Single; the left fielder bobbles the ball, allowing the batter to
end up at second

SB2+e2(th).1-3

Runner steals second and takes third on a throwing error by
the catcher

Other Plays
This table shows other examples of the scoresheet notation:
Play

Description

FC.3-H;B-1

Fielder's choice; the runner on third goes home while the batter
takes first

54/SH.1-2

Sacrifice bunt to the third baseman, who throws to the second
baseman covering first while the runner on first goes to second

PO1(13)

Runner picked off at first with the pitcher throwing to the first
baseman

k

Strikeout

k23

Strikeout; batter thrown out at first after the dropped third strike

k+wp.B-1

Batter reaches first on a dropped third strike; ruled a wild pitch

k+pb.B-1

Batter reaches first on a dropped third strike; ruled a passed ball

W

Walk

IW

Intentional walk

HBP

Batter hit by pitch

wp.1-2

Wild pitch; runner on first goes to second

pb.2-3

Passed ball; runner on second goes to third

bk.1-2

Balk, runner goes to second

OA.1-2

Other base advance, such as a steal attempt on which the
defense concedes the base and the runner is not awarded a steal

Advances
When a base runner advances, this is indicated on the scoresheet after the period by the base the runner left, a
dash, and the base the runner reached. When a base runner is put out attempting to reach a base, this is indicated
by an X in place of the dash. The fielders combining to make the out are shown in brackets.

Play

Description

S.3-H

Single; runner scores from third

S.1-3

Single; runner advances from first to third

S.2-3;1-2

Single; runners advance from second to third and from first to
second

S.2xH(92)
Single; runner on second is out trying to score on a throw from the
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e6.B-2

Error by the shortstop; batter ends up on second
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Reading the Game log
The game log provides a straightforward summary of the events that have occurred in a game, but it also includes
some notation like pitch sequences that may not be as obvious. This tutorial describes those codes.
Click here to view a sample game log. You may want to print this out to have on hand as you review the notations.
The game log is divided into the following five columns:
Column Title

Description

Score

score before the event occurs; always lists visiting team's score first

O

number of outs before the event occurs

Rnr

location of runners (1st, 2nd, and/or 3rd base) before the event occurs

BS

count (balls followed by strikes) before the event occurs

Event

description of the play including the sequence of pitches (contained in
parentheses at the end of the play) that led up to the outcome

As mentioned in the previous table, the Event includes the sequence of pitches that led up to and includes the end
result. The codes used to indicate the pitch sequence are described in the following table:
Pitch Code

Description

H

Hit by pitch

I

Intentional ball

B

Called ball

C

Called strike

S

Swinging strike

F

Foul ball

X

Ball put in play

1

Pitcher made pickoff throw to 1st

2

Pitcher made pickoff throw to 2nd

3

Pitcher made pickoff throw to 3rd

The > symbol appears before a pitch to indicate one or more runners moving on the pitch.
The following codes appear after a pitch to indicate the described action:

Pitch Suffix

Description

+1

Catcher made pickoff throw to 1st

+2

Catcher made pickoff throw to 2nd

+3

Catcher made pickoff throw to 3rd

b

Batter was bunting

p
Pitchout
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Real-life Transactions and Lineups
You can choose to play your season using the actual starting lineups for each game, if (and only if):
your league uses the real-life as-played schedule,
you are using a Season Disk for which we have compiled a complete list of real-life transactions or you have
compiled your own list of real-life transactions, and
you have made no changes to the team rosters.
If you do choose to use the real-life lineups, you'll also need to use the real-life transactions to ensure that the right
players are on the active roster for each game.
You have these options:
If you choose Do not use transactions and lineups, DMB will not change the status of players on the roster
as you move through the season. You can make your own roster moves if you like. And if you autoplay
games or play games interactively with the computer manager handling one or both teams, the computer
manager will choose starting lineups based on the manager profile settings for the teams involved.
If you choose Use real-life transactions, DMB will apply the real-life roster moves (trades, promotions,
demotions, disabled list moves, and so on) on the days they happened in real life, but it will not use the reallife lineups. If you autoplay games or play games interactively with the computer manager handling one or
both teams, the computer manager will choose starting lineups based on the manager profile settings for the
teams involved.
Finally, if you choose Use real-life transactions and lineups, DMB will apply the real-life roster moves and
use the same starting lineups for each game as were used in real life.
The real-life transactions and saved lineups are intended for people who enjoy replaying real-life seasons in detail.
If you are drafting new rosters or making any other changes to the rosters, the real-life transaction file and the
game-by-game lineups won't be in synch with your rosters, so you must choose Do not use transactions and
lineups to avoid seeing warnings and error messages.
WARNING! If you use real-life transactions and lineups, you MUST play scheduled games in chronological order. If you play
them out of order, the transaction stream will get out of synch. You do not even have to play any part of the game for this
problem to arise.
Example: If the first unplayed game is scheduled for 4/7, but you start up a game on 4/10 in order to see what pitcher is
scheduled to start in a few days, the game will apply all transactions up through the later date even if you didn't play any
part of that game. When you then try to play the game on 4/7, the transaction stream is out of synch and you may
receive error messages and/or have to restart your season depending on the severity of the problem.

DMB enables you to create real-life transactions using the View>Transactions command. You can save game-bygame lineups as you progress through a season replay, so they will available for you (and others) who wish to
replay that season again.

Saving opening day rosters

In addition to creating a complete set of real-life transactions for a season, you will also need to save the opening
day rosters for all teams in your league. This provides a starting point for the application of the transactions that
follow.
After you finish playing out a season, you can use the restart a season command from the Tools menu to to reset
all statistics, fatigue, and injury information, and to restore your rosters to their opening-day status. If you have not
previously saved your opening day rosters, the active/reserve/disabled status of some players might be
inconsistent with real-life and with the transactions in the log.
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the Pre-season radio button on the tool bar in the roster window to indicate that you want to work with the opening
day status codes. Then use the menu commands to activate all players who began the season on the active roster.
Farm anyone who was not either active or disabled on opening day. Disable anyone that began the season on the
DL. When all of these moves have been made, click on the Current radio button to indicate that you are finished
working with the pre-season
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This is a good place to remind you that DMB season disks may have the same player on more than one roster if
that player was traded, released, or claimed on waivers during the year. When the game processes one of these
transactions, it does not physically move the player from one team to another, because that player already has a
record with his stats and ratings for that other team. Instead, it activates the player on the team he's joining and
deactivates him on the team he's leaving. So, when you're setting up your opening day rosters, and you have a
player who wasn't really on the team on opening day, leave him on the roster but farm him. DO NOT remove him
from the roster.

Creating real-life transactions
After you have saved your opening day rosters, you're ready to start creating real-life transactions using the
View>Transactions command. You can enter the transactions in any order.
See Transactions for guidance on how to create and modify real-life transactions.

Saving game-by-game lineups
If saved lineups do not already exist for a season disk you wish to use for a detailed replay, you can still enter the
lineups from each game using published boxscores.
To do this, choose Game>Scheduled to open the scheduled game window, then double-click on the game in
question to begin playing the game. Make sure the manager options are set to Human for starting lineup selection.
When DMB displays the window used to select starting pitchers and lineups, make your selections (both pitchers
first, then both lineups). As you finish with each lineup, click on the Other actions button, then select Save this
lineup>To real-life lineup log from the popup menu.
You don't need to go ahead and play the game right away. You can quit this game and play it later using the
lineups that you just saved.
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Sacrifice Fly Rules
Many of you already know that the sacrifice rule has changed many times in the history of professional baseball.
Here are the changes that have occurred during the 20th century:
From 1900 to 1907, sacrifice flies were not counted
From 1908 to 1925, a batter who hit a fly ball that scored a runner from third was credited with a sacrifice, but
these sacrifices were grouped together with sacrifice bunts in one category called sacrifice hits (SH)
From 1926 to 1930, batters were awarded a sacrifice if any runner advanced on a fly ball, and sacrifice bunts
and flies continued to be grouped together in the SH category
From 1931 to 1938, sacrifices were no longer awarded on any fly balls
In 1939, sacrifices were once again credited on fly balls that scored a runner, but they were still combined
with bunts
From 1940 to 1953, sacrifice flies were once again eliminated
From 1954 to the present, batters were once again awarded sacrifices on scoring fly balls, and a new
category (sacrifice flies, or SF) was created to keep them separate from sacrifice bunts
Starting with version 7, Diamond Mind Baseball enables you to choose the sacrifice fly rule for a league. The
conversion program automatically assigns a sacrifice fly rule based on the year of the Era the league is currently
assigned to.
To double-check that the correct rule was assigned by the conversion, or to change the rule for a league, use the
Organizer to view the league rules and select from one of the following values:
None--for no sacrifice flies
3rd only, as SH--to credit a SH on a scoring fly ball
3rd only, as SF--to credit a SF on a scoring fly ball
Any base, as SH--to credit a SH on any fly ball that advances a runner
It should be clear that the generous rule in the 1926-30 period inflated batting averages by quite a few points
relative to eras when sacrifices were awarded only on scoring fly balls or not at all. Older versions of DMB always
used the modern rule, and that made it more difficult to compare your Diamond Mind results with real life. With the
ability to choose the appropriate sacrifice fly rule for your league, that becomes much easier.

The DMB Weather System
If you are using DMB's optional weather system, DMB determines the weather for the game by examining the
weather information for the home park and making adjustments for seasonal and daily variations.
If the home park has a retractable roof, the roof is left open if the weather is nice and closed whenever it is too hot
or cold and when rain is in
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You can choose to have DMB display a weather report at the beginning of the game, and you can access a
weather report at any time during a game. This report always includes the temperature, wind direction, wind speed
and the condition of the sky (clear, cloudy, raining). The start of the game may be delayed by rain.

Weather can affect a game
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Warmer weather increases the level of offense
Extreme temperatures (hot or cold) cause pitchers to tire more quickly
The direction and speed of the wind can cause the level of offense to go up or down and may affect the flight
of fly balls that are hit into or with the wind
Rain delays may cause a pitcher to tire more quickly and, if his arm stiffens during a long delay, may force a
pitcher to leave the game
A wet field may cause a fielder to slip and misplay a ball
The DMB weather system is designed to work properly for the months in which baseball is normally played in the
northern hemisphere. If you create a league schedule that extends through the winter months, the weather system
will probably not give you meaningful results, and we recommend that you either (a) stick with schedules that
extend from April to October or (b) if you want to use a schedule that includes other months, disable the weather
system for that league.

Uninstalling Diamond Mind Baseball
We do not recommend uninstalling the game as a solution to technical problems. It is very likely that any
problem you may be trying to solve by uninstalling and reinstalling the game can be fixed in another way. As a
result, we ask that you please contact our technical support staff us first before uninstalling and reinstalling the
game.
There are, however, situations where it makes sense to uninstall the game. You may wish to move the game to
another location on the same computer, move it to another computer, or stop using it altogether. In rare
circumstances, our tech support staff may suggest an uninstall/reinstall as a way to resolve a technical problem
you're having.
To uninstall the game, do the following::
1. Use My Computer or Windows Explorer to locate the game directory on your hard drive. This location is
typically c:\dmb9.
2. In the DMB folder, double-click on the Unwise.exe file. This will begin the uninstall process. Follow the
instructions contained in the program.
Running Unwise removes game files, but does not delete player databases. Once you have reinstalled the game,
you can continue to use previously installed databases by selecting File and then Add reference to existing
database.

